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TEKTRONIX END USER LICENSE AGREEMENT
This End User Agreement (“Agreement”) is an agreement between Tektronix, Inc., an Oregon corporation, and its corporate affiliates,
subsidiaries, and divisions as applicable (collectively, “Tektronix,” “we,” “us,” or “our”) and You (including any entity or organization you
represent, collectively, “Customer” or “You”). Please read this Agreement carefully as this Agreement governs the terms and conditions
under which You are permitted to use Tektronix’s software and services.

THE SOFTWARE, ENCODED OR INCORPORATED WITHIN EQUIPMENT OR ACCOMPANYING THIS AGREEMENT, IS FURNISHED
SUBJECT TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. BY INDICATING YOUR ACCEPTANCE OF THESE TERMS
BY SELECTING AN "ACCEPT” OR SIMILAR BUTTON IN A SOFTWARE MENU, OR BY RETAINING THE SOFTWARE FOR MORE
THAN THIRTY DAYS OR USING THE SOFTWARE IN ANY MANNER YOU (A) ACCEPT THIS AGREEMENT AND AGREE THAT YOU
ARE LEGALLY BOUND BY ITS TERMS; AND (B) REPRESENT AND WARRANT THAT: (I) YOU ARE OF LEGAL AGE TO ENTER
INTO A BINDING AGREEMENT; AND (II) IF YOU ARE A REPRESENTATIVE FOR A CORPORATION OR OTHER LEGAL ENTITY,
YOU HAVE THE RIGHT, POWER, AND AUTHORITY TO ENTER INTO THIS AGREEMENT ON BEHALF OF SUCH ENTITY AND BIND
SUCH ENTITY TO ITS TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, TEKTRONIX WILL NOT AND DOES
NOT LICENSE THE SOFTWARE TO YOU AND YOU MUST NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE. UNITED STATES
GOVERNMENT CUSTOMERS OR END-USERS MAY REQUEST A GOVERNMENT ADDENDUM TO THIS AGREEMENT.

NOTWITHSTANDING ANYTHING TO THE CONTRARY IN THIS AGREEMENT OR YOUR ACCEPTANCE OF THE TERMS AND
CONDITIONS OF THIS AGREEMENT, NO LICENSE IS GRANTED (WHETHER EXPRESSLY, BY IMPLICATION, OR OTHERWISE)
UNDER THIS AGREEMENT TO ANY SOFTWARE THAT YOU DID NOT ACQUIRE LAWFULLY OR THAT IS NOT A LEGITIMATE,
AUTHORIZED COPY OF TEKTRONIX’S SOFTWARE. THIS AGREEMENT EXPRESSLY EXCLUDES ANY RIGHTS CONCERNING
SUCH ILLEGITIMATE COPIES.

IF THESE TERMS ARE NOT ACCEPTABLE, THE UNUSED SOFTWARE AND ANY ACCOMPANYING DOCUMENTATION SHOULD BE
RETURNED PROMPTLY TO TEKTRONIX (WITHIN 30 DAYS OF PURCHASE) FOR A FULL REFUND OF THE LICENSE FEE PAID.
(FOR INFORMATION REGARDING THE RETURN OF SOFTWARE ENCODED OR INCORPORATED WITHIN EQUIPMENT, CONTACT
THE NEAREST TEKTRONIX SALES OFFICE.)

DEFINITIONS.

“Equipment” means Tektronix equipment that the Software is encoded or incorporated within or installed onto.

LICENSE.

Subject to the terms and conditions of this Agreement, Tektronix grants You a non-exclusive, non-transferable license to the Software, as
follows.

You may:

1. Use the Software with the Equipment, or if the Software is not encoded or incorporated in any Tektronix equipment, on no more than
one machine at a time; and

2. Copy the Software for archival or backup purposes, provided that no more than one (1) such copy is permitted to exist at any one time,
and provided that each copy includes a reproduction of any patent or copyright notice or restrictive rights legend that was included with
the Software, as received from Tektronix;

3. Fully transfer the Equipment to a third party but only if prominently accompanied by this End User License Agreement, and such
third-party recipients agree to be bound by the terms of this Agreement; and

4. Integrate Tektronix products that contain the Software into a system and sell or distribute that system to third parties, provided that
those third parties are bound by the terms of this Agreement, and provided that You (i) do not separate the Software from any
Equipment it is incorporated into, (ii) do not retain any copies of the Software, and (iii) do not modify the Software.

You may not:

1. Use the Software other than for its intended purpose as provided above in the section “You may,” or in conflict with the terms and
restrictions of this Agreement;

2. Distribute or transfer the Software to any person or organization outside of Your organization without Tektronix’s prior written consent,
except in connection with a permitted use authorized in “You may” paragraphs 3 or 4 above;
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3. Decompile, decrypt, disassemble, or otherwise attempt to derive the source code, techniques, processes, algorithms, know-how,
or other information (collectively “Reverse Engineer”) from the Software or permit or induce any third party to do so, except to the
limited extent allowed by directly applicable law or third party license (if any), and only to obtain information necessary to achieve
interoperability of independently created software with the Software;

4. Modify, translate, adapt, or create derivative works of the Software, or merge the Software with any other software;
5. Copy the documentation accompanying the Software;
6. Remove any copyright, trademark, or other proprietary notices from the Software or any media relating thereto; or
7. Export or re-export, directly or indirectly, the Software or Equipment, any associated documentation, or systems created in

accordance with “You may” section 4 above, to any country to which such export or re-export is restricted by law or regulation of
the United States or any foreign government having jurisdiction without the prior authorization, if required, of the Office of Export
Administration, Department of Commerce, Washington, D.C. and the corresponding agency of such foreign government;

8. Use the Software or Equipment in any manner or for any purpose that infringes, misappropriates, or otherwise violates any
intellectual property rights or other proprietary rights of any person, or any applicable laws;

9. Use the Software or Equipment in a network or system with other products or services that are incompatible, insecure or not
compliant with applicable laws;

10. Bypass, circumvent, damage or otherwise interfere with any security or other features of the Software or Equipment designed to
control the manner in which they are used, or harvest or mine Tektronix’s proprietary content or information from the Software or
Equipment.

THE SOFTWARE MAY NOT BE USED, COPIED, MODIFIED, MERGED, OR TRANSFERRED TO ANOTHER EXCEPT AS EXPRESSLY
PERMITTED BY THESE TERMS AND CONDITIONS.

FEEDBACK

If You provide feedback to Tektronix concerning the functionality and performance of the Software or Equipment, including without limitation
identifying potential errors and improvements, any comments, questions, suggestions, or the like ("Feedback"), Tektronix is free to use
such Feedback without any attribution, compensation, or restriction in any manner to improve or enhance its products, irrespective of
any other obligation or limitation between the Parties governing such Feedback. You hereby grant Tektronix an irrevocable, worldwide,
perpetual, royalty-free license to use Your Feedback for any purpose whatsoever and waive any moral rights You may have in the
Feedback. Tektronix is not obligated to use Your Feedback.

OWNERSHIP

Title to the Software and all copies thereof, but not the media on which the Software or copies may reside, shall remain with Tektronix or
others from whom Tektronix has obtained a respective licensing right.

GOVERNMENT NOTICE

If the Software or any related documentation is acquired by or for an agency of the U.S. Government, the Software and documentation
shall be considered “commercial computer software” or “commercial computer software documentation” respectively, as those terms are
used in 48 CFR §12.212, 48 CFR §227.7202, or 48 CFR §252.227-7014, and are licensed with only those rights as are granted to all other
licensees as set forth in this Agreement.

TERM

The license granted herein is effective until terminated. The license may be terminated by You at any time upon written notice to Tektronix.
The license may be terminated by Tektronix if You fail to comply with any term or condition and such failure is not remedied within fifteen
(15) days after notice hereof from Tektronix. Upon termination by either party, You shall return to Tektronix or destroy, the Software and all
associated documentation, together with all copies in any form.

IF YOU TRANSFER, DISTRIBUTE, OR OTHERWISE MAKE AVAILABLE ANY COPY, MODIFICATION, OR MERGED PORTION OF THE
SOFTWARE WITHOUT THE AS EXPRESS PERMISSION OF THESE TERMS AND CONDITIONS OR PRIOR WRITTEN CONSENT OF
TEKTRONIX, YOUR LICENSE WILL BE IMMEDIATELY AND AUTOMATICALLY TERMINATED.

LIMITED WARRANTY.

Tektronix does not warrant that the functions contained in the Software will meet Your requirements or that the operation of the Software
will be uninterrupted, secure, or error-free.

TEKTRONIX END USER LICENSE AGREEMENT
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EXCEPT AS SEPARATELY PROVIDED IN A WRITTEN WARRANTY FROM TEKTRONIX, THE SOFTWARE IS PROVIDED “AS IS”
WITHOUT ANY WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, QUIET ENJOYMENT, AND NON-INFRINGEMENT.

THE SOFTWARE IS NOT DESIGNED OR INTENDED FOR USE IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE
PERFORMANCE INCLUDING WITHOUT LIMITATION, IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION
OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, WEAPONS SYSTEMS, DIRECT LIFE-SUPPORT MACHINES, OR ANY
OTHER APPLICATION IN WHICH THE FAILURE OF THE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY OR SEVERE
PHYSICAL OR PROPERTY DAMAGE (COLLECTIVELY "HAZARDOUS ACTIVITIES"). TEKTRONIX AND ITS AFFILIATES, LICENSORS,
AND RESELLERS EXPRESSLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HAZARDOUS ACTIVITIES.

LIMITATION OF LIABILITY

IN NO EVENT SHALL TEKTRONIX, ITS AFFILIATES, LICENSORS, OR RESELLERS BE LIABLE FOR: (1) ECONOMICAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL, PUNITIVE OR EXEMPLARY DAMAGES, WHETHER CLAIMED UNDER
CONTRACT, TORT OR ANY OTHER LEGAL THEORY, (2) LOSS OF OR DAMAGE TO YOUR DATA OR PROGRAMMING, LOSS
OF PROFITS, BUSINESS INTERRUPTION, OR OTHER PECUNIARY LOSS ARISING FROM THE USE OF (OR INABILITY TO USE)
THE SOFTWARE, (3) PENALTIES OR PENALTY CLAUSES OF ANY DESCRIPTION, (4) ANY DAMAGE, CLAIMS, OR LOSSES
RESULTING FROM THE USE OF THE SOFTWARE IN CONJUNCTION WITH OTHER PRODUCTS OR SERVICES (INCLUDING
THIRD-PARTY PRODUCTS OR SERVICES); OR (5) INDEMNIFICATION OF YOU OR OTHERS FOR COSTS, DAMAGES, OR
EXPENSES RELATED TO THE GOODS OR SERVICES PROVIDED UNDER THIS LIMITED WARRANTY, EVEN IF TEKTRONIX OR ITS
AFFILIATES, LICENSORS, OR RESELLERS HAVE ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, SOME OF THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU, BUT THEY SHALL APPLY TO THE MAXIMUM EXTENT
PERMITTED BY LAW. NOTWITHSTANDING ANYTHING HEREIN TO THE CONTRARY, IN NO EVENT SHALL TEKTRONIX’S TOTAL
AGGREGATED LIABILITY TO YOU FOR ALL DAMAGES IN ANY ONE OR MORE CAUSES OF ACTION EXCEED THE AMOUNT
RECEIVED BY TEKTRONIX FROM YOU FOR THE SOFTWARE OR EQUIPMENT.

You are solely responsible for Your data. You must back up Your data before Tektronix or a third party performs any remedial, upgrade, or
other work on Your systems, including any Equipment. If applicable law prohibits exclusion of liability for lost data, then Tektronix will only
be liable for the cost of the typical effort to recover the lost data from Your last available back up.

SECURITY DISCLAIMER

This Software and its associated Equipment are not designed or intended to be used with unsecure networks. You acknowledge that use
of the Equipment may rely upon certain networks, systems, and data communication mediums that are not controlled by Tektronix and
that may be vulnerable to data or security breaches, including, without limitation, internet networks used by Your internet providers and
the databases and servers controlled by Your internet providers. Tektronix shall not be liable for any such breaches, including without
limitation, damages and/or loss of data related to any security breach, and disclaims all warranties, including any implied or express
warranties that any content will be secure or not otherwise lost or altered.

For the avoidance of doubt, if You choose to connect this Software or Equipment to a network, it is Your sole responsibility to provide
and continuously ensure a secure connection to that network. You agree to establish and maintain appropriate measures (e.g., firewalls,
authentication measures, encryption, anti-virus applications, etc.) to protect the Software and Equipment and any associated data against
security breaches including unauthorized access, destruction, use, modification, or disclosure.

Notwithstanding the foregoing, You shall not use any Products in a network with other products or services that are incompatible, insecure
or not compliant with applicable laws.

THIRD-PARTY DISCLAIMER

The Software may contain software owned by third parties and obtained under a license from those parties (“Third Party Software”). Your
use of such Third Party Software is subject to the terms and conditions of this Agreement and the applicable Third Party Software licenses.
Except as expressly agreed otherwise, third parties do not warrant the Third Party Software, do not assume any liability with respect to its
use, and do not undertake to furnish any support or information relating thereto.

GENERAL

Unless the Customer is the United States Government, this Agreement contains the entire agreement between the parties with respect to
the use, reproduction, and transfer of the Software, and shall be governed by the laws of the state of Oregon.

TEKTRONIX END USER LICENSE AGREEMENT
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You shall be responsible for any taxes that may now or hereafter be imposed, levied or assessed with respect to the possession or use of
the Software or the rights and licenses granted under this Agreement, including any sales, use, property, value added, and excise taxes,
and similar taxes, duties, or charges.

Any waiver by either party of any provision of this Agreement shall not constitute or be deemed a subsequent waiver of that or any other
portion.

You may not assign this Agreement or any right or obligation under this Agreement, or delegate any performance, without Tektronix’s prior
written consent. This section does not prohibit You from transferring the Equipment in accordance with Subsections 3 and 4 of the Section
titled “You may” above.

All questions regarding this Agreement should be directed to the nearest Tektronix Sales Office.

TEKTRONIX END USER LICENSE AGREEMENT
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Open Source GPL License Notice
For programs licensed under the "GNU General Public License (GPL) or Lesser GNU General Public License (LGPL)" the complete
corresponding sources are available. You can order a CD containing the sources from us for a period of three years after download of the
software, by sending a written request to:

Chief Intellectual Property Counsel, Tektronix, Inc.

MS 50/LAW

14150 SW Karl Braun Dr.

Beaverton OR, 97077

This offer is valid to anyone in receipt of this information.

Your request should include: (i) the name of the product, (ii) your (company) name, and (iii) your return mailing and email address (if
available).

Please note that we may charge you a fee to cover the cost of performing this distribution.

Open Source GPL License Notice
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GPU disclosure
This product utilizes a 3rd party device driver to enable the Graphics Processor Unit. The driver was obtained from NXP and requires the
end user to accept an end-user licensing agreement.

This product uses Linux kernel version 3.0.35. If you wish to modify any of the GPL or LGPL components of the Linux kernel, and
re-compile them, you will need to request a copy of the binary driver imx-gpu-viv-5.0.11.p4.5.bin from NXP. Instructions for compiling the
kernel with the binary driver are below.

The GPU binary files rely on the gpu-viv driver package to be compiled into the kernel. This package can be found in the " drivers/mxc/
gpu-viv" directory of this kernel distribution. To compile the package the user need only enable the following flags in the configuration file in
the build configuration file named "Config-tek_lk-3.0.35":

CONFIG_IMX_HAVE_PLATFORM_VIV_GPU=y

CONFIG_DRM_VIVANTE=y

CONFIG_HAS_DMA=y

CONFIG_MXC_GPU_VIV=m

An end user who wishes to utilize this binary package will need to ensure that the binary files are placed into a suitable directory in
their uImage linux boot file. The command line used for installing the galcore.ko module which starts up the GPU driver on an i.mx6 solo
processor to perform 2D scaling is as follows:

" insmod /lib/modules/3.0.35/kernel/drivers/mxc/gpu-viv/galcore.ko" \

" registerMemBase=0x00000000 registerMemSize=0x00004000 irqLine=-1" \

" irqLine2D=42 registerMemBase3D=0x02200000 registerMemSize3D=0x00004000" \

" irqLineVG=43 registerMemBase2D=0x02204000 registerMemSize2D=0x00004000" \

" signal=48 baseAddress=0x80000000 fastClear=-1 " \

" contiguousSize=0x006f50000 contiguousBase=0x9E000000 "

Finally, in the board support configuration file, memory needs to be reserved for the GPU. An example of how to configure the board can
be found in the following file: "/arch/arm/mach-mx6/ board-mx6q_sabresd.c". The salient lines are:

#include <mach/viv_gpu.h>

…

static struct viv_gpu_platform_data imx6q_gpu_pdata __initdata = {

.reserved_mem_size = SZ_128M,

};

….

imx_add_viv_gpu(&imx6_gpu_data, &imx6q_gpu_pdata);

…

#if defined(CONFIG_MXC_GPU_VIV) || defined(CONFIG_MXC_GPU_VIV_MODULE)

if (imx6q_gpu_pdata.reserved_mem_size) {

phys = memblock_alloc_base(imx6q_gpu_pdata.reserved_mem_size,

SZ_4K, SZ_1G);

memblock_remove(phys, imx6q_gpu_pdata.reserved_mem_size);

imx6q_gpu_pdata.reserved_mem_base = phys;

GPU disclosure

3 Series Mixed Domain Oscilloscope Help 17

www.tehencom.com          



}

#endif

GPU disclosure
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Welcome to the 3 Series MDO instrument help
This help supports 3 Series MDO (MDO34, MDO32) instruments. See the following list for information on the key features.

MDO34, MDO32 Key features and benefits
3 Series Mixed Domain Oscilloscopes are 6-in-1 integrated oscilloscopes, offering a built-in spectrum analyzer, arbitrary function generator,
logic analyzer, protocol analyzer, digital voltmeter and frequency counter.

Key features include:

• A dedicated RF input channel for frequency domain measurements
• 1 GHz spectrum analyzer standard, 3 GHz optional
• Bandwidths from 100 MHz to 1 GHz
• 2- and 4-channels for time domain measurements
• Sixteen-channel digital input option
• Large 11.6” HD (1920 x 1080 pixel) capacitive touchscreen display
• User interface optimized for touchscreen use
• Sample rates of 2.5 GS/s on all analog channels (5 GS/s on 1 or 2 channels for the MDO34 or MDO32 with the 1 GHz option)
• 10 M points record length on all channels
• Maximum waveform capture rate: 280,000 waveforms/second, with FastAcq: >50,000 waveforms/second with normal operation
• Advanced triggering and analysis: I2C, SPI, USB 2.0, CAN, CAN FD, LIN, FlexRay, SENT, RS-232, RS-422, RS-485, UART, I2S, Left

Justified (LJ), Right Justified (RJ), TDM, MIL-STD-1553, ARINC429 (with the appropriate option), and Parallel
• Power analysis (optional)
• Arbitrary function generator and 16 digital channels (optional)
• Digital voltmeter and trigger frequency counter free with product registration

3 Series MDO Help, version 20230710-08:00 for Firmware v1.19.13 and later

Welcome to the 3 Series MDO instrument help
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Product documents and support

Related documents
Use the related documents for more information on instrument functions, how to remotely program or operate the instrument, understand
theory of operation, replace suspected modules, and do other tasks.

3 Series MDO documents

To learn about Use this document
How to use instrument functions 3 Series MDO Help (Tektronix part number 076-0425-xx; Printable version of the

instrument Help; available at www.tek.com/downloads)

3 Series MDO Installation and Safety Manual (this document, Tektronix part number
071-3608-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages. Other language versions are available to
download from the Tektronix web site.

How to remotely control the instrument 3 Series MDO Programmer Manual (Tektronix part number 077-1498-xx; available at
www.tek.com/downloads)

Instrument specifications and procedures to
verify the instrument meets specifications

3 Series MDO Specifications and Performance Verification Technical Reference (Tektronix
part number 077-1499-xx; available at www.tek.com/downloads)

Instrument theory of operation,
troubleshooting, disassembly, and
replaceable parts

3 Series MDO Service Manual (Tektronix part number 077-1500-xx; available at
www.tek.com/downloads)

Installing the instrument in a rack RM3 Rack Mount Kit Instructions (Tektronix part number 071-3609-xx; available at
www.tek.com/downloads)

Product support and feedback
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your instrument, application, or product documentation.

Contact through mail, telephone, or the Web site. See Contacting Tektronix for more information or assistance with your product.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible):

General information
• All instrument model numbers
• Hardware options, if any
• Probes used
• Your name, company, mailing address, phone number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments

Product documents and support
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Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save and send the setup files for all the instruments used and the application
• If possible, save and send status messages text files
• If possible, save and send the waveform on which you are performing the measurement as a .isf file

Product documents and support
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Accessories

Standard accessories
Item Quantity Tektronix part

number
Passive Voltage Probe, depends on instrument bandwidth 1 GHz bandwidth One per analog

channel
TPP1000

350 MHz and
500 MHz

TPP0500B

100 MHz and 200
MHz bandwidth

TPP0250

Accessory bag 1 016-2144-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
OpenChoice® Desktop Software. Available for download from www.tek.com/software/downloads

Recommended accessories
See the Tektronix Web site (www.tek.com) for the latest information on recommended accessories for this product.

Recommended accessories

Accessory Tektronix part number

Preamplifier, 12 dB nominal Gain, 9 kHz - 6 GHz TPA-N-PRE

N-to-TekVPI adapter TPA-N-VPI

Near field probe set, 100 kHz - 1 GHz 119-4146-00

Flexible monopole antenna 119-6609-00

Service manual, download from Web (English only) 077-0981-xx

TekVPI® to TekProbe™ BNC adapter TPA-BNC

TekVPI Deskew pulse generator signal source TEK-DPG

Power measurement deskew and calibration fixture 067-1686-xx

Vector Signal Analysis Software SignalVu-PC-SVE

GPIB-to-USB adapter TEK-USB-488

Table continued…

Accessories
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Accessory Tektronix part number

Front protective cover 200-5480-xx

Soft transit case (includes front protective cover) SC3

Hard transit case (requires front protective cover) HC3

Rackmount kit RM3

Recommended probes
See the Tektronix Web site (www.tek.com) for the latest information on supported probes for this product.

Probes
Tektronix offers over 100 different probes to meet your application needs. For a comprehensive listing of available probes, please visit
www.tek.com/probes.

Accessory Tektronix part number

250 MHz, 10X attenuation passive probe with TekVPI® interface TPP0250

500 MHz, 10X attenuation passive probe with TekVPI® interface TPP0500B

500 MHz, 2X attenuation passive probe with TekVPI® interface TPP0502

2.5 kV, 800 MHz, 50X TekVPI® passive high-voltage probe TPP0850

1 GHz, 10X TekVPI® passive voltage probe, 1.3 Meter cable TPP1000

500 MHz TekVPI® differential voltage probe, ±42 V differential input voltage TDP0500

1 GHz TekVPI® differential voltage probe, ±42 V differential input voltage TDP1000

±6 kV, 100 MHz TekVPI® high-voltage differential probe THDP0100

±1.5 kV, 200 MHz TekVPI® high-voltage differential probe THDP0200

±750 V, 200 MHz TekVPI® high-voltage differential probe TMDP0200

Isolated Probe; 1 GHz, ±50 V, TekVPI, 10 Meter Cable TIVM1 / L

400 MHz differential active FET probe (Level II TekProbe) P6246

1 GHz differential active FET probe (Level II TekProbe) P6427

2.5 kV, 100x high voltage probe (Level II TekProbe) P5100

Table continued…

Accessories
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Accessory Tektronix part number

20 A AC/DC TekVPI® current probe, 50 MHz BW TCP0020

30 A AC/DC TekVPI® current probe, 120 MHz BW TCP0030A

150 A AC/DC TekVPI® current probe, 20 MHz BW TCP0150

2000 A AC Current probe/BNC A621

100 A AC/DC Current probe/BNC A622

AC/DC current probe, DC to 100 MHz, (Requires TCP305A or TCP312A or TCP303 probes) TCPA300

AC/DC current probe, DC to 50 MHz, (Requires TCP404XL probe) TCPA400

15MHz AC/DC 150A current probe for TCPA300 TCP303

50MHz AC/DC 50A current probe for TCPA300 TCP305

100MHz AC/DC 30A current probe for TCPA300 TCP312

2 MHz AC/DC 500A current probe for TCPA400 TCP404XL

100x, 10x, 1x, 0.1x high gain differential amplifier ADA400A

16 Channel Logic Probe P6316

RF probes
Contact Beehive Electronics to order: http://beehive-electronics.com/probes.html

Accessory Part number

EMC probe set 101A

EMC probe amplifier 150A

Probe cable 110A

SMA probe adapter 0309-0001

BNC probe adapter 0309-0006

Accessories
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Factory options
The 3 Series MDO is configured according to the various options you choose when you purchase your instrument. All options in this
section are installed at the factory.

Bandwidth options
The table lists the different bandwidth configuration options for your 3 Series MDO.

Table 1: 3 Series bandwidth options

Option name Description
3-BW-100 100 MHz Bandwidth for analog channels
3-BW-200 200 MHz Bandwidth for analog channels
3-BW-350 350 MHz Bandwidth for analog channels
3-BW-500 500 MHz Bandwidth for analog channels
3-BW-1000 1 GHz Bandwidth for analog channels

Digital channels option
The MSO option provides 16 digital channels to simultaneously view analog and digital signals on your oscilloscope.

Table 2: 3 Series MSO option

Option name Description
3-MSO Adds 16 digital channels to the oscilloscope. The option includes a P6316 digital probe and

accessories.

Spectrum analyzer frequency range options
The spectrum analyzer options increase the input frequency range and capture bandwidth of the integrated spectrum analyzer. With
increased spectrum analyzer bandwidth you can capture higher-frequency signals and view a broader spectrum. The 1 GHz spectrum
analyzer comes standard on all models. The 3 GHz spectrum analyzer is optional.

Table 3: 3 Series spectrum analyzer options

Option name Description
3-SA3 Increase spectrum analyzer input frequency range to 9 kHz to 3 GHz and capture bandwidth to 3 GHz

 

Factory options
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Arbitrary Function Generator (AFG) option
The AFG option adds a 50 MHz AFG function to your oscilloscope.

AFG features
• Function types: Arbitrary, Sine, Square, Pulse, Ramp, Triangle, DC Level, Gaussian, Lorentz, Exponential Rise/Fall, Sin(x)/x, Random

Noise, Haversine, Cardiac
• Maximum frequency: 50 MHz (Sine)
• Maximum output amplitude: 5 Vp-p
• Maximum sample rate: 250 MS/s
• Arbitrary function record length: 128K samples
• AM and FM modulation

Table 4: 3 Series AFG option

Option name Description
3-AFG Adds a arbitrary function generator with 13 predefined waveforms and arbitrary waveform generation.

Enhanced instrument security
The enhanced instrument security option provides the highest level of instrument security. This option enables password protecting and
disabling of all communication ports and firmware upgrades. This option configures the oscilloscope hardware to easily declassify the
oscilloscope. This option must be ordered at the same time you order an instrument. You cannot order this option as a field-installable
upgrade, as the option requires hardware reconfiguration.

Table 5: Enhanced instrument security pre-installed option

Install option name Description
3-SEC Enhanced instrument security to enable password protected control of turning on/off all instrument

ports and instrument firmware update functionality.

Serial bus decode and trigger options
Serial bus and trigger options provide bus decode display and triggering for testing and analysis of industry standard serial buses.

Table 6: 3 Series serial bus options

Option name Description
3-SRAERO Adds aerospace serial triggering and analysis (MIL-STD-1553, ARINC429)
3-SRAUDIO Adds audio serial triggering and analysis (I2S, LJ, RJ, TDM)
3-SRAUTO Adds automotive serial triggering and analysis (CAN, CAN FD, LIN, FlexRay)
3-SRCOMP Adds computer serial triggering and analysis (RS-232/422/485/UART)
3-SREMBD Adds embedded serial triggering and analysis (I2C, SPI)
3-SRUSB2 Adds USB serial triggering and analysis (USB 2.0 LS, FS, HS)
3 - SRAUTOSEN Adds SENT serial triggering and analysis

Factory options
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Power Analysis option
The power analysis option enables analysis of many different power measurements: power quality, switching loss, harmonics, modulation,
ripple, slew rate (di/dt, dv/dt), and safe operating area (SOA).

Table 7: 3 Series power option

Upgrade option name Description
3-PWR Adds power measurement and analysis.

Application bundle
The application bundle option includes all of the serial bus decode and trigger options and the power analysis option.

Table 8: 3 Series bundle option

Option name Description
3-BND Adds all the serial options and power analysis option as an application bundle

Power cord options
These options let you order the oscilloscope with a country- or region-specific power cord.

Power cord options
These options are ordered when ordering the oscilloscope.

Option name Description
A0 North America Power Cord
A1 Universal EURO Power Cord
A2 United Kingdom Power Cord
A3 Australia Power Cord
A4 240 V North America Power Cord
A5 Switzerland Power Cord
A6 Japan Power Cord
A8 None provided, product set to operate at 120 V
A9 None provided, product set to operate at 230 V
A10 China Power Cord
A11 India Power Cord
A12 Brazil Power Cord
A99 No Power Cord or AC Adapter

 

Factory options
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Service options
Service options improve the level of service response, extend the warranty period, or provide calibration reports. You can order service
options when you purchase an oscilloscope, or purchase a service option at a later date.

Service options
Option name Description
G3 Three Year Gold Care Plan. Includes expedited repair of all product failures including ESD and EOS, access

to a loaner product during repair or advanced exchange to reduce downtime, priority access to Customer
Support among others.

G5 Five Year Gold Care Plan. Includes expedited repair of all product failures including ESD and EOS, access
to a loaner product during repair or advanced exchange to reduce downtime, priority access to Customer
Support among others.

R3 Standard Warranty Extended to 3 Years. Covers parts, labor and 2-day shipping within country. Guarantees
faster repair time than without coverage. All repairs include calibration and updates. Hassle free-a single call
starts the process.

R5 Standard Warranty Extended to 5 Years. Covers parts, labor and 2-day shipping within country. Guarantees
faster repair time than without coverage. All repairs include calibration and updates. Hassle free-a single call
starts the process.

T3 Three year Total Protection Plan. Includes preventative maintenance, and repair or replacement coverage
from wear and tear, accidental damage, and ESD or EOS damage. Includes a five-day turnaround time and
priority access to customer support.

T5 Five year Total Protection Plan. Includes preventative maintenance, and repair or replacement coverage from
wear and tear, accidental damage, and ESD or EOS damage. Includes a five-day turnaround time and priority
access to customer support.

C3 Three-year calibration service. Includes traceable or functional verification where applicable, for
recommended calibrations. Coverage includes the initial calibration plus two years calibration coverage.

C5 Five-year calibration service. Includes traceable or functional verification where applicable, for recommended
calibrations. Coverage includes the initial calibration plus four years calibration coverage.

D1 Factory calibration data report for the instrument.
D3 Three years of calibration data reports (with Option C3)
D5 Five years of calibration data reports (with Option C5)
IN Product installation service
IF Upgrade installation service
IFC Service installation and calibration
IFCN Service installation and calibration, includes incoming calibration.

Factory options
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Option upgrades
The 3 Series MDO products offer a number of ways to add functionality after the initial purchase.

Post-purchase instrument options
Option upgrades add functionality to your 3 Series MDO after you receive it from the factory. The upgrades are enabled by installing a
software license key that is specific to the model and serial number of your oscilloscope. The license key from Tektronix is provided with
the purchase of your options.

Table 9: Instrument upgrade options

Option name Description
SUP3 AFG Adds the arbitrary function generator to any 3 Series MDO product
SUP3 DVM Adds a digital voltmeter and frequency counter.

This option is free when you register your product. To register go to: www.tektronix.com/
register3mdo

SUP3 MSO Adds 16 digital channels and includes a P6316 digital probe and accessories
SUP3 SA1 Free with registration. Adds a spectrum analyzer; frequency range from 9 kHz to 1 GHz

and capture bandwidth to 1 GHz
SUP3 SA3 Adds a spectrum analyzer; frequency range from 9 kHz to 3 GHz and capture bandwidth to

3 GHz
SUP3 BND Adds an application bundle (includes all serial options and power analysis option)
SUP3 SRAERO Adds aerospace serial triggering and analysis (MIL-STD-1553, ARINC429)
SUP3 SRAUDIO Adds audio serial triggering and analysis (I2S, LJ, RJ, TDM)
SUP3 SRAUTO Adds automotive serial triggering and analysis (CAN, CAN FD, LIN, FlexRay)
SUP3 SRCOMP Adds computer serial triggering and analysis (RS-232/422/485/UART)
SUP3 SREMBD Adds embedded serial triggering and analysis (I2C, SPI).
SUP3 SRUSB2 Adds USB serial triggering and analysis (USB 2.0 LS, FS, HS)
SUP3 PWR Add power measurement and analysis
SUP3 T3 Three Year Total Protection Plaln, includes repair or replacement coverage from wear and

tear, accidental damage, ESD or EOS plus preventative maintenance, including a 5 day
turnaround time and priority access to customer support

SUP3 T5 Five Year Total Protection Plaln, includes repair or replacement coverage from wear and
tear, accidental damage, ESD or EOS plus preventative maintenance, including a 5 day
turnaround time and priority access to customer support

SUP3 SRAUTOSEN Adds SENT serial triggering and analysis

Bandwidth upgrade options
Instrument bandwidth can be upgraded on any 3 Series MDO product after initial purchase. Each upgrade product increases analog
bandwidth and spectrum analyzer frequency range. Bandwidth upgrades are purchased based on the combination of the current
bandwidth and the desired bandwidth. Software option key depends on the instrument model and serial number combination. Bandwidth
upgrades up to 500 MHz can be performed in the field, while upgrades to 1 GHz require installation at a Tektronix service center.

Option upgrades
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Table 10: MDO32 bandwidth upgrades

Option name Bandwidth before upgrade Bandwidth after upgrade
SUP3 BW1T22 100 MHz 200 MHz
SUP3 BW1T32 100 MHz 350 MHz
SUP3 BW1T52 100 MHz 500 MHz
SUP3 BW1T102 100 MHz 1 GHz
SUP3 BW2T32 200 MHz 350 MHz
SUP3 BW2T52 200 MHz 500 MHz
SUP3 BW2T102 200 MHz 1 GHz
SUP3 BW3T52 350 MHz 500 MHz
SUP3 BW3T102 350 MHz 1 GHz
SUP3 BW5T102 500 MHz 1 GHz

Table 11: MDO34 bandwidth upgrades

Option name Bandwidth before upgrade Bandwidth after upgrade
SUP3 BW1T24 100 MHz 200 MHz
SUP3 BW1T34 100 MHz 350 MHz
SUP3 BW1T54 100 MHz 500 MHz
SUP3 BW1T104 100 MHz 1 GHz
SUP3 BW2T34 200 MHz 350 MHz
SUP3 BW2T54 200 MHz 500 MHz
SUP3 BW2T104 200 MHz 1 GHz
SUP3 BW3T54 350 MHz 500 MHz
SUP3 BW3T104 350 MHz 1 GHz
SUP3 BW5T104 500 MHz 1 GHz

How to install an option license
Use this process install an option license to enable specific instrument features. Option licenses provide advanced functions for specific
standards or measurement requirements.

Before you begin
Prerequisite:

• You need the license key from Tektronix that is provided with your purchase. A single license key is valid only for the specific model
number and serial number of the instrument for which it was purchased; it will not work on any other instrument. The single license key
does not affect options that were factory installed or any other upgrades that you may have already purchased and installed.

• These instructions only support options that are enabled by installing a software license key. Some product upgrades, such as 3
Series MDO bandwidth upgrades to 1 GHz, are not supported by this procedure. These upgrades either have their own installation
instructions, or require that you send the instrument to a Tektronix service center for new hardware and calibration.

Option upgrades
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About this task
Note: You can only install a Node Locked option license one time. If you need to reinstall an uninstalled Node Locked license,
contact Tektronix Customer Support.

Procedure
1. Select Help > About.
2. Tap Install License to open the Install License dialog box.
3. Double-tap the Enter License Key field to open the virtual keyboard.
4. Use the virtual keyboard to enter the license key. The key is not case sensitive.
5. Tap OK. The instrument installs the license and returns to the About screen.
6. Power cycle the instrument to enable the installed option(s).
7. Return to the Help > About menu to verify that the Enabled status for the option is Yes.
8. If you installed a bandwidth upgrade, remove the model/bandwidth label from the lower-left corner of the front panel and install the

new model/bandwidth label that your received as part of the upgrade purchase. If you installed a bandwidth upgrade, run signal path
compensation (Utility > Calibration > Run SPC).

Option upgrades

3 Series Mixed Domain Oscilloscope Help 31

www.tehencom.com          



Install your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North America, call
1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered items. If you
purchased factory options, tap Help > About to confirm that the option(s) are listed in the Installed Options table.

Standard accessories
Item Quantity Tektronix part

number
Passive Voltage Probe, depends on instrument bandwidth 1 GHz bandwidth One per analog

channel
TPP1000

350 MHz and
500 MHz

TPP0500B

100 MHz and 200
MHz bandwidth

TPP0250

Accessory bag 1 016-2144-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
OpenChoice® Desktop Software. Available for download from www.tek.com/software/downloads

Safely rotate the handle
Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

WARNING: Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
this can pinch the base of your thumb between the handle and the case.

CAUTION: If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do
not pinch the cables.
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Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the most
accurate measurements and safe instrument operation.

Environment requirements
Characteristic Description
Operating temperature -10 °C to +55 °C (+14 °F to +131 °F)

For proper cooling, keep the sides and rear of the instrument clear of obstructions for
2 inches (51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.

5% to 60% RH above +40 °C up to +55 °C (+104 °F to +131 °F), Noncondensing.

Operating altitude Up to 3000 meters (9842 feet)

Power requirements
Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase

Power source frequency 50/60 Hz, 100-240 V

400 Hz ±10% at 100 to 132 V

Power consumption 130 W maximum

Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and digital
probes or instrument. Make sure that input signals are within the following requirements.

Table 12: Maximum analog input

Input Description
Analog input channels, 1 M Ω setting, maximum input
voltage at BNC

300 VRMS

Measurement Category II

De-rate at 20 dB/decade between 4.5 MHz and 45 MHz, De-rate 14 db between
45 MHz and 450 MHz. Above 450 MHz, 5 VRMS.

Analog input channels, 50 Ω setting, maximum input
voltage at BNC

5 VRMS with a peak at ±20 V. (DF ≤ 6.25%).

Table continued…
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Input Description
RF input maximum input voltage Average Continuous Power: +20 dBm (0.1 W)

DC maximum before damage: ±40 VDC

Max no damage +33 dBm (2 W) CW

Peak Pulse Power: +45 dBm (32 W)

Peak Pulse Power defined as <10 μs pulse width, <1% duty cycle, and reference
level of ≥ +10 dBm

Table 13: Maximum input with a P6316 Digital Probe

Input Description
Threshold Accuracy ±(100 mV + 3% of threshold setting after calibration)
Threshold Range +25 V to –15 V
Maximum nondestructive input signal to probe +30 V to -20 V
Minimum signal swing 500 mVpeak-to-peak

Input resistance 101 kΩ
Input capacitance 8.0 pF typical
Pollution Degree 2, indoor use only
Humidity 5% to 95% relative humidity

Powering the instrument
Always connect the oscilloscope to AC power using the power cord that shipped with the instrument.

Procedure
1. Connect the supplied power cord to the instrument power connector and then connect the power cord to an appropriate AC mains

source.
2. Push the front panel power button to power the instrument on and off. The button is blue when the instrument is powered on. The

button color is yellow when the instrument is in standby mode and unlit when no AC power is applied.
3. To completely remove power from the instrument, disconnect the power cord.
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Figure 1: Power cord connector and power standby switch

Check that the oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

Procedure
1. Power on the oscilloscope and wait until the oscilloscope screen appears.
2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.
3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.
b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.
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Lock the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss. Attach a standard laptop security lock to the rear panel of
the oscilloscope, to secure the oscilloscope to a workbench, rack, or other location.

Connecting probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal measurement
needs.

1. Tektronix Versatile Probe Interface (TekVPI). These probes support two-way communication with the oscilloscope through on-screen
menus and remotely through programmable support. The remote control is useful in applications like ATE where you want the system
to set probe parameters.
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2. Tektronix Versatile Probe Interface (TekVPI) for Passive Probes. These probes build upon the functionality of the TekVPI interface.
Each probe is matched with its corresponding oscilloscope channel, allowing the oscilloscope to optimize the signal input path. This
provides AC compensation across the frequency band.

3. TPA-BNC Adapter. The TPA-BNC Adapter allows you to use TEKPROBE II probe capabilities, such as providing probe power and
passing scaling and unit information to the oscilloscope.

4. BNC Interfaces. Some of these use TEKPROBE capabilities to pass the waveform signal and scaling to the oscilloscope. Some only
pass the signal and there is no other communication.

5. Logic Probe Interface. The P6316 probe provides 16 channels of digital (logical one or zero) information.
6. TPA-N-VPI Adapter. The TPA-N-VPI Adapter allows you to use TekVPI probes with the RF input.

Connect TPP0250, TPP0500B, TPP1000, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into an input
connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If a probe
has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active probes to set their
parameters (auto zero, degauss, and so on).

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until it locks.

For more information on the many probes available for use with 3 Series MDO oscilloscopes, visit the Oscilloscope Probe and Accessory
Selector Tool at www.tek.com.

Note: Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Rackmount information
The optional RM3 Rackmount Kit lets you install the oscilloscope in standard equipment racks. The rack mount requires six rack units (6U)
of space to install.

Contact Tektronix Customer Support to purchase the rackmount kit option RM3. Follow the instructions that come with the rackmount kit
(RM3 Rackmount Kit Instructions).

Make sure to allow at least two inches of clearance on the sides for air ventilation and on the back for any cables you attach to the rear
panel.
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface.

Refer to the instrument help for detailed information on using the controls and user interface to display waveforms and take
measurements.

Front panel controls and connectors
The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, and cursors. The connectors
are where you input signals with probes or cables or insert USB devices.

Note: Refer to the instrument help for detailed information on using the controls to display waveforms and take measurements.

1. Use the Acquisition and Cursors controls to start and stop waveform acquisition, turn cursors on or off, enable or disable the fast
acquisition mode, enable making a single waveform acquisition, calculate the average of all the samples for each acquisition interval,
and delete the current acquisitions and measurement values from memory.

2. Use the Multipurpose Knobs (A, B) to move cursors, adjust the zoom, and set parameter values in configuration menu input fields.
3. Use the Trigger controls to force a trigger event at a random point in the waveform and captures the acquisition, set the amplitude

level that the signal must pass through to be considered a valid transition, set the signal transition direction to detect for a trigger, and
set how the instrument behaves in the absence or presence of a trigger event.

4. Use the Vertical controls to move the selected waveform up or down on the screen, set the amplitude units per vertical graticule
division of the selected waveform, turn on (display) or select channels, and add or select a math, reference (saved), bus, RF, and
digital waveform on the Waveform view.

5. Use the Horizontal controls to move the waveform from side to side on the screen, and set the time per major horizontal graticule
division and samples/second parameters for the oscilloscope.
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6. Use the Miscellaneous controls to turn touchscreen capability off, restore the oscilloscope settings to the default settings, automatically
display a stable waveform, and save files or settings (using the current File > Save As settings).

7. Use Ground and probe compensation connectors to provide a ground connector to help reduce electrostatic damage (ESD) and adjust
the high-frequency response of a passive probe. The Ground and Probe Compensation connectors are located at the lower right side
of the instrument, near the front panel.

8. USB ports are located at the lower right corner of the front panel and on the rear panel. Connect USB flash drives to which you can
save or recall data (such as instrument software updates, waveforms, settings, and screen captures) or connect peripheral devices
such as a mouse or keyboard.

9. Use the Probe connectors to connect TekVPI+ and TekVPI measurement probes, BNC passive probes, the P6316 Logic Probe, and
BNC cables.

Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference signals,
and the AFG output.

1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.
3. AUX Out generates a signal transition on a trigger event or outputs a synchronization signal from the AFG.
4. LAN connector (RJ-45) connects the oscilloscope to a 10/100 Base-T local area network.
5. USB Device port lets you connect to a PC to remotely control the oscilloscope using the USBTMC protocol.
6. USB Host port lets you connect a USB memory device, keyboard, or mouse.
7. HDMI output lets you connect an external monitor or projector to show the oscilloscope screen.
8. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other location.
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User interface
The touchscreen user interface contains waveforms, measurement readouts, and touch-based controls to access all oscilloscope
functions.

1. The Menu bar provides menus for typical operations including:

• Saving, loading, and accessing files
• Undoing or redoing an UI action
• Setting oscilloscope display and measurement preferences
• Configuring network access
• Running self tests
• Erasing measurement and settings memory (TekSecure™)
• Loading option licenses
• Opening a Help viewer

2. The Waveform View area displays analog, digital, math, reference, and bus waveforms. The waveforms include waveform handles
(identifiers), trigger position, and level(s) indicators. See Identifying items in the time domain display on page 41.

3. The Results Bar contains controls for displaying cursors, adding result tables to the screen, and adding measurements to the Results
bar. The controls are:

• The Cursors button displays on-screen cursors. Touch and drag or use the Multipurpose knobs to move the cursors. Double-tap
on a cursor or on the cursor readouts to open a configuration menu to set cursor types and related functions.

• The Measure button opens a configuration menu from which to select and add up to four measurements to the Results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.

• The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search configuration
menu and set the search conditions for analog and digital channels. Search badges are added to the Results Bar.

• The Results Table button adds a Measurement, Bus, Search, and Harmonics results table to the screen. The Measure tab
displays all measurements present in the Results bar. The Bus tab displays bus decode information for displayed bus waveforms.
The Search tab displays search event information. The Harmonics tab displays harmonic measurement results.

• The More... button on the Results Bar allows you to select Zoom or Mask.
• The Draw Zoom/Mask button lets you to draw a mask or zoom. This button reflects the function selected in DRAW A BOX menu.
• The Measurement and Search badges show measurement and search results and are displayed in the Results Bar.
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4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive Channel
buttons to turn on channels; Math/Ref/Bus button to add math, reference, and bus waveforms to the display; and Channel and
Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform button to add it to the screen
and display a badge. Double-tap a badge to open its configuration menu.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open configuration menus by
double-tapping on badges, screen objects, or screen areas.

Identifying items in the time domain display
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes the key
user interface elements.

 

1. The Waveform Record View is a graphical high-level view of the overall acquisition, how much of the acquisition is on the screen
(shown in brackets), the location of key time events including the trigger event, and the current position of waveforms cursors.

If you are changing the horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the
part of the waveform record that is being viewed relative to the current acquisition total record length.

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed lines.

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface on page 52.
2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and compresses when

changing horizontal settings.
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3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record.

4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off.

5. The Trigger Level Indicator icon(s) shows the trigger level(s) on the trigger source waveform. Some trigger types require two trigger
levels.

6. Measurement and Search badges show measurement and search results. See Badges on page 46.
7. The Results Bar Handle opens or closes the Results bar to maximize waveform screen viewing when needed. To reopen the

Results bar, either tap the handle icon or swipe left from the right side of the display.
8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time). See

Badges on page 46.
9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the Settings

bar.

The Add Math Ref Bus button expands allowing you to add a math, reference, or bus waveform to the Waveform view and add an
associated Waveform badge to the Settings bar.

The RF button activates the frequency domain display and adds an RF badge. Double-tap the badge to open the RF configuration
menu to configure the RF input. This button is only active if one of the RF options is enabled.

The AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the AFG option
is installed.

The DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT. Tap the
button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a trigger frequency
counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only present if the DVM option is
installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 46. See Configuration menus on page 50.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at each end of
the waveform badge area to scroll and display hidden badges.

11. The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, M for Math, Rx for Reference
waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default. The currently
selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, with each individual digital signal labeled D0–D15 and
displayed with a different color.
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Double-tapping a digital waveform handle opens the digital channel configuration menu.

Dragging a digital signal handle over another handle swaps location of the signals in the waveform view. Dragging a digital signal
handle out of the group, creates a new group. A selected digital group or signal handle can be moved using the Vertical Position
control.

Identifying items in the frequency domain display
To activate the frequency domain display, press the front panel RF button or tap the RF button in the display. Each area of the user
interface has a specific function that helps manage information or controls.

1. Vertical graticule labels
2. Start frequency
3. Reference level
4. Vertical scale
5. Center frequency
6. Span and resolution bandwidth
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7. Stop frequency
8. Reference marker
9. Displayed trace indicators

a. An RF trace indicator is placed at the Reference Level.
b. A capital M appears if the maximum trace is turned on.
c. A capital A appears if the average trace is turned on.
d. A capital N appears if the normal trace is turned on.
e. The small m appears if the minimum trace is turned on.

Orange highlighting indicates the currently selected trace. In the figures the small m, which stands for the minimum trace, is
highlighted. This indicates that the minimum trace is currently selected.

10. Normal trace: Each acquisition is discarded as new data is acquired.
11. Max hold trace: The maximum data values are accumulated over multiple acquisitions of the Normal trace.
12. Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal trace.
13. Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power averaging, which occurs before

the log conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.
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Identifying items in the arbitrary function generator display
This topic shows and describes each element of the arbitrary function generator display.

Each element of the arbitrary function generator display gives information about the generated function.

1. If visible, the output is on
2. AFG label
3. Waveform type, such as Sine
4. Additive Noise icon
5. Frequency
6. Amplitude
7. Offset

Identifying items in the digital voltmeter display
This topic shows and describes each element of the digital voltmeter display.

Each element of the digital voltmeter display gives information about the measurement.

1.

Measurement type (AC+DC RMS, DC, AC RMS, or Frequency)
2. Numerical value of the current measurement
3. Average of all measurement values recorded since you powered on the instrument or since you last reset DVM statistics.
4. Maximum measurement value recorded since you powered on the instrument or since you last reset DVM statistics.
5. Minimum measurement value recorded since you powered on the instrument or since you last reset DVM statistics.
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Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast access to
configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform (Math, Ref, Bus) badges are shown in the Settings Bar, located along the bottom left of the screen. Each
waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a badge to open
its configuration menu.

Most Channel and Waveform badges also have Vertical Scale buttons, shown by single-tapping the badge. Use these buttons to increase
or decrease the vertical scale setting for that waveform.

You can drag or flick Channel and Waveform badges down off the display to turn them off. Swiping back up from the bottom of the display
restores them if they were accidentally deleted.

Channel badges are listed in the channel order. For more information, double-tap the badge to open its configuration menu or search the
instrument Help.

Measurement badges
Result badges are located in the Results Bar. They show measurement or search results. The badge title also shows the measurement
source or sources. To add a Measurement badge, tap the Measure button, select a measurement, and tap Add.

Double-tap a Measurement badge to open its configuration menu to change or refine settings.

Some measurements and their badges are only available as options. For example, Power measurements are only listed in the Add
Measurement menu if the PWR option is installed.

Getting acquainted with your instrument

46

www.tehencom.com          



To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu and select
Show Statistics in Badge.

You can drag or flick Measurement badges off to the right of the display to delete them. You can bring the badge back by swiping in from
the right.

Mask Test Badge
The mask test results and measurement statistics are displayed in the Mask Test badge in the Results bar. The badge is created when the
first segment of a mask is defined.

Badge readout Description
Label A label defined in the badge configuration menu.
Wfms The total number of waveforms tested against the mask.
Failed The number of waveforms that contained one or more samples that violated the mask.
Hits (optional readout) A row is created for each segment that makes up the mask. The number displayed is the number of

times that segment has been hit.
Total The total number of hits on all segments.
Table continued…
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Badge readout Description
Status The status of the mask test. Either Pass (green) or Fail (red) is displayed.

Double-tap a Mask Test badge to open its configuration menu to change or refine settings.

You can drag the badge to change its position in the Results bar and open the badge right click menu to access a quick-action menu.

There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

See for the mask test configuration settings Create a Mask on page 92 for more information masks and Mask Test badge configuration
menu on page 203.

Search badges
Search badges are also shown in the Results Bar, below the Measurement badges. A search badge lists the search source, search type,
and the number of search event occurrences in the current acquisition. The instrument marks the waveform where those events occur with
small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to open its configuration menu to change
or refine search settings.

Search badges are created by tapping the Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the display at the
position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only usable when acquisitions
are stopped.

You can drag or flick a Search badge to the right, off the display, to delete it. You can bring the badge back by swiping in from the right.

Signal clipping and badges
Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved waveform
files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

WARNING: Clipping is caused by excessive or dangerous voltages at the probe tip and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and cause
damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the word Clipping in a Channel badge when a vertical clipping condition exists. Any
measurement badges associated with that channel also indicate a clipping condition.

Getting acquainted with your instrument

48

www.tehencom.com          



To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the excessive voltage
source, and check that you are probing the correct signal using the correct probe.

Error messages and badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.

To remove the message from the badge, clear the error.

System badges
System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System badges.

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase or
decrease the horizontal time/div setting.
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Common badge actions
Action Result Example
Single tap Immediate access controls (Scale,

Navigation).

Double tap Configuration menu with access to all
settings for the badge.

Touch and hold Right-click menu with single tap
access to common actions. Typical
actions include turning off a channel
and deleting a measurement or
search badge.

Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition), measurements,
cursor readouts, Waveform view, and so on.

Double-tap an item (badge, Waveform View, cursor readouts, and so on) to open its configuration menu. For example, double-tap a
Channel badge in the Settings Bar to open its configuration menu.
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Selections or values that you enter take effect immediately. Menu contents are dynamic and can change depending on your selections,
instrument options, or attached probes.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change the values
and/or fields shown in that panel and other panels.

Tap anywhere outside a configuration menu to close it.

To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.
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Zoom user interface
Use the zoom tools to magnify waveforms to view signal details.

1. The Zoom Overview shows the entire waveform record. Use pinch and expand gestures on the Zoom Overview waveforms to change
the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 5 on page 52). You can touch and drag the
box to move the area to view. Moving the Zoom Box or changing its position does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.
4. The DRAW A BOX menu has an option to toggle between drawing a zoom box (default mode) and drawing segments for Mask

Testing.

A zoom box lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview. Drawing a box immediately
puts the oscilloscope into zoom mode. To draw a zoom box, tap the Draw Zoom button while in Zoom mode in the DRAW A BOX
menu, then touch and drag on the waveform to draw a box waveform. You can continue to draw zoom boxes until you single tap
anywhere on the screen or open a menu.

To toggle between Zoom mode and Mask mode, tap the More button and select one of the two options in the DRAW A BOX menu.
5. The Zoom View shows the zoomed waveforms as marked by the Zoom Box. Use pinch and/or drag options in the zoom view to

change the zoomed area of interest. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and
Zoom Box position.

6. Use the Zoom Title Bar controls to adjust the horizontal size and the position of the zoom area. Click or tap the + or - buttons or use
the A and B multipurpose knobs. Double tap the zoom scale and position fields to enter a value using a numerical keypad. Touch the
Zoom Position or Horizontal Zoom Scale fields before using the multipurpose knobs to adjust the zoom.
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Using the touchscreen interface for common tasks
Use standard touchscreen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You can also
use a mouse to interact with the UI. The equivalent mouse operation is shown for each touch operation.

Table 14: Common touchscreen UI tasks (with mouse equivalents)
Task Touchscreen UI action Mouse action
Add a channel, math, reference, or bus
waveform to the screen.

Tap an inactive channel button or the Add
Math Ref Bus button and select a math,
reference, or bus.

Click an inactive channel button or the Add
Math Ref Bus button and select a math,
reference, or bus.

Select a channel, math, reference, or bus
waveform to make it active.

Tap the Channel or Waveform badge or
waveform handle.

Click the Channel or Waveform badge or
waveform handle.

Display scale or navigation buttons on a
badge (waveform, measurement 1, search,
horizontal).

Tap the badge. Click the badge.

Open a configuration menu on any item (all
badges, views, cursor readouts, labels, and
so on).

Double-tap the badge, view, or other object. Double-click the badge, view, or other object.

Open a right-click menu (badges, views). Touch and hold on the badge, Waveform
View, or other screen item until a menu
opens.

Right-click the object.

Close a configuration menu 2. Tap anywhere outside the menu or dialog. Click anywhere outside the menu or dialog.

Move a menu. Touch and hold the menu title bar or a blank
area in the menu, then drag the menu to new
position.

Click and hold the left mouse button on title
or blank area and then drag to new position.

Change horizontal or vertical settings directly
on a waveform.

Vertical changes only apply to the selected
channel or waveform; horizontal changes
apply to all channels and waveforms.

Tap a badge and use the Scale buttons. Or,
use pinch/expand gestures.

Click a channel, waveform, or Horizontal
badge and click on the Scale buttons.

Increase or decrease the zoom area (while
in Zoom mode).

Touch and hold two fingertips on the
waveform view, move them together or apart
vertically or horizontally, lift from screen, and
repeat.

Click and drag the zoom area.

Click the + or - buttons on the Zoom Title
bar.

Adjust the zoom position (while in Zoom
mode).

Touch and drag in the zoom area to adjust
the position of the zoom.

Click and drag in the zoom area to adjust the
position of the zoom.

Quickly scroll or pan a waveform. Touch and drag in the waveform. Click and drag in the waveform or list.
Close or open the Results Bar to increase
the Waveform View area.

Tap on the Results Bar Handle or anywhere
in the border between the Waveform View
and the Results Bar.

Click the Results Bar Handle or anywhere
in the border between the Waveform View
and the Results Bar.

Click and drag the Results Bar divider.

1 Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
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Accessing application help
Use the instrument online help to quickly get information about a function or assistance in performing a task.

Using context-sensitive help
To open help on a particular menu or item, tap the Help button (question mark symbol) in the title bar. The browser opens with content
relevant to the menu or item.

Navigating the online help
Select Help > Help to display the help browser is similar to PC-based Help tools. From the help browser, select one of the following tabs:

• Contents. Click any entry to display information on the subject.
• Index. Click an entry to display information on the subject.
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Configure the instrument

Set the date and time
Set the date and time so that saved files are marked with the correct date and time information.

Procedure
1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.

2. To turn off showing the date and time on the screen, tap the Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the configuration
menu and set the Display button to On.

3. You may also tap the Year, Day, Hour, Minute, or UTC Offset fields and use the multipurpose knobs to set the fields to the correct
time.
You may also double-tap the fields and use the numeric keypad to set the time.

4. Tap Month and select the month from the list.
5. Tap anywhere outside of the menu to close it.

Functional check
Use this procedure to quickly verify that the oscilloscope can display a waveform and take a measurement.

Procedure
1. Power on the oscilloscope.
2. Tap Utility > Self test. Check that all tests listed show Pass.
3. Connect an analog probe to the Channel 1 connector.
4. Connect the probe tip and ground lead to the probe compensation connectors.
5. Push the Autoset button. You should see a square wave in the display (approximately 2.5 V P-P).
6. Tap the Measure button.
7. Tap the Time Measurements panel in the Add Measurements configuration menu.
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8. Double-tap the Frequency button and then the Add button to add the frequency measurement to the Results bar.
9. Check that the Frequency measurement reads 1 kHz
10. Repeat these steps to check the other channels on the oscilloscope. Make sure that you set the source in the Add Measurement

configuration menu to use the correct channel before adding the Frequency measurement.

Download and install the latest firmware
Installing the latest firmware helps ensure that your instrument is equipped with all of the best available measurement and analysis
improvements.

Before you begin
Save any important on-instrument files (waveforms, screen captures, oscilloscope setups, and so on) to a USB drive or network. The
installation process does not remove user-created files, but it is a good idea to back up important files before an update.

Determine the current version of firmware installed on the oscilloscope. The version number is found in the About window under the Help
menu on most instruments.

Procedure
1. Open up a Web browser on a PC and go to www.tek.com/product-support.
2. Enter the oscilloscope model number in the search field and click Go.
3. Scroll down the screen and click the Software tab.
4. If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.
5. Copy the firmware install file to a USB drive.
6. Follow the instructions that are provided with the firmware to create the install files.
7. Insert the USB flash drive into any USB Host port on your instrument. The instrument automatically recognizes the firmware file and

starts the installation process.
8. Follow on-screen instructions. The instrument will take a few minutes to install the new firmware. Do not remove the USB flash drive

or power off the instrument during this time.
9. After the upgrade is complete, power off the instrument and remove the USB flash drive.
10. Power on the instrument.
11. To confirm the firmware update, locate the version number found in the About window under the Help.
12. Confirm that the instrument firmware version number matches the firmware version number that you just installed.

Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature has changed
by more than 5 °C (9 °F) or once a week if you use vertical scale settings of 5 mV/div or less.

About this task
Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path caused by temperature variations and/or
long-term signal path drift.

Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted performance levels at low volts per division
settings.

Configure the instrument

56

www.tehencom.com          



Before you begin
Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

Procedure
1. Power on and warm up the oscilloscope for at least 20 minutes.
2. Tap Utility > Calibration.
3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel to run, so

wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.
4. Close the Calibration configuration dialog when SPC has completed.
5. If SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run SPC again. If SPC still

fails, contact Tektronix Customer Support.

Compensate TPP0250, TPP0500B, or TPP1000 probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for TPP0250, TPP0500B and TPP1000 probes.

About this task
The oscilloscope stores the compensation values for each probe/channel combination and automatically recalls the compensation values
when you plug in the probe again. Probe compensation status is shown in the Probe Setup panel of the Channel configuration menu.

• If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.
• If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have this probe

compensation procedure run.
• If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure. Reconnect the

probe and run probe compensation again.
• If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for that probe.

See the oscilloscope Help for how to manually compensate passive probes not supported by the probe compensation function.
• Each compensation generates values for a specific probe and channel combination. If you want to use the probe on another channel

and desire to compensate the new probe-channel pair, you must run a new set of compensation steps.
• Each channel can store compensation values for 10 individual probes. If you try to compensate an 11th probe on a channel, the

oscilloscope will delete the values for the least recently used probe and add the values for the new probe.

Use this procedure to compensate a TPP0250, TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default status
when connected to the oscilloscope.

Note: A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

Before you begin
The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

Procedure
1. Connect a supported probe to an input channel.
2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope (see

following image).
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Figure 2: Probe Comp connections.

Connect the probe tip to the 1 kHz source and the ground clip to the ground. For best results, remove any probe tip accessories and
hold the probe tip directly onto the 1 kHz connector.

Note: Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.
4. Turn on the channel to which the probe is connected.
5. Push the front-panel Autoset button. The screen displays a square wave.
6. Double-tap the badge of the channel that you want to compensate.
7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe to another
channel and start again from step 1 or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.
8. Tap Compensate Probe to open the Probe Compensation dialog.
9. Tap Compensate Probe to run the probe compensation.
10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and ground from

the PROBE COMP terminals.
11. Repeat these steps for each supported passive probe that you want to compensate for this channel.
12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

Note: For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

Note: A probe compensation failure is most likely due to intermittent connection of the probe tip or ground connection during
the probe compensation operation. If a failure occurs, the oscilloscope will re-use the old probe compensation values if they
existed prior to the failed probe compensation operation.

Compensate passive probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. Use this
procedure to adjust probe compensation for probes with a manual adjustment.

About this task
A passive probe is only adjusted for one channel at a time. If you move a passive probe to another channel, you must compensate that
probe to that channel.
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Procedure
1. Connect the probe to the channel where you want to use it to take measurements. Remove all other probes.
2. Turn on the channel to which the probe is connected. Turn off all other channels.
3. Attach the probe tip and reference lead to the probe compensation connectors.
4. Push the Autoset button to display a square wave.
5. Adjust the vertical Scale and Position knobs to display as large a waveform as possible.
6. Use the adjustment tool provided with the probe to adjust the probe until the square wave has as flat a top as possible. See your probe

manual for adjustment location and instructions.

Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

Before you begin
Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP address,
Subnet Mask, DNS IP address, and so on).

Procedure
1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.
2. Select Utility > I/O on the menu bar to open the I/O configuration menu.
3. Tap the LAN panel
4. Obtain or enter the network address information:

• If your network is DHCP-enabled and the IP address field does not already show an address, tap Auto to obtain the IP address
information from the network. DHCP mode is the default mode.

• If your network is not DHCP-enabled or you need a static (non-changing) IP address for this instrument, tap Manual and enter the
IP address and other values provided by your IT or system administrator resource.

5. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the instrument
successfully connects to your network. If you have problems connecting to your network, contact your system administration resource
for help.

Mount a network drive
Use this procedure to mount (map) a network Linux mount point or Windows shared directory on a standard instrument.

Before you begin
Prerequisites:

The oscilloscope must be connected to a network that has access to the directories to mount or unmount. See the Connect to a network
(LAN) topic in the application Help.

To mount a Linux network drive on the oscilloscope, the network Linux mount point (drive, host) that you want to mount must be exported.
If the mount point is not exported, work with your organization's IT resource to get that location exported and accessible to your network.
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About this task
To mount a network drive on your oscilloscope:

Procedure
1. Tap File > File Utilities.
2. Tap Mount to open the Mount Network Drive menu.
3. Select the drive letter to assign to the network drive from the Drive Letter list.
4. Tap Name or IP to specify how you will enter the host name (server) of the network mount location or PC.
5. Enter the network host name or IP address of the Linux mount point or server in the Server Name or Server IP Address field.

Example: ACME-PC0205
6. Enter the path to the location of the mount point or shared directory of the server in the Path field.

• Linux example: /opt/testing/batch1 (Linux requires forward slashes in path definitions. Linux assumes that the path starts at the root
directory.)

7. If access to this network location is controlled, enter the required information in the User Name, Password, and Domain fields.
8. Tap Enter. The oscilloscope mounts the drive and adds the specified drive letter to the File Utilities menu.

The oscilloscope displays an error message if it cannot mount the drive. Work with your organization's IT resource to verify that the
access information is correct and to resolve the network access problems.

Unmount a network drive
Use this procedure to unmount (remove) a network Linux mount point or Windows shared directory from a standard or Windows OS
instrument.

About this task
To unmount a network drive from your instrument:

Procedure
1. Tap File > File Utilities.
2. Select the drive to unmount.
3. Tap Unmount. The instrument unmounts the drive and removes it from the Drive column.

Note: Any network locations that were mounted when the oscilloscope was powered down will be automatically remounted
when the oscilloscope is powered up. Unmount any network location that you do not want to automatically remount on power
up.

Deskew analog input channels - quick visual method
Use the following procedure to visually align waveform edges to compensate for timing differences between probes.

About this task
Critical timing measurements on multiple channels require that all probes be adjusted, or deskewed, to compensate for signal timing
differences between probes. This procedure uses displayed waveform edges to quickly minimize deskew between probes.

Note: Once probes have been deskewed for a particular channel, you should only use the probes on the channels for which they
were deskewed, when taking critical timing measurements.
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Procedure
1. Connect all probes that you want to deskew.
2. Connect up to four probe tips and ground leads to the Probe Compensation connector (maximum of four channels at a time).
3. Turn on (display on screen) the connected channels that you want to deskew.
4. Push the Autoset button.
5. Adjust the vertical Scale and Position controls for each channel so that the signals overlap and are centered on the display.
6. Adjust the horizontal Scale so that the differences in the channel delays are clearly visible.
7. Determine the channel you want to use as your reference.
8. Double-tap the Channel badge of a channel other than the reference channel and tap the Other panel.
9. Tap the Deskew field and use the multipurpose knob to align this channel with the reference channel waveform such that the

waveforms cross the trigger point at the same time. For fine adjust, double-tap the Deskew field to open a number pad.
10. Repeat steps 8 on page 61 and 9 on page 61 for each additional channel you want to deskew.

Deskew analog input channels - measurement method
Use the following procedure to more accurately minimize timing differences between probes.

About this task
Critical timing measurements on multiple channels require that all probes be adjusted, or deskewed, to compensate for signal timing
differences between probes. This procedure uses a Delay measurement to adjust a probe's deskew setting.

Note: Once probes have been deskewed for a particular channel, you should only use the probes on the channels for which they
were deskewed when taking critical timing measurements.

Procedure
1. Connect all probes that you want to deskew to the oscilloscope.
2. Connect up to four probe tips and ground leads to the Probe Compensation connector.
3. Turn on all the channels that you want to deskew.
4. Push the Autoset button.
5. Change the vertical Scale of all active channels to 500 mV/div and adjust the vertical Position so that the waveforms are centered on

the display.
6. Determine the channel you want to use as your reference.
7. Tap the Measure button and tap the Time Measurements panel.
8. Select the Delay measurement, then tap the Add button.
9. Double-tap the Delay measurement badge and set your chosen reference channel as Source 1 and your channel being deskewed

as Source 2.
10. Double-tap the Channel badge of the channel being deskewed (Source 2) and tap the Other panel
11. Tap the Deskew field and use the multipurpose knob to align this channel with the reference waveform such that the measured delay

between channels becomes a minimum. For fine adjust, double-tap the Deskew field to open a number pad.
12. Double-tap the Delay measurement badge and set the Source 2 channel to the next channel to deskew.
13. Repeat steps 10 on page 61 through 12 on page 61 for each additional channel you want to deskew.
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Connect a keyboard or mouse
The instrument supports most standard USB-connected keyboards and mice, including wireless-connected keyboards and mice (using a
USB-connected dongle).

About this task
You can use the keyboard to quickly create names or labels. Use the arrow keys on the keyboard to move the insertion point, and then
type in a name or label. Labeling channels and buses makes the information on the screen easier to identify.

Connect a keyboard and/or mouse by connecting their USB cable, or USB dongle, into any available USB Host port. The keyboard or
mouse should work immediately. If it does not, try the following:

Procedure
1. Remove and reinsert the USB cable or dongle in the same port.
2. Insert the USB cable or dongle into a different USB port.

Connect an external monitor or projector
Use the video outputs to send the instrument display to a projector or to a flat-panel LCD monitor.

Procedure
1. Power on the oscilloscope.
2. Connect the appropriate video cable to the projector or monitor. Connect the other end to the HDMI connector on the oscilloscope.
3. Power on the projector or monitor.
4. Follow the projector or monitor instructions to set up and adjust the image.

ESD prevention guidelines
Electrostatic discharge (ESD) can damage oscilloscope and some probe inputs. This topic discusses how to avoid this type of damage.

ESD is a concern when handling any electronic equipment. The instrument is designed with robust ESD protection, however it is still
possible that large discharges of static electricity directly into the signal input may damage the instrument. Use the following techniques to
prevent electrostatic discharge from damaging the instrument.

• Discharge the static voltage from your body by wearing a grounded antistatic wrist strap while connecting and disconnecting cables,
probes, and adapters. The instrument provides a ground connection for attaching a wrist strap (above the Probe Comp ground
connector).

• A cable that is left unconnected on a bench can develop a large static charge. Discharge the static voltage from all cables before
connecting them to the instrument or device under test by momentarily grounding the center conductor of the cable, or by connecting a
50 Ω termination to one end, before attaching the cable to the instrument.

• Before you apply power, connect the instrument to an electrically-neutral reference point, such as earth ground. To do this, plug the
three-pronged power cord into an outlet grounded to earth ground. Grounding the oscilloscope is necessary to ensure safety and to
take accurate measurements.

• If you are working with static sensitive components, ground yourself. Static electricity that builds up on your body can damage
static-sensitive components. Wear a wrist strap to safely send static charges on your body to earth ground.

• The oscilloscope must share the same ground as any circuits that you plan to test.
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Analog channel operating basics

Acquiring a signal
After acquiring a signal you can take measurements.

Use the following procedure to set the scale and position parameters for analog signal acquisition.

1. Press the Default Setup button.
2. Connect the probe output to the desired oscilloscope channel and connect the probe input to the input signal source using proper

probing/connecting techniques.

Note: Some probes automatically set their termination and other values.

3. Tap the channel button to add the channel waveform to the waveform view and add a channel badge to the setting bar. A channel
button lights when its channel is on.

4. Double-tap the channel badge to open the channel Vertical Settings menu. To change the input coupling, select the appropriate
coupling button.

• Select DC to couple both the AC and DC components of an input signal.
• Select AC to couple only the AC components of an input signal.

5. Use the Vertical knobs to scale and position the waveform vertically on the screen. The knobs are highlighted with the color of the
active channel. Dragging the waveform handle also positions the waveform.

6. Use the Vertical Settings menu to change the offset. Tap Offset, then use a multipurpose knob to adjust the offset.
7. Use the Horizontal knobs to scale and position the waveform horizontally on the screen and to set the record length. Dragging the

trigger position icon or the waveform itself also positions the waveform.
8. Use the Horizontal menu to set the record length.
9. You may attempt to stabilize the display by pressing the trigger Level knob to set the trigger level to 50%. The 50% level is calculated

as the midpoint between the highest and lowest samples of the acquired waveform. If your signal is periodic, you should see a stable,
triggered signal. This method will not work as well with random signals.

Quickly display a waveform (autoset)
The Autoset function analyzes the signal characteristics and changes the instrument's Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the points of
interest.

Procedure
1. Connect the probe with the signal of interest to an available channel. The signal can be analog or digital.
2. Double-tap the Trigger badge and set the trigger source to that of the signal of interest.
3. Connect any other associated signal(s) to available channel input(s).
4. Add the channel waveforms to the Waveform view. See Add a channel waveform to the display on page 67.
5. Tap File > Autoset or push the front-panel Autoset button. The instrument analyzes the signal characteristics of the trigger source

channel (analog or digital) and adjusts the horizontal, vertical, and trigger settings accordingly to display a triggered waveform for that
channel.
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What to do next
Autoset guidelines:

• Autoset displays four or five cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.
• The trigger is set to type Edge, rising slope, DC coupling.
• If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the Waveform view whether it has a signal or not.
• Autoset ignores math, reference, and bus waveforms.
• A channel or waveform with a frequency less than 40 Hz is classified as no signal.

Set horizontal parameters
Use this procedure to set the horizontal time base parameters such as position, horizontal scale, and delay.

Procedure
1. Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.

2. Use the menu selections to set horizontal parameters.
3. Tap the Help icon on the menu title for more information on these settings.

How to trigger on a signal
Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

Procedure
1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.
2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the illustration

to show a graphic of the trigger type.
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Note: To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus
waveform on page 69

Note: Triggering on buses other than Parallel requires the purchase and installation of serial trigger and analysis options. See
the Tektronix Web site for available serial trigger and analysis options.

3. Select the other fields to refine the trigger conditions. The menu fields and trigger graphic update as you make changes to the trigger
settings. Displayed fields depend on the selected trigger type. Selection changes take effect immediately.

4. Tap the Help icon on the menu title for more information on these settings.
5. Tap outside the menu to close the menu.

Set the acquisition mode
Use this procedure to set the method the instrument uses to acquire and display the signal.

Procedure
1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.
2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected acquisition type.
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3. Tap the Help icon on the menu title for more information on these settings.
4. Tap outside the menu to close the menu.

Start and stop an acquisition
Acquisition controls the start and stop of waveform acquisition.

Procedure
1. To start an acquisition, double-tap the Acquisition badge and tap Run/Stop in the Acquisition configuration menu. You can also push

the Run/Stop button on the front panel.

2. To stop an acquisition, tap Run/Stop again or push the Run/Stop button.
3. To take a single acquisition, double-tap the Acquisition badge and tap Single/Seq in the Acquisition configuration menu or push the

Single/Seq button on the front panel.
4. The color of the Run/Stop and Single/Seq buttons on the front panel indicate the acquisition status (green = acquiring; red = stopped).
5. To clear the current acquisition data from waveform memory, double-tap the Acquisition badge and tap Clear in the Acquisition

configuration menu, or push the Clear button on the front panel.
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Add a channel waveform to the display
Use this procedure to add a channel signal to the display.

Procedure
1. Connect signal(s) to the channel input(s).
2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

The selected channel is added to the Waveform View, and a Channel badge is added to the Settings bar.

3. Continue tapping Inactive Channel buttons to add more channels (digital or analog).

4. Double-tap a channel badge to open that channel's configuration menu to check or change settings. See Configure channel or
waveform settings on page 67.

Configure channel or waveform settings
Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth, probe
settings, deskew values, external attenuation, and other settings.

Before you begin
Prerequisite: There is a channel or waveform badge in the Settings bar.

Procedure
1. Double-tap a Channel or Waveform badge to open a configuration menu for that item.
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For example, in a Channel menu, use the Vertical Settings panel to set basic parameters such as vertical scale and position, offset,
coupling, termination, and bandwidth limit.

Available settings depend on the probe.

2. Tap the Probe Setup panel to confirm probe settings and run configuration or compensation on supported probes.

3. Tap the Other panel to set probe deskew and external attenuation parameters.

4. Tap the Help icon on the menu title to open the help topic for more information.
5. Tap outside the menu to close the menu.
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Add a math, reference, or bus waveform
Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and analyze
serial or parallel data.

About this task
You can add 1 Math, 4 Reference (2 Reference on a 2 channel instrument), or 2 Bus waveforms to the Waveform View.

Procedure
1. Tap the Add Math Ref Bus button in the Settings bar and select from the available waveforms.

2. The instrument adds the waveform to the Waveform view and adds a Waveform badge to the Settings bar. This example shows adding
the Math waveform.

3. Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections made in the
menu. Selection changes take effect immediately.
This example shows adding a Math waveform by using the Math Source fields to select Ch 1 and Ch 2 as the waveform sources,
setting the math type to Basic math operation, and subtracting channel 2 from channel 1.

4. When adding a Reference waveform, if a reference is not defined, the instrument displays a Recall configuration menu. Navigate
to and select the reference waveform file (*.isf) to recall, then tap the OK, Recall Waveform button. The instrument displays the
Reference waveform.

5. Double-tap a math, reference, or bus badge to check or change that waveform's settings. See Configure channel or waveform
settings on page 67.

6. Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.
7. Tap outside the menu to close the menu.
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Add a measurement
Use this procedure to select and add measurements.

Procedure
1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.

Note: Waveforms do not need to be displayed to be used for measurements as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2. Tap the Measure button to open the Add Measurements configuration menu.

Note: If the menu shows tabs, then optional measurement types have been installed on the instrument. Select a tab to show
the measurements for that option.

Note: If frequency domain (RF) is active, tapping the Measure button opens the Add Measurements configuration menu
for RF.

3. Tap the Source field and select the measurement source. The list shows all available sources that are valid for the measurement.

4. Select from the configuration menu panels, such as Amplitude Measurements, Timing Measurements, and Other, to display
measurements for those categories.

5. Select a measurement and tap Add to add the measurement to the Results bar.
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6. Select and add other measurements for the current source. Tap the measurement category panels to display and select other
measurements to add.

7. To add measurements for other sources, select a different source, select a measurement, and add the measurement.

8. Tap outside the Add Measurements menu to close the menu.
9. To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that measurement.

See Configure a measurement on page 71.
10. Tap the Help icon on the menu title for more information on settings.

Configure a measurement
Use this procedure to add statistical readouts to the measurement badge and refine measurement parameters (configuration, global
versus local scope of settings, gating, and so on).

Procedure
1. Double-tap a measurement badge to open its Measurement configuration menu.
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2. Tap Show Statistics in Badge to add statistical readouts to the measurement badge.

3. Tap available panel titles to make changes for those categories.

4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection changes take
effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.
6. Tap outside the menu to close the menu.

Delete a measurement or search badge
Use this procedure to remove a Measurement or Search badge from the Results bar.

Procedure
1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.
2. Select Delete Meas or Delete Search to delete that badge from the Results bar.
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3. You can also delete a Measurement or Search badge by dragging it off the display. You can use the mouse to drag and delete a badge.

Display an XY waveform
Use this procedure to display an XY waveform.

About this task
XY display mode displays the amplitude from one waveform against the amplitude from another.

Procedure
1. Double-tap the Acquisition badge.

The Acquisition configuration menu is displayed.
2. Tap XY Display to toggle the mode on or off.

Results
A data point from the first waveform specifies the horizontal location while the corresponding data point from the second waveform
specifies the vertical location for each displayed point.

Display an FFT math waveform
Use this procedure to display an FFT math waveform.

About this task
The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot acquisition) into its frequency
components. The FFT function processes the waveform record and displays the FFT frequency domain record, which contains the input
signal frequency components from DC (0 Hz) to ½ the sample rate (also called the Nyquist frequency).

Procedure
1. Tap Add Math Ref Bus and then tap Math.
2. Double-tap the Math badge to open the Math configuration menu.
3. Tap Source and select the signal source from the list.
4. Set Math Type to FFT.

The FFT of the waveform is displayed in an FFT Math waveform view.
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5. Use the controls to further refine the FFT display.

Add a search
Use this procedure to set search criteria and mark a waveform where those events occur.

About this task
You can search on analog and digital signals, math waveforms, and reference waveforms.

Prerequisite: Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

Procedure
1. Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.
2. Tap the Search button to open the Search configuration menu.

3. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select the
Search Type, Source, and conditions on which to search).

4. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. The example image shows
search criteria set to find positive pulse widths that are less than 70 ns wide.

5. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.
6. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap a Search

badge, and tap the < or > Navigation button.

Analog channel operating basics

74

www.tehencom.com          



This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.
7. To return the instrument to normal acquisition mode, tap the Zoom icon in the upper right corner of the Waveform View to turn off

Zoom mode, and then push the Run/Stop front-panel button to set it to Run mode.

Change waveform view settings
Use this procedure to change the waveform persistence, style, and intensity; graticule style and intensity; and screen annotation.

Procedure
1. Double-tap on an open graticule area to open the Waveform View configuration menu.

2. Use the controls to set the waveform point persistence, style, and intensity, graticule style and intensity, and screen annotation.
3. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view

parameters.
4. Tap outside the menu to close the menu.

Display and configure cursors
Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform. Cursor readouts show both current
position values and the difference (delta) between cursors.

Procedure
1. Tap the Cursors button, or push the front-panel Cursors button.

The cursors are added to the display.
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2. Use Multipurpose Knobs A and B or touch and drag to move the cursors. Cursors show readouts that show position and difference
measurements between the cursors.

3. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration menu. For
example, tap the Cursor type to select the cursors to display, such as Waveform.

4. Tap the Help icon on the menu title for more information on the menu settings.
5. To stop showing cursors, push the front panel Cursor button or open the Cursors configuration menu and set Display to Off.

Using Default Setup
Use Default Setup to restore instrument settings to their factory defaults.

Procedure
1. Press the front panel Default Setup button to return the instrument to its factory default settings (horizontal, vertical, scale, position,

and so on).

2. You can also select File > Default Setup to restore default settings.
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Using Fast Acq
Fast Acq (fast acquisition mode) reduces the dead time between waveform acquisitions, enabling the capture and display of transient
events such as glitches or runt pulses. Fast acquisition mode can also display waveform occurrences at intensity levels that reflect their
rate of occurrence.

Procedure
1. To use Fast Acquisition mode, double-tap the Acquisition badge. Tap Acquisition mode and select Fast Acq from the list. You can

also push the Fast Acq front-panel button.

2. To display waveform phenomena at an intensity that reflects their rate-of-occurrence, after selecting the Fast Acq acquisition mode,
tap Fast Acq Palette and select a display palette from the drop-down list.

3. Fast Acq displays waveform phenomena at an intensity that reflects their rate-of-occurrence
4. View the waveform to find glitches, transients, or other random events. When you have identified an anomaly, use the advanced trigger

system to capture the event of interest for further analysis.

Analog channel operating basics

3 Series Mixed Domain Oscilloscope Help 77

www.tehencom.com          



Note: If Fast Acquisitions mode is on and you attempt to activate a feature that conflicts with this mode, Fast Acquisitions
mode will be disabled. When the conflicting feature is turned off, Fast Acquisitions will resume in most cases.

Remote access from a Web browser
You can remotely access your network-connected instrument from a Web browser to display the instrument user interface on a PC.

About this task
This procedure describes how to remotely access the UI controls and screen for the instrument.

Before you begin
• The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network

(LAN) on page 59
• Determine the IP address of the oscilloscope that you want to access. To determine the oscilloscope's IP address, select Utility > IO in

the oscilloscope menu bar and view the network settings in the LAN panel.

Procedure
1. Open a Web browser on a PC connected to the same network as the oscilloscope.
2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The browser

searches for and opens the Web page for the oscilloscope.
3. Select Instrument Control (e*Scope®). The browser displays the instrument screen.
4. Use a mouse to select and interact with the oscilloscope controls shown in the Web browser. If your remote PC or laptop has a

touchscreen monitor, you can use that to access the oscilloscope controls.
When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address information, and
so on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is available in the e*Scope
application.

Use the following steps to copy text from an e*Scope-connected PC to the instrument:

a. Open a connection to the instrument using e*Scope.
b. Select and copy the text on your PC.
c. In e*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.
d. Paste the text into the Clipboard field.
e. Press Ctrl-Alt-Shift to close the browser Clipboard menu
f. Use e*Scope to open the instrument menu to which to paste content and position the cursor in the field where you want to paste

the text.
g. Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the menu field.
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h. Repeat steps 4.b on page 78 through 4.g on page 78 to copy and paste other text from the PC to the instrument.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

Procedure
1. On the oscilloscope, select Utility > I/O from the menu bar.
2. Tap USB Device Port.
3. Confirm that the USB Device Port control is On (default setting).
4. Connect a USB cable from the PC to the USB Device port on the rear of the instrument.
5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address for your

configuration (0 - 30).
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Acquiring digital signals

Acquiring digital signals
Connect a P6316 logic probe to digital input. Connect the logic probe inputs to the DUT (see the probe instructions). Then use the
following topics to set up, acquire, and display digital signals.

 

• Connect and set up digital signals on page 80
• Add a serial bus to the Waveform view on page 81
• Add a parallel bus to the Waveform view on page 83

Connect and set up digital signals
Use the digital Channel configuration menu to set up the digital channels to acquire signals.

About this task
Digital channel configuration menus are available only if a supported digital logic probe is attached to the oscilloscope.

CAUTION: To prevent damage to the instrument always wear an antistatic wrist strap when making connections to the instrument
and DUT. Always observe the maximum input voltage ratings for input connectors.

Procedure
1. Connect the logic probe to the instrument. Tap the D15-D0 . The digital signal waveforms are opened on the screen.
2. Connect the probe to the signal sources. Use the accessories in the Tektronix Probe accessory Kit (shipped with the probe) to connect

to your DUT.

3. Double-tap the D15-D0 button to open the Digital configuration menu. Set up digital channels to match your digital logic requirements.
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4. Tap Display to toggle the digital channel group On or Off.
5. To change the displayed height of the digital channels, tap a Height button.
6. Tap a Bit control to toggle individual digital channel bits On or Off and remove them from the displayed logic waveform.
7. Tap a Threshold field and use multipurpose knob A to set bit threshold levels. You can also set the thresholds by double-tapping the

field and setting the threshold using the virtual keypad.
8. Use the bit Label fields to enter labels for the individual digital channel bits (D0-D15). Double-tap on the field and use the virtual

keyboard to enter label text. Or tap the field and use an attached keyboard to enter label text.
9. Tap Turn All Off to turn all digital bits Off (D15-D7 or D7-D0).

Add a serial bus to the Waveform view
Use this procedure to add a serial bus to the Waveform view.

This instrument supports decoding parallel buses (standard with the instrument) and several serial buses options (see Serial bus decode
and trigger options on page 26). All serial bus functions are options that must be purchased and installed before they are available in the
instrument menus.

Use a Bus configuration menu to define a bus from which to acquire, decode, and display data.

Procedure
1. Tap the Add Math Ref Bus button on the Settings bar and then tap Bus to add a Bus badge to the Settings bar and add a bus

waveform to the screen. The default bus type is parallel.
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2. Double tap the Bus badge to open the Bus Configuration menu.
3. Tap Bus Type and select the bus type from the drop-down list.

 

4. Use the fields and controls to select the bus signal sources, thresholds, other parameters, and the output format. The following
example shows the settings for an I2C serial bus.
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The decoded bus is updated on the screen as you make changes to the settings.

 

5. Tap outside of the Bus configuration menu to close it.
6. Double-tap the Trigger badge and use the Trigger configuration menu to trigger on a specific condition in the bus.

 

7. For more information on serial bus settings, tap the Help button on the Bus configuration menu.

Add a parallel bus to the Waveform view
Use this procedure to add a parallel bus to the Waveform view.

When you acquire data from a Parallel bus, you can set up the bus to be clocked or unclocked. If the bus is not clocked, the instrument
acquires all data from the parallel bus at the sample rate of the instrument.

Procedure
1. Tap the Add Math Ref Bus button on the Settings bar and then tap Bus to add a Bus badge to the Settings bar and add a bus

waveform to the screen. The default bus type is parallel.
2. Double tap the Bus badge to open the Bus Configuration menu.
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3. If setting up a clocked bus:

 

a) Set Clocked Data to Yes.
b) Tap the Clock Source field and select the source for the parallel bus clock signal.
c) Tap the Clock Polarity and Threshold controls and set the clock signal transition to detect and threshold level, respectively.

4. Tap Define Inputs and select the signal sources for the parallel bus. Signal sources can be analog or digital. Tap a signal in the
Sources list to add it to the bus list on the left.
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The bus waveform updates as you make changes on the configuration menu. Tap the + symbol next to the waveform handle to turn on
and off showing the signals associated with the bus waveform.

5. Use the rest of the fields and controls in the configuration menu to set up the parallel bus parameters (label, position, display and
decode formats).

6. Tap outside of the Bus configuration menu to close it.
7. To get a stable triggered waveform, double-tap the Trigger badge, set the Trigger Type to Bus, select the bus Source to the parallel

bus you just set up, and enter the data condition on which to trigger in the Data field.
8. For information on parallel bus menu settings, tap the Help button on the Bus configuration menu.
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Advanced triggering

Advanced triggering
You can check the advanced trigger status in the trigger menu. The menu indicates the trigger type and then shows sources, levels, or any
other parameters that are important for the particular trigger type. Use the following links for more information on advanced triggering.

 

• Triggering concepts on page 86
• Set Trigger Holdoff on page 87
• Trigger on sequential events (A and B triggers) on page 88
• Set up trigger on a parallel bus on page 88
• Set up trigger on a serial bus on page 89

Triggering concepts
Overview
User selected trigger conditions are used to capture waveforms for measurement and analysis.

Triggers help you capture meaningful waveforms to display on screen. This instrument has simple edge triggers as well as a variety of
advanced triggers.

The trigger event
The trigger event establishes the time-zero point in the waveform record. All waveform record data are located in time with respect to that
point. The instrument continuously acquires and retains enough sample points to fill the pretrigger portion of the waveform record (that part
of the waveform that is displayed before, or to the left of, the triggering event on screen).

When a trigger event occurs, the instrument starts acquiring samples to build the posttrigger portion of the waveform record (displayed
after, or to the right of, the trigger event). Once a trigger is recognized, the instrument will not accept another trigger until the acquisition is
complete and the holdoff time has expired.

Trigger on a pulse width event
Pulse-width triggering triggers the instrument when a signal pulse width is less than, greater than, equal to, or not equal to a specified
pulse width. This trigger is useful for digital logic troubleshooting.

About this task

To set a pulse width trigger:

Procedure
1. Double-tap the Trigger badge to open the Trigger configuration menu.
2. Tap Trigger Type and select Pulse Width.
3. Tap Source and select the trigger source.
4. Tap Trigger When and select the pulse width condition on which to trigger (> Limit, < Limit, = Limit, ≠ Limit, Outside Range,

Inside Range).
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5. Set the pulse width time constraints:
a) For all Trigger When conditions except Outside Range or Inside Range, tap the Time Limit field and use the assigned

multipurpose knob to set the pulse width time condition to meet.
b) For Outside Range or Inside Range conditions, tap the High Time Limit and Low Time Limit fields and use the assigned

multipurpose knobs to set the pulse width time range condition to meet.
6. Tap the Level field and set the threshold value at which you want to measure pulse width.
7. Select the pulse polarity on which to trigger.

Set Trigger Holdoff
Trigger Holdoff sets the time, after triggering on an event, that the instrument waits before detecting the same trigger event to start the next
acquisition.

About this task
Setting the correct holdoff time is important to get a stable trigger. The longer holdoff time for the top waveform causes unstable triggering.
The shorter holdoff set for the bottom waveform only triggers on the first pulse in the burst to remedy the unstable trigger.

Procedure
1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.
2. Tap the Mode & Holdoff panel.
3. To set a specific holdoff time, tap Holdoff and use the assigned multipurpose knob to specify a holdoff time. Or double-tap the field and

use the virtual keypad to enter a holdoff time.
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Trigger on sequential events (A and B triggers)
Use the A and B Trigger Events to trigger on a second event after a first event occurs.

Set up sequential triggering

Procedure
1. Double-tap the Trigger badge to open the Trigger configuration menu.
2. Tap Trigger Type and select Sequence. Sequence triggering uses Edge triggering for both the A and B trigger types.
3. Set up the A Trigger Event:

a) Tap A Source and select the A event trigger source.
b) If displayed, tap Coupling and select the trigger coupling.
c) Tap A Level and set the desired trigger level using the multipurpose knob. Or double-tap the field to set the value using the virtual

keypad.
d) Tap a A Slope button to select the slope of the signal on which to trigger (Rise or Fall).

4. Set up the B Trigger Event:
a) Tap B Source and select a trigger source.
b) Tap B Level and set the desired trigger level using the multipurpose knob. Or double-tap the field to set the value using the virtual

keypad.
c) Tap a B Slope button to select the slope of the signal on which to trigger (Rise or Fall).

5. To trigger on a specific occurrence of the B trigger event:
a) Tap After the A Trigger Event is found: Trigger on the Nth Trigger Event button in the main Trigger menu.
b) Tap Where N is: and use the multipurpose knob to set the oscilloscope to trigger on the Nth occurrence of a B trigger event.

6. To trigger on the B event after a specific time delay:
a) Tap After the A Trigger Event is found: Trigger on the 1st B Event button.
b) Tap After a Delay of: and use the multipurpose knob to set the desired delay time to wait before detecting and triggering on a B

trigger event. You can also double-tap the field and use the virtual keypad to enter a delay time.

Set up trigger on a parallel bus
Use this procedure to set up triggering on a parallel bus.

Before you begin
Use this procedure if you have already created a parallel bus.

Procedure
1. Double-tap the Trigger badge.
2. Tap the Trigger Type field and select Bus from the list.
3. Tap the Source field and select the parallel bus on which to trigger.
4. Tap either the Binary or Hex Data boxes to enter the parallel bus data value, in either Binary or Hexadecimal format, on which to

trigger. The number of bits shown depends on the number of sources (channels) in the parallel bus.
a) Use multipurpose knob A to select the digit or digits to change.
b) Use multipurpose knob B to change the value of the selected digits.
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Set up trigger on a serial bus
Use this procedure to set up triggering on a serial bus.

Before you begin
Use this procedure if you have already created a serial bus. Serial buses require the purchase and installation of serial bus options. See
Serial bus decode and trigger options on page 26.

Procedure
1. Double-tap the Trigger badge on the Settings bar.
2. Tap Trigger Type and select Bus from the list.
3. Tap Source and select a serial bus from the list.
4. Tap Trigger On and select what to trigger on from the list. The displayed fields and controls depend on the bus type and Trigger On

selection. Use these fields to trigger on a specific bus condition.

Trigger using the AUX input
Use this procedure to trigger the instrument from an external signal connected to the AUX input.

Procedure
1. Double-tap the Trigger badge on the Settings bar.
2. Tap Trigger Type and select Edge from the list.
3. Tap Source and select Aux.

Note: Aux is available only on 2 channel instruments and for the Edge trigger type.

4. Set the values for Coupling, Level, and Slope to trigger on the Aux connector signal.

Advanced triggering

3 Series Mixed Domain Oscilloscope Help 89

www.tehencom.com          



Setting waveform display parameters

Setting waveform display parameters
Use waveform display controls to set the persistence, style, and intensity display parameters, and graticule style and intensity.

Use the following topics for more information on setting display parameters.

 

• Set the waveform persistence style and intensity on page 90
• Set the graticule style and intensity on page 90

Set the waveform persistence style and intensity
Use the Waveform View configuration menu to set waveform persistence, style, and intensity.

Procedure
1. Double-tap on an open graticule area to open the Waveform View menu.
2. Tap the Persistence field to select the persistence option.

• Off disables display persistence.
• Auto lets the oscilloscope automatically determine a persistence time for you.
• Infinite persistence continuously accumulates record points until you change one of the acquisition display settings. Use infinite

persistence for displaying unique signal anomalies, such as glitches.
• Variable persistence accumulates record points for a specified time interval. Each record point decays independently according to

the time interval. Use variable persistence for displaying infrequently appearing signal anomalies, such as glitches.

If you select Variable persistence, tap Variable Persistence and set the time using the multipurpose knob or double-tap the field
and use the virtual keypad to enter the time value.

3. Tap the Waveform Style buttons to set waveforms to draw as vectors (continuous lines) or dots.

• Vectors displays the waveform with the waveform sample values connected by vectors.
• Dots displays the individual waveform sample values.

4. Tap the Waveform Intensity field and use the multipurpose knob to set the brightness of all waveforms.

Set the graticule style and intensity
Use this procedure to set the graticule (display grid) style and intensity.

Procedure
1. Double-tap on an open graticule area to open the Waveform View configuration menu.
2. Tap the Graticule Style field to select a graticule style from the list.

 

Full shows a frame, cross hairs, and a grid on the instrument display. This style is useful for making quick, full-screen measurements
with cursors and automatic readouts when cross hairs are not needed.
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Grid, Solid, and Cross Hair provide compromises between Frame and Full.

Frame provides a clean screen on which you can most easily read automatic measurement results and other screen text.
3. Tap the Graticule Intensity field and use the multipurpose knob to set the brightness of all graticules.
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Mask testing waveforms
Mask testing determines how well your signals conform to expected signal quality and provides instant automated statistical analysis. A
mask defines a portion of the instrument display that a signal must not enter. Mask testing is supported for analog channels but it does not
support for analog math waveforms, analog reference waveforms, and digital channels.

Create a Mask
Use the More button to create a new mask on the instrument display.

1. Tap the More button and select the Mask button on the DRAW A BOX menu window. This sets the DRAW A BOX function to Mask
mode.

2. Tap outside the menu to close the DRAW A BOX menu. The Draw Mask button is highlighted to show that it is in Mask draw mode.
3. Tap the Draw Mask button at the top right of the Results Bar to draw a rectangle on the waveform screen for the first segment to

define. The segment created is associated with the active channel.
4. Continue drawing rectangles to add other mask segments by selecting a channel before creating segments for that channel.
5. When you are done drawing the mask segments, tap anywhere to end the segment draw function.
6. To draw segments again, tap the Draw Mask button again.

You can add maximum one mask with a maximum eight segments.
7. To change the shape of a segment, see Edit mask segments using the Mask Definition menu on page 92 .
8. To delete a mask segment:

a. Touch and hold or right click on the segment to delete.
b. Select Delete Segment from the menu.

Edit mask segments using the Mask Definition menu
The Mask Definition Segment menu allows you to edit the mask, including moving, changing size, moving individual vertices, adding and
deleting vertices. You have the choice to edit a mask by segments or waveform tolerance with the Mask Defined By options in the Mask
Settings panel.

See Mask Definition Segment configuration menu on page 202

See for more information on the mask settings.

1. To add a point (vertex) to a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segment under the Mask Defined By options.
c. Select the vertex in the list counterclockwise from where you want to insert a new vertex.
d. Tap Insert Point. A new vertex is added to the segment and is highlighted in the list.
e. Continue adding vertices as needed.
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2. To delete a point (vertex) from a segment using the Mask Settings menu:

• Double-tap on the segment to edit.
• Select Segment under the Mask Defined By options.
• Select the vertex in the list that you want to delete.
• Tap Delete Point. The selected vertex gets deleted.
• Continue deleting vertices as needed.

3. To move individual vertices in a segment using the Mask Settings menu:

• Double-tap on the segment to edit.
• Select Segment under the Mask Defined By options.
• Select the vertex in the list that you want to move.
• Tap the X- Axis or Y-Axis field in the list and use the A and B knobs to change the position values. Or double-tap on each field and

enter the new positional values for that vertex.
4. To clear the shape using the Mask Settings menu:

• Double-tap on the segment to edit.
• Select Segment under the Mask Defined By options.
• Tap Clear Table. The shape changes to a triangle centered in the display.

5. To save the segment vertices using the Mask Settings menu:

• Tap the Save panel.
• Tap Save Mask. Only edits to the segment settings are saved.
• Tap outside the menu to exit.

6. To change the vertical tolerance of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Waveform Tolerance under the Mask Defined By options.
c. Tap the Vertical Tolerance field and enter the tolerance value as units of the current channel settings. Or double-tap on the field

and use the A knob to change the value.
d. Tap the Update Mask Now button to immediately change the vertical tolerance of the segment.

7. To change the horizontal tolerance of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Waveform Tolerance under the Mask Defined By options.
c. Tap the Horizontal Tolerance field and enter the tolerance value as units of the current channel settings. Or double-tap on the field

and use the B knob to change the value.
d. Tap the Update Mask Now button to immediately change the horizontal tolerance of the segment.

8. To save the waveform tolerance edits:

a. Tap the Save panel.
b. Tap Save Mask. Only edits to the waveform tolerance settings are saved.
c. Tap outside the menu to exit.
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Zooming on waveforms

Zooming on waveforms
Use the zoom tools to magnify waveforms to view signal details.

Turn on Zoom mode
Zoom mode lets you look at a portion of your waveform in greater detail. Enable Zoom mode and touch and drag on-screen to select the
area to zoom.

About this task
To enable Zoom mode, do the following:

Procedure
1. Tap the Zoom icon in the corner of display.

2. Zoom overview:

a. To use Zoom once enabled, use pinch and/or drag options in the zoom view to change the zoomed area of interest.

Note: Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

Use the A and B multipurpose knobs to adjust the scale and position of the zoom from the front panel controls. Select
either the Horizontal Zoom Scale or the Zoom Position field to assign knob A and B for zoom adjustment. A and B icons
are displayed in the field when a knob is assigned.

b. To exit the zoom display mode, tap the Zoom icon in the corner of display or tap the X in the Zoom Title Bar.
3. For more information on zoom:

• Zoom user interface on page 52
• Zoom mode and Searches on page 94

Zoom mode and Searches
Use Zoom and Searches to find events of interest on a waveform.

About this task
Searches provide a way to mark a waveform event or events for reference. You can set marks automatically with search criteria such as
particular edges, pulse widths, runts, logic states, rise/fall times, setup and hold, and bus data types.

When in Zoom mode, you can tap the Search badge and use its navigation buttons to position the waveform to the previous or next search
marks.
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For information on creating a Search, see Add a search on page 74.
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Customizing measurements

Customizing measurements
After adding a measurement, you can customize the measurement for more precise results by using gating or setting reference levels.

To customize measurements, double-tap a Measurement badge in the Results bar to open the Measurement configuration
menu on page 114.

See the following topics for more information.

• Reference levels determine how time-related measurements are taken. See Set measurement reference levels on page 96.
• Gating confines the measurement to a certain portion of a waveform. See Set measurement gates on page 97.

Set measurement reference levels
Use this procedure to set measurement reference levels.

About this task
Reference levels are set in the Global Measurement Settings panel of the Measurements configuration menu. See Measurement
configuration menu on page 114.

Before you begin
Prerequisite: To set measurement reference levels you must be taking a measurement. See Add a measurement on page 70.

Procedure
1. Double-tap a Measurement badge.

The Measurement configuration menu is displayed.
2. Tap the Global Measurement Settings panel.
3. Tap Reference Levels and select either % or Units.

• % sets the High, Mid, and Low reference levels as percentages of the calculated High and Low signal levels. Tap the High Ref,
Mid Ref, or Low Ref fields and set the level using the assigned multipurpose knob. Or double-tap the field and use the virtual
keypad to enter a value.

• Units sets the High, Mid, and Low reference levels to specific signal levels. Tap the High Ref, Mid Ref, or Low Ref fields and set
the level using the assigned multipurpose knob. Or double-tap the field and use the virtual keypad to enter a value.

4. Tap High-Low Method and select the method.

• Auto automatically chooses the method.
• Hysteresis is best for pulses.
• Min-Max is best for all other waveforms.

5. Tap anywhere outside the Measurement configuration menu to close it.
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Set measurement gates
Use this procedure to specify which portion of your waveform is used to take measurements.

About this task
Gating is set in the Global Measurement Settings panel of the Measurements configuration menu. See Measurement configuration
menu on page 114.

Before you begin
To set measurement gates you must be taking a measurement. See Add a measurement on page 70.

Procedure
1. Double-tap a measurement badge to open the Measurement configuration menu.
2. Tap the Global Measurement Settings panel.
3. Tap Gating and either Off, Screen, or Cursors gating:

• Off takes measurement across the entire waveform record.
• Screen takes measurements on that portion of the waveform shown in the display. When Zoom is on, the display is the zoom

window.
• Cursors takes measurements on that portion of the waveform between the cursors. Selecting Cursors opens cursors on the

measurement source. Set the cursors so that the waveform area of interest is between the cursors.
4. Tap anywhere outside the Measurement configuration menu to close it.
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Saving and recalling information
Use these procedures to save or recall waveforms, setups, or traces.

The oscilloscope provides permanent storage for setups and waveforms. Use the internal storage of the oscilloscope to save setup files
and reference waveform data.

Use external storage, such as USB drives or network drives, to save setups, waveforms, and screen images. Use the external storage to
carry data to remote computers for further analysis and for archiving. USB drives must be FAT32 file systems.

External file structure. If you are saving information to external storage, select the appropriate file.

Drive name Drive letter Drive or physical USB port location
Root drive Instrument Storage User-accessible memory on the oscilloscope

Front panel E USB 2.0 (top)

F USB 2.0 (bottom)
Rear panel G USB 2.0

H USB 2.0 device port provides USBTMC support
Network location I through Z Network storage locations

Browse to select the file location. Tap the + buttons to navigate to and select a location at which to save the file.

Naming your file.

The oscilloscope gives all files it creates a default name in the following format:

tekXXXXX.set for setup files where XXXXX is an integer from 00000 to 99999

tekXXXXX.png, tekXXXXX.bmp, or tekXXXXX.tif for image files

tekXXXXYYY.csv for spreadsheet files or tekXXXXYYY.isf for internal format files

For waveforms, the XXXX is an integer from 0000 to 9999. The YYY is the channel of the waveform, and can be one of the following:

CH1, CH2, CH3, or CH4 for the analog channels

D00, D01, D02, D03, and so on through D15 for the digital channels

MTH for a math waveform

RF1, RF2, RF3, or RF4 for reference memory waveforms

For RF traces, XXXX is an integer from 0000 to 9999. The YYY defines the trace and can be one of the following:

NRM for a normal trace

AVG for an average trace

MAX for a maximum hold trace

MIN for a minimum hold trace

TIQ for a baseband I & Q file

Note: Analog, digital, and RF waveforms and traces and those waveforms and traces derived from them (such as math and
references) can be saved to an ISF file.

The XXXX value will automatically increment each time you save a file of the same type. For example, the first time you save a file, that file
is named tek00000. The next time you save the same type of file, the file will be named tek00001.
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Note: You can override the automatically generated filename with a custom name.

Save a screen image
Use this procedure to save a screen image.

Procedure
1. Tap the File menu and select Save As.

The Save As configuration menu opens.
2. Tap Screen Capture to open the Screen Capture tab.
3. Browse to select the location to save the file.

a) Tap the + buttons to navigate to and select a location at which to save the file.
4. File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and

enter a new file name using the virtual keyboard.
5. Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save

sequential files without needing to manually rename them each time. The count number is added to the end of the file name.

• If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name that
already use incremented file names. If there are files at the save location that already use the specified file name, and have already
been saved using count increments, the Count field shows the next count value that will be added to the file name when the file is
saved.

• To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field and
use the virtual keypad to change the value.

6. Tap Format and select the desired graphic image file type from the list.
7. Tap Ink Saver to turn the Ink Saver mode on or off. When on, this mode provides a white background.
8. Tap OK Save Screen Capture to save the screen image to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel Save button to
immediately save the same type file again, without opening any menus.

Save a waveform to a file
Use this procedure to save channel waveform (analog or digital) data to a comma-separated values (csv) or Tektronix waveform data (isf)
file, for later analysis or inclusion in reports.

Procedure
1. Tap the File menu and select Save As.

The Save As configuration menu opens.
2. Tap Waveform to open the Waveform tab.

Note: The instrument can save digital waveforms to .csv files, not reference memories. The oscilloscope cannot recall digital
waveforms.

Note: The instrument can save, but not recall, RF acquisitions as .TIQ files. You can use .TIQ files with Tektronix SignalVu
Vector Signal Analysis software.

3. Browse to select the location to save the file.
a) Tap the + buttons to navigate to and select a location at which to save the file.
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4. File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and
enter a new file name using the virtual keyboard.

5. Tap Format and select the desired waveform format.

When saving RF trace data, you can select to save it as either the standard display data or as baseband I and Q data (.TIQ files). Use
the I and Q data with Tektronix SignalVu Vector Signal Analysis software.

6. Tap Source and select the source of the waveform to save from the list. You can save a single waveform or all waveforms
7. Tap Gating and select the desired gating from the list.
8. Tap OK Save Waveform to save the waveform to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel Save button to
immediately save the same type file again, without opening any menus.

Save instrument settings to a file
Use this procedure to save instrument settings to a Tektronix setup (.set) file.

Procedure
1. Tap the File menu and select Save As.

The Save As configuration menu opens.
2. Tap Setup to open the Setup tab.
3. Browse to the location to save the file.

a) Tap the + buttons to navigate to and select a location at which to save the file.
4. File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and

enter a new file name using the virtual keyboard.
5. Tap Save to save the setup information to the specified file name and location.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel Save button to
immediately save the same type file again, without opening any menus.

Save all
Use this procedure to save all file types including: screen capture, waveforms, and setup files.

About this task
The save all function saves each file type according to the latest save settings in the Screen Capture, Waveform, and Setup tabs. All files
saved use the user-specified filename followed by extensions that distinguish the file types. The types of files saved is determined by the
configuration of your instrument.

An instrument configured for time domain acquisitions saves a screen capture, all waveforms, and a setup file. An instrument configured
for frequency domain acquisitions saves a screen capture, all waveforms, a setup file, and a CSV file. The CSV file contains the frequency
and amplitude of each peak identified by automatic peak markers.

Procedure
1. Tap the File menu and select Save As.

The Save As configuration menu opens.
2. Confirm that the Screen Capture, Waveform, and Setup settings are setup for the desired output.
3. Tap All to open the save all tab.
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Note: An external drive (USB) must be connected to save all file types.

4. Browse to select the location to save the files.
a) Tap the + buttons to navigate to and select a location at which to save the file.

Note: The file names cannot be changed when saving all file types. All files saved use an auto-assigned file name
followed by extensions that distinguish the file types.

5. Tap Save to save all file types to the specified file names and location.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel Save button to
immediately save the same type file again, without opening any menus.

Recall a Reference waveform
Use this procedure to recall (load) and display a saved waveform as a Reference waveform. There are 4 (or 2) reference waveforms that
you can load and display.

Display a reference waveform
Use this procedure to display a saved reference waveform.

1. Tap the Add Math Ref Bus button on the Settings bar and then tap Ref 1, Ref 2, Ref 3,, or Ref 4 to add a Ref badge to the Settings
bar and add a Ref waveform to the screen.

2. To change the display of the reference, double-tap the Ref badge to open the Ref configuration menu. See Reference waveform
configuration menu on page 209 for more information.

Recall a reference waveform
Use this procedure to recall (load) a saved waveform as a Reference waveform.

Procedure
1. Tap File and then select Recall.

This displays the Recall menu.
2. Tap the Recall Waveform tab.
3. Tap a Recall To button to specify the reference to load the waveform in.
4. Use the + and - buttons to navigate the file directory. Navigate to the folder that contains the file to recall.
5. Select the file to recall
6. Tap OK Recall Waveform.

The reference waveform is loaded and displayed, and a Ref badge is added to the Settings bar.

Recall a Setup file
Use this procedure to recall (load) and configure instrument settings from a Setup file.

Procedure
1. Select File > Recall from the Menu bar to open the Recall configuration menu.
2. Tap Setup to open the Setup tab.

The Recall configuration menu opens.
3. Navigate to the folder that contains the file to recall, using the following methods:
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• Tap a + button to open a folder and show its contents.
• Tap a - button to close a folder and stop showing its contents.

4. Select the file to recall.

Note: You can double-tap on a file name to immediately recall the file and close the menu.

5. Tap OK Recall Setup
The instrument loads the setup file and reconfigures the oscilloscope to the setup file settings.
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Menus and dialog boxes

Act On Event configuration menu
Use this configuration menu to set the actions the instrument takes when specified conditions are met (mask test failure, mask test
completion).

To open the Act On Event menu, select the Act On Event button in mask configuration menu.

Act On Event menu fields and controls
Displayed fields and controls can change depending on menu selections.

Field or control Description
Act on Event on/off switch Allows you to configure Act On Event before enabling. This turns off as soon as the event (Mask test

Failure or Mask test completion) occurs.
Save Screen Capture Saves the screen image at the time of the event.
Save Waveform Saves the waveform data at the time of the event.
Stop Acquisitions Stops the instrument from acquiring any more data.
SRQ This is a signal sent via the VISA connection to alert listeners that an event has occurred. Enabling

this will send such an event when the action has occurred and if the status registers are configured
correctly.

AUX OUT Pulse A falling edge occurs when there is a specified event in a test application.

The Acquisition configuration menu
Use this configuration menu to set parameters for acquiring waveform data points and to enable XY mode.

To open the Acquisition menu, double-tap the Acquisition badge on the Settings bar.

The Acquisition menu fields and controls
Displayed fields and controls can change depending on menu selections.
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Field or control Description
Run/Stop Toggles the oscilloscope between constant acquisition (Run) and no acquisitions (Stop). When

stopped, the oscilloscope shows waveforms from the last completed acquisition.

Single/Seq Acquires a single acquisition or a set number of acquisitions, then stops.

Clear Erases acquired waveform data points from memory. Applies to all live acquisition waveforms.

Acquisition Mode Sample creates a record point by saving one or more samples during each acquisition interval.
Sample mode is the default acquisition mode. The instrument does no post processing of the acquired
samples in this mode.

 

Peak Detect alternates between saving the highest sample in one acquisition interval and the lowest
sample in the next acquisition interval. Useful for capturing fast and random events such as narrow
waveform pulses.

 

High Res applies unique finite impulse response (FIR) filters based on the current sample rate. This
FIR filter maintains the maximum bandwidth possible for that sample rate while rejecting aliasing.
The filter removes noise from the oscilloscope amplifiers and ADC above the usable bandwidth for
the selected sample rate. Implementation of the filter in hardware, ahead of the trigger and storage,
reduces trigger jitter and enables using Fast Acq mode while in High Res mode.

 

The High Res sample rate and record length settings are displayed in the Horizontal badge. High Res
mode sets the maximum real time sample rate to ½ the maximum sample rate.

 

Envelope acquires and displays a waveform record that shows the extremes in variations over several
acquisitions. The instrument saves the highest and lowest values in two adjacent intervals (similar to
the Peak Detect mode). Unlike Peak Detect mode, the peaks are gathered over many trigger events.

 

Average acquires and displays a waveform record that is the average result of several acquisitions.
This mode reduces random noise.

 

FastAcq provides high-speed waveform capture. It is helpful in finding elusive signal anomalies. Fast
acquisition mode reduces the dead time between waveform acquisitions, enabling the capture and
display of transient events such as glitches and runt pulses. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

Single Seq/Stops After Enables stopping acquisitions after a specified number of acquisitions. Only works when using the
Single/Seq button.

Number of Waveforms Specifies the number of acquisitions for average and envelope modes.

XY Display Toggles XY display mode on and off.
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Add Measurements configuration menu overview
Use this configuration menu to select measurements you want to take on waveforms and add the measurements to the Results bar.

To open the Add Measurements configuration menu, tap the Measure button in the Analysis controls area.

The Add Measurements configuration menu always opens on the Amplitude Measurements panel. The listed panels and
measurements depend on the installed measurement options and the selected signal source.

To add a measurement, select the input source or sources, select the measurement, and tap the Add button. The measurement is added
to the Results bar.

To change individual measurement settings, double-tap the Measurement badge to open a configuration menu for that measurement. See
Measurement configuration menu on page 114.

Add Measurements menu fields and controls
 

Field or control Description
Measurement description

(graphic and text)

Shows a graphic and short description of the selected measurement. Use this information to verify that
the selected measurement is correct for what you want to measure.

Source Selects the measurement source. If the measurement requires more than one source (for example,
Skew, Phase, or many Power measurements), the menu shows two source fields from which to select.

Add button Adds the selected measurement as a measurement badge to the Results bar.

Standard measurement panels
 

Panel Description
Amplitude Measurements
panel

Lists the available amplitude measurements. See Amplitude Measurements panel on page 105.

When a digital source is selected, this panel is not available.

Time Measurements panel Lists the available time measurements. See Time Measurements panel on page 107.

Other Measurements Lists the available other measurements. See Other Measurements panel on page 108.

Power Measurements Advanced Power Analysis (optional). Provides measurements for power quality, harmonics, slew rate,
switching loss, safe operating area, ripple, and modulation analysis measurements. See The Power
Measurements panel (optional) on page 109.

Amplitude Measurements panel
The Amplitude Measurements panel lists available amplitude-related measurements that you can take on analog channel signals, math
waveforms (time-domain), and reference waveforms. Amplitude measurements are not available for digital signals.

To open the Amplitude Measurements panel:

1. Tap the Measure button.
2. Tap the Amplitude Measurements panel.

To add a measurement to the Results bar:
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1. Select the signal source.
2. Select a measurement.
3. Tap Add.

The Amplitude Measurements panel measurements
 

Measurement Description
Amplitude The difference between the Top value and the Base value. You can take this measurement on each

cycle in the waveform record or on the entire waveform record.
Peak-To-Peak The absolute difference between the Maximum and Minimum amplitudes in the measurement region.

You can take this measurement on each cycle in the waveform record or on the entire waveform
record.

Positive Overshoot 3 The difference between the Maximum value and the Top value, divided by the Amplitude, and
multiplied by 100 to express the measurement as a percentage of amplitude. You can take this
measurement on each cycle in the waveform record or on the entire waveform record.

Negative Overshoot 3 The difference between the Minimum and Base values, divided by the Amplitude, and multiplied by
100 to express the measurement as a percentage of amplitude. You can take this measurement on
each cycle in the waveform record or on the entire waveform record.

Mean The arithmetic mean of all data points over the measurement region. You can take this measurement
on each cycle in the waveform record or on the entire waveform record.

Cycle RMS The true Root Mean Square voltage over the first cycle in the waveform or the first cycle in the gated
region.

High This value is used as 100% whenever high reference, mid reference, or low reference values are
needed, such as in fall time or rise time measurements. Calculate using either the min/max or
histogram method. The min/max method uses the maximum value found. The histogram method uses
the most common value found above the midpoint. This value is measured over the entire waveform or
gated region.

Low This value is used as 0% whenever high reference, mid reference, or low reference values are needed,
such as in fall time or rise time measurements. Calculate using either the min/max or histogram
method. The min/max method uses the minimum value found. The histogram method uses the most
common value found below the midpoint. This value is measured over the entire waveform or gated
region.

Maximum The maximum data point value. You can take this measurement on each cycle in the waveform record
or across the entire waveform record.

Minimum The minimum data point value. You can take this measurement on each cycle in the waveform record
or on the entire waveform record.

Total Overshoot The summation of the positive overshoot and the negative overshoot.

Cycle Mean The arithmetic mean over the first cycle in the waveform or the first cycle in the gated region.

Table continued…
3 Changing your High-Low Method in the Global Measurement Settings panel of the Measurement configuration menu may change how this value is calculated.

Menus and dialog boxes

106

www.tehencom.com          



Measurement Description
RMS The true Root Mean Square voltage over the entire waveform or gated region.

See also
Measurement configuration menu on page 114

Time Measurements panel
Use the Time Measurements panel to add timing-related measurements to the Results bar. Timing measurements can be taken on
time-domain analog, math, and reference waveforms. Timing measurements can also be taken on some digital channel signals.

To open the Time Measurements panel:

1. Tap the Measure button.
2. Tap the Time Measurements panel.

To add a measurement to the Results bar:

1. Select the signal source.
2. Select a measurement. If a measurement requires two signal sources, select both sources.
3. Tap Add.

Time Measurements panel
 

Measurement Description

Period 4 The time between two adjacent crossings of the Mid reference level (one cycle) of the waveform.

The measurement is taken on each cycle of the waveform record or measurement region.

Frequency 4 The frequency of the waveform. Frequency is the reciprocal of Period (Frequency = 1/Period).

Delay The time difference between the mid reference (default 50%) amplitude point of two different
waveforms. You can specify the signal edges to measure in the measurement’s Configuration menu.

The measurement requires two sources.

Phase 4 The time difference (phase shift) between the specified signal edges of waveform source 1 and
waveform source 2. The measurement is expressed in degrees, where 360° comprise one waveform
cycle. This measurement requires two sources.

The measurement is taken on each cycle of the waveform record.

Positive Pulse Width 4 The distance (time) between the mid reference (default 50%) amplitude points of a positive pulse.

The measurement is made on the first pulse in the measurement region.

Table continued…

4 This measurement can also be taken on digital signals.
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Measurement Description

Negative Pulse Width 4 The distance (time) between the mid reference (default 50%) amplitude points of a negative pulse.

The measurement is taken on each cycle in the waveform record or measurement region.

Positive Duty Cycle 4 The ratio of the positive pulse width to the signal period, expressed as a percentage.

The duty cycle is measured on the first cycle in the measurement region.

Negative Duty Cycle 4 The ratio of the negative pulse width to the signal period, expressed as a percentage.

The duty cycle is measured on the first cycle in the measurement region.

Rise Time The time required for the leading edge of the first pulse in the measurement region to rise from the low
reference value (default = 10%) to the high reference value (default = 90%).

The measurement is taken on each cycle of the waveform record.

Fall Time The time required for the trailing edge of the first pulse in the measurement region to fall from the high
reference value (default = 90%) to the low reference value (default = 10%).

The measurement is taken on each cycle of the waveform record.

Burst Width The duration of a series of adjacent crossings of the Mid reference level. Bursts are separated by a
specified idle time.

The measurement is taken on each burst in a waveform record.

See also
Measurement configuration menu on page 114

 

Other Measurements panel
Use the Other Measurements panel to add pulse count, edge count, and area measurements to the Results bar. Other measurements can
be taken on time-domain analog, math, and reference waveforms. Other measurements can also be taken on some digital channel signals.

To open the Other Measurements panel:

1. Tap the Measure button.
2. Tap the Other measurements panel.

To add a measurement to the Results bar:

1. Select the signal source.
2. Select a measurement. If a measurement requires two signal sources, select both sources.
3. Tap Add.

Other Measurements panel
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Measurement Description
Positive Pulse Count The number of positive pulses that rise above the mid reference crossing in the waveform or gated

region.

Negative Pulse Count The number of negative pulses that fall below the mid reference crossing in the waveform or gated
region.

Rising Edge Count The number of positive transitions from the low reference value to the high reference value in the
waveform or gated region.

Falling Edge Count The number of negative transitions from the high reference value to the low reference value in the
waveform or gated region.

Area Area measurement is a voltage over time measurement. It returns the area over the entire waveform or
gated region in volt-seconds. Area measured above ground is positive; area measured below ground is
negative.

Cycle Area A voltage over time measurement. The measurement is the area over the first cycle in the waveform
or the first cycle in the gated region expressed in volt-seconds. The area above the common reference
point is positive, and the area below the common reference point is negative.

See also
Measurement configuration menu on page 114

 

The Power Measurements panel (optional)
The Power panel lists the power-related measurements that you can add to the Results bar. Power measurements include power quality,
switching loss, harmonics, ripple, modulation, and safe operating area. The Power Measurements panel is shown only if you have
purchased and installed the Power Measurement and Analysis option.

To open the Power Measurements panel:

1. Tap the Measure button.
2. Tap the Power measurements panel.

To add a measurement to the Results bar:

1. Tap a measurement.
2. Tap Add.

Power Measurements panel (optional)
 

Measurement Description
Power Quality Measures the Frequency, RMS values of the voltage and current, Crest Factors of the

voltage and current, Real Power, Reactive Power, Apparent Power, Power Factor, and
Phase Angle of the AC signal.

Table continued…
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Measurement Description
Switching Loss Measures power loss and energy loss across the acquired waveform, including turn-on,

turn-off, conduction, and total loss.

Harmonics Measures the signal amplitudes at the fundamental line frequency and its harmonics.
Measures the RMS amplitude and Total Harmonic Distortion of the signal. Plots the
Harmonics Bar Graph.

Ripple Measures ripple and statistics for the AC components of the acquired waveform.
Modulation Measures the modulation value across the acquired waveform.
Safe Operating Area Measures the switching device-under-test's voltage and current. Also, performs a mask test

of the X-Y signal relative to the graphical X-Y description of the device specification limits.

Power Quality Measurements panel (optional)
 

Measurement Description
Voltage Source Select which channel the voltage waveform is on.

Frequently, for these measurements, you will select a channel pair, where channel 1 is
used as a voltage source and channel 2 as a current source.

The Voltage and Current sources can be any analog waveforms, whether live channels or
references.

Current Source Select which channel the current waveform is on.

Frequently, for these measurements, you will select a channel pair, where channel 1 is
used as a voltage source and channel 2 as a current source.

The Voltage and Current sources can be any analog waveforms, whether live channels or
references.

Frequency Reference Select the source for the zero crossings for all Power Quality measurements and for
frequency.

Global Measurement Settings Set reference levels, gating, samples, and Hysteresis level. See Global Measurement
Settings panel (Measurement configuration menu) on page 116

Switching Loss Measurements panel (optional)
 

Measurement Description
Voltage Source Select which channel the voltage waveform is on.

Current Source Select which channel the current waveform is on.

Gate Voltage (Vg) Select which channel thet gate voltage is on.
Vg Polarity Select the gate polarity.
Table continued…
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Measurement Description
Vg Ton Level Set the gate Ton level. This control is only present when Gate Voltage (Vg) is set to

something other than None.
Conduction Calculation Set the conduction calculation method. Voltage Waveform measures the voltage drop

across the switching device during conduction. Because this voltage is typically very small
compared with the voltage across the switching device when it is not conducting, you
generally cannot measure both voltages accurately at the same vertical setting of the
oscilloscope. In that case, consider using RDS(on) or Vce(sat) for more accurate results.

RDS(on) RDS(on) is the best model for MOSFETs and is based on information from the device data
sheet. This value is the expected on-resistance between the drain and the source of the
device when it is conducting. This control is only present when Conduction Calculation is
set to MOSFET.

Vce(sat) VCE(sat) is the best model for BJTs and IGBTs and is based on information from the
device data sheet. It is the expected saturation voltage from the collector to the emitter of
the device when it is saturated. This control is only present when Conduction Calculation is
set to BJT/IGBT.

Badge Results Select which of the available switching loss measurements to display. The choices are
Power loss or Energy loss.

Ton-Start & Toff-Stop Current Level Set the Ton-Start & Toff-Stop Current Level. This control is only present when Gate Voltage
(Vg) is set to None.

Ton-Stop & Toff-Start Voltage Level Set the Ton-Stop & Toff-Start Voltage Level.
Toff-Stop Current Level Set the Toff-Stop Current Level. This control is only present when Gate Voltage (Vg) is set

to something other than None.
Global Measurement Settings Set reference levels, gating, and Hysteresis level. See Global Measurement Settings panel

(Measurement configuration menu) on page 116

Harmonics Measurements panel (optional)
 

Measurement Description
Voltage Source Select which channel the voltage waveform is on.

Current Source Select which channel the current waveform is on.

Harmonics Specify the number of harmonics to calculate. whether to calculate harmonics on the
voltage or the current waveform, and how to determine the frequency of the primary
waveform.

Standard Select between general harmonics analysis or testing to a specific standard, such as IEC
61000-3-2 Class A or MIL-STD-1399 Section 300A.

Harmonics Source Specify whether to calculate harmonics on the voltage or the current waveform.

Table continued…
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Measurement Description
Frequency Reference Select how to determine the frequency of the primary waveform. Choices are None, IEC

61000-3-2, V, I, Fixed.

Fixed Reference Specify the fixed reference frequency of the primary waveform. This control is only
available when Frequency Reference is set to Fixed.

Display Selects the harmonics to display.

Line Frequency Select teh line frequency of the DUT .

Class Select the class from the drop-down list. Available values are A, B, C (Table 1), C (Table 2),
C (Table 3), and D.

Observation Period (OP) Enter the observation period.
Set Scale & RL for OP Sets the scale and record length for the observation period.
Power Factor Enter the power factor. This control is only present when Class is set to Class C, Tables 1,

2, or 3.
Current Enter the current. This control is only present when Class is set to Class C, Tables 1, 2, or

3.
Input Power Enter the input power, This control is only present when Class is set to Class C, Table 3 or

Class D.
Filter (1.5 s) Toggles the filter on and off.
Grouping Toggles the grouping on and off.
Set to IEC Defaults Sets to IEC defaults.
Horizontal Sets the horizontal scale for greater than 10 cycles.

Power Level Select a High or Low power level.
Current Select either measured or rated current.
Rated Current When rated current is selected, enter the current value.
Global Measurement Settings Set the Hysteresis level. See Global Measurement Settings panel (Measurement

configuration menu) on page 116

Ripple Measurements panel (optional)
 

Measurement Description
Voltage Source Select which channel the voltage waveform is on.

Current Source Select which channel the current waveform is on.

Ripple Source Select which channel to measure the ripple on.

Table continued…
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Measurement Description
Do Vertical Autoset Removes the DC component from the signal by adding vertical offset and then auto-scaling

the AC component for optimal measurement accuracy.

Typically, a ripple measurement involves looking at a very small voltage riding on a large
voltage. You want to use the internal resolution of the oscilloscope as effectively as
possible to measure that small voltage. With Do Vertical Autoset, you can devote much
more of the oscilloscope's ADC range to measurement of the desired ripple.

Set Offset to 0 V Removes all vertical offset.

Modulation Measurements panel (optional)
 

Measurement Description
Voltage Source Select which channel the voltage waveform is on.

Current Source Select which channel the current waveform is on.

Modulation Source Select which channel to measure the modulation on.

Modulation Type Select what to measure. Choices include: positive pulse width, negative pulse width,
period, frequency, positive duty cycle, and negative duty cycle.

Global Measurement Settings Set the reference levels. See Global Measurement Settings panel (Measurement
configuration menu) on page 116

Safe Operating Area Measurements panel (optional)
 

Measurement Description
SOA Pair Select which channels to measure. For this measurement, there are four valid voltage/

current input pairs. These are Ch1/Ch2, Ch3/Ch4, Reference 1/Reference 2, and
Reference 3/Reference 4.

Axes Select either a log or linear graticule. Use the max and min menu items and multipurpose
knob a to set the size of the graticule.

The x axis typically displays voltage and the y axis displays current.

Y Axis Max Set the Y axis maximum value.

Y Axis Min Set the Y axis minimum value.

X Axis Max Set the X axis maximum value.

X Axis Min Set the X axis minimum value.

Stop On Violation Select whether or not to stop acquisitions on the detection of an error.

Table continued…
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Measurement Description
Mask Settings panel Define a mask for the measurement. See SOA Mask definition controls and

fields on page 118

Mask Settings panel (optional)
 

Measurement Description
Define Mask Selects setting limits or setting points to define a mask.

Maximum Voltage Set the maximum voltage using a multipurpose knob or double-tap and set the value using
the displayed keypad.

Maximum Current Set the maximum current using a multipurpose knob or double-tap and set the value using
the displayed keypad.

Maximum Power Set the maximum power using a multipurpose knob or double-tap and set the value using
the displayed keypad.

Define Mask Lists the points that define a mask. Set the X and Y values using the multipurpose knobs.

Insert Point Inserts a new mask point.

Delete Point Deletes the selected mask point.

Clear Table Deletes all mask points.

See also
Power measurement configuration menu overview (optional) on page 117

Global Measurement Settings panel (Measurement configuration menu) on page 116

SOA Mask definition controls and fields on page 118

Measurement configuration menu
Use this configuration menu to add statistics to a measurement badge readout and change measurement settings including source,
reference levels, high-low method, gating, and number of samples.

To open a Measurement configuration menu for a measurement, double-tap a Measurement badge in the Results bar. The configuration
menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel (the name of the measurement), which provides controls to display additional
statistics to the measurement badge, reference levels, gating, and so on. The content of the measurement name panel depends on the
measurement. The most common Measurement Name fields are listed in the following table.

Measurement configuration menu fields, controls, and panels
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Field, control, or panel Description
Measurement Statistics

(Measurement name panel)

A list of measurement statistics related to the measurement. You can add these statistics to a
measurement badge by selecting the Show Statistics in Badge control.

Show Statistics in Badge

(Measurement name panel)

Adds the listed statistical measurement readouts to the measurement badge readout.

Source

(Measurement name panel)

Sets the source and slope for the measurement. The number of controls is specific to each
measurement type.

Info:

(Measurement name panel)

Displays measurement warnings for the measurement.

Global Measurement Settings
panel

Sets the reference levels and units used to take measurements, the gating method, the method used
to calculate the Top and Base waveform values, and the number of samples. See Global Measurement
Settings panel (Measurement configuration menu) on page 116 for more information.

 

Measurement Name panel (Measurement configuration menu)
The Measurement Name panel (the name of the measurement) provides controls for adding measurement statistics to the measurement
badge and opening plots of the measurement.

To open the measurement name panel, double-tap a Measurement badge. This is the default panel shown when you open a Measurement
settings menu.

The content of the Measurement Name panel depends on the measurement.

Field or control Description
Measurement Statistics A list of measurement statistics. You can add these statistics to a measurement badge by selecting the

Show Statistics in Badge control.
Info:

(Measurement name panel)

Displays measurement warnings for the measurement.

Show Statistics in Badge Select to add the listed statistical measurement readouts to the measurement badge.
Source 1 (From)

(Measurement name panel)

Sets Source 1 for the measurement. Tap and select the source from the list.

This control is only available when the measurement type is Delay or Phase.

Source 1 Edge

(Measurement name panel)

Sets the edge direction of the source. Tap to select the positive or negative edge of the source.

This control is only available when the measurement type is Delay.

Source 2 (To)

(Measurement name panel)

Sets Source 2 for the measurement. Tap and select the source from the list.

This control is only available when the measurement type is Delay or Phase.

Source 2 Edge

(Measurement name panel)

Sets the edge direction of the source. Tap to select the positive or negative edge of the source.

This control is only available when the measurement type is Delay.

Source 2 Edge Occurrence Specifies whether the Source 2 Edge occurs before or after the Source 1 Edge.
Table continued…
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Field or control Description
Global Measurement Settings
panel

Sets the reference levels and units used to take measurements, the gating method, the method used
to calculate the Top and Base waveform values, and the number of samples.

 

See Global Measurement Settings panel (Measurement configuration menu) on page 116.

See also
 

Global Measurement Settings panel (Measurement configuration menu) on page 116

 

Global Measurement Settings panel (Measurement configuration menu)
Use the Global Measurement Settings panel to set the reference levels (High, Mid, and Low), the units used to take measurements, gating,
and the method used to calculate the High and Low waveform values.

To open the Global Measurement Settings panel:

1. Tap the Measure button.
2. Tap the Global Measurement Settings panel.

Global Measurement Settings panel- fields and controls
Not all items listed in the table are shown for all measurements; The panel only shows fields and controls relevant to the selected
measurement.

Field or control Description
Reference Levels Sets the method used to set or calculate the High, Mid, and Low reference levels. Select % or Units

and use the Multipurpose Knob to set custom reference values.
High-Low Method Sets the method to calculate the waveform High and Low values, which is then used to calculate the

High, Mid, and Low reference levels.

 

Auto is the default method, and automatically determines the best High-Low method to use. Most
commonly sets the method to Histogram Mode.

 

Min-Max Uses the minimum and maximum values in the waveform record to determine the high and
low amplitude. Useful on a waveform with low noise and free from excessive overshoot.

 

Histogram Mode uses histogram analysis to calculate the most common values above and below the
waveform midpoint. High is set to the common high value, and Low is set to the common low value.

Note: All measurements that you add to the Results bar will use the new High-Low Method
values for taking measurements.

Table continued…
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Field or control Description
High Ref, Mid Ref 1, Mid Ref 2,
Low Ref, Vg Mid Ref

Sets the reference levels as specified percentages of the High and Low waveform measurement or as
absolute values.

To set custom reference values, tap a setting field, and use the Multipurpose Knob to set the different
% (relative) or absolute values.

 

High Ref and Low Ref references are used to calculate rise and fall times. The default High reference
is 90% and Low reference is 10%.

Mid Ref 1 and Mid Ref 2 references are primarily used for measurements between edges such as
pulse widths. The default level is 50%.

Vg Mid Ref sets the mid reference when the Gate Voltage is set to something other than None.
This control is only available with the 3MDOPWR power measurement option Switching Loss
measurement.

Gating Sets the gate type used to take measurements.

 

Off: Measurements are taken across the entire record.

 

Screen: Measurements are taken on the portion of the waveform shown on the display. When zoom is
on, the ‘display’ on which to measure is the zoom window.

 

Cursors: Measurements are taken on the portion of the waveform between the cursors. When
Cursors is selected, use the multipurpose knobs to select the portion of the waveform to measure.

Hysteresis Set the hysteresis amount. This setting applies hysteresis to the frequency reference level. Harmonics,
Switching Loss, and Power Quality all use the frequency of the signal as part of their calculation.
Hysteresis defines a region around the reference level relative to the amplitude of the signal. This
prevents noisy signals from creating multiple crossings that ruin the frequency calculation.

Increase the hysteresis to prevent the noise from affecting the frequency measurement.

Mean & Std Dev Samples Sets the number of samples used in a mean and standard deviation measurement.

Power measurement configuration menu overview (optional)
Use this configuration menu to add statistics to a Power measurement badge readout and change measurement settings including source,
reference levels, and gating.

To open the Power measurement configuration menu for a measurement, double-tap a Power measurement badge in the Results bar. The
configuration menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel (the name of the measurement), which provides controls to display additional statistics
to the measurement badge. The measurement name panel only shows fields and controls relevant to the selected measurement. The most
common Power measurement Name fields are listed in the following table.
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Power Measurement configuration menu fields, controls, and panels
Field, control, or panel Description
Measurement Statistics

(Measurement name panel)

A list of measurement statistics related to the measurement. You can add these to a measurement
badge by selecting the Show Statistics in Badge control.

Show Statistics in Badge

(Measurement name panel)

Adds the listed statistical measurement readouts to the measurement badge readout.

Voltage Source Select the source from the drop-down list.
Current Source Select the source from the drop-down list.
Mask Settings Panel Define a mask for the safe operating area (SOA) measurement.
Global Measurement settings
panel

Sets the reference levels, gating, mean and standard deviation samples, and hysteresis used to take
measurements.

Power Measurement Name panel (Measurement configuration menu)
The Power Measurement Name panel (the name of the measurement) provides controls for adding display statistics to the measurement
badge.

To open the power measurement name panel, double-tap a Power Measurement badge. This is the default panel shown when you open a
Power Measurement settings menu.

The contents of the Measurement Name panel depends on the measurement.

Field or control Description
Measurement Statistics Shows a list of measurement statistics. You can add these statistics to a measurement badge by

selecting the Show Statistics in Badge control.

Show Statistics in Badge Adds the listed statistical measurement readouts to the measurement badge.

See also
 

Measurement Name panel (Measurement configuration menu) on page 115

Global Measurement Settings panel (Measurement configuration menu) on page 116

 

SOA Mask definition controls and fields
Use the SOA Mask dialog to configure the parameters to add point, delete point, save mask, and recall mask.

Use the parameters to define the linear mask for an SOA measurement.

Define Mask fields and controls
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Field or control Description
Define Mask Select between defining a mask by setting limits or defining points. Use Set Points to define

a more complex mask with up to 10 points, each of which you can define.

Maximum Voltage Define the safe operating area by creating a four-point mask by setting the maximum
voltage, current, and power.Maximum Current

Maximum Power
Define Mask Define the voltage (X) and amperage (Y) for each mask point.
X (Volts) Define voltage values for the mask point.

Y (Amps) Define current values for the mask point.

Insert Point Add voltage and current points to define mask. Points are added to the end of the existing
list.

Delete Point Deletes the selected point data row.

Clear Table Clears the values of the mask coordinates in the table.

Reference Levels panel (Power measurement configuration Menu)
Use the Global Measurement Settings panel to set the reference levels, the units used to take measurements, gating, and the method
used to calculate the High and Low waveform values.

See Global Measurement Settings panel (Measurement configuration menu) on page 116 for the Reference panel fields and controls.

Other measurement settings panels
Power Measurement Name panel (Measurement configuration menu) on page 118

 

Bus configuration menu
Use the Bus menu to select the bus type to display, configure the input sources, and set how to display the bus on the screen.

To open the Bus configuration menu:

• For an existing bus, double-tap the Bus badge in the Settings bar.
• To add a new Bus badge on the Settings bar, tap the Math Ref Bus button and select Bus1 or Bus2. This adds the Bus badge to the

Settings bar. Double-tap the Bus badge. This opens the Bus configuration menu.

Bus configuration menu - fields and controls
Field or control Description
Display Toggles bus display on or off.
Label Allows entry of label text in this field. The default label is the bus type.
Table continued…
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Field or control Description
Bus Type Select a bus from the drop down list. The Parallel bus type comes standard on the instrument. Serial

buses require purchase and installation of serial bus triggering and analysis options.

See Serial bus decode and trigger options on page 26.

Source configuration Specifies the bus signal input parameters. Shown fields depend on the selected bus type. See the
individual bus configuration help topics for information on their settings.

Display format Enables showing just the decoded bus or both the bus and its digital subwaveforms. You can also tap
on the + symbol on the bus waveform to toggle between showing the bus only or showing bus and
source waveforms. Digital waveforms represent the logical waveforms for each signal after they have
been digitized. If the decode is not working as expected, you can look at the individual waveforms to
see if things like suboptimal threshold settings are causing incorrect decoding.

Decode format Sets how decoded data information is shown in the bus. Select from listed formats. Available formats
depend on the bus type.

Note: These controls are common to all bus types. Controls unique to specific bus types are discussed in separate topics for each
bus.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

ARINC429 serial bus menu
Use the ARINC429 bus menu (optional) to set up and decode an ARINC429 avionics network serial bus.

• To set up a ARINC429 serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to ARINC429.
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• Double-tap the Bus waveform badge to change the settings on an existing ARINC429 serial bus waveform.

ARINC429 serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text using an attached keyboard.

Bus Type Set to ARINC429.
Polarity Select the polarity to match the ARINC429 bus being acquired.
Source Select the ARINC429 signal source.
High Threshold, Low
Threshold

Sets the valid high and low threshold values for the signal source.

Bit Rate Sets the bit rate to 12,500, 100,000, or Custom.
Custom Rate Sets a custom data bit rate. To set the value, tap the field and use the Multipurpose knob, double-tap

the field and use the Custom Rate virtual keypad, or double-tap the field and use an attached
keyboard.

This field is only visible when Bit Rate is Custom.

Data Format Sets the data format to Data (19 bits), SDI (Source/Destination Identifiers) plus Data (21 bits), or SDI
plus Data plus Sign/Status Matrix (SSM) (23 bits).

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and Mixed Hex.
Mixed Hex displays labels as octal, and other fields are formatted as hexadecimal.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135
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USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

Audio serial bus configuration menu
Use the Audio bus menu (optional) to set up and display I2S, Left Justified (LJ), Right Justified (RJ), or TDM Audio serial bus waveforms.

• To set up a Audio serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to Audio.

• Double-tap the Bus waveform badge to change the settings on an existing Audio serial bus waveform.

Audio serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to Audio.
Audio Type Sets the digital audio signal type. Select from the drop-down list.
Bit Order Set the waveform to decode with most-significant (MS First) bit first or least-significant (LS First) bit

first.
Bit Clock Set the signal source, logic level threshold, and polarity (rising or falling edge) for the Bit Clock signal.
Word Select Set the signal source, logic level threshold, and polarity (normal or inverted) signal setting for the Word

signal.
Data Set the signal source, logic level threshold, and polarity (active high or low) for the Data signal.
Word Size Set the number of bits used in a Word for the selected audio type (4-32 bits).

This field is only available when Audio Type is I2S, LJ, or RJ.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal..

Decode Format Sets the decode format used to display the bus information. Choices are Hex, Binary, and Signed
Decimal.

TDM-specific settings
Frame Sync Set the signal source, logic level threshold, and polarity (rising or falling edge) for the frame sync

signal.
Data Bits per Channel Set the number of data bits per audio channel.
Clock Bits per Channel Set the number of clock bits per audio channel.
Channels per Frame Set the number of audio channels per data frame.
Table continued…
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Field or control Description
Bit Delay Sets the bit delay (number of bits to delay the trigger).

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

CAN serial bus configuration menu
Use the CAN bus menu (optional) to set up and display a CAN (Controller Area Network) or CAN FD serial bus waveform.

• To set up a CAN serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to CAN.

• Double-tap the Bus waveform badge to change the settings on an existing CAN serial bus waveform.

CAN serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Table continued…
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Field or control Description
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to CAN to set up and display a CAN bus waveform.
Signal Type Sets the CAN signal type to decode.
Standard Sets the CAN signal standard to decode.
FD Standard Sets the CAN signal standard to decode.

Available when Standard is CAN FD.

Source Select the signal source from the listed analog and digital channels.
Threshold Sets the high/low logic transition level.
Sample Point Sets the sample point from 5% to 95% of the position within the bit period or the unit interval.
Bit Rate Select the bit rate of your CAN bus serial data.

To enter a custom bit rate, select Custom and enter the custom bit rate in the Custom Rate input box.

Only available when CAN Standard is CAN 2.0.

SD Bit Rate Select the SD bit rate of your CAN FD serial bus data.

To enter a custom bit rate, select Custom and enter the custom bit rate in the Custom Rate input box.

This field is only available when CAN Standard is CAN FD.

FD Bit Rate Select the FD bit rate of your CAN FD serial bus data.

To enter a custom bit rate, select Custom and enter the custom bit rate in the Custom Rate input box.

This field is only available when CAN Standard is CAN FD.

Custom Rate Sets the custom bit rate to use to decode the signal. Tap the field and use the Multipurpose knob to
change the value, or double-tap on the field and use the virtual keypad to enter a custom bit rate.

This field is only available when Bit Rate, SD Bit Rate, or FD Bit Rate is Custom.

Display Format Bus sets the waveform view to show just the decoded bus information.

Bus and Waveform sets the waveform view to show both the decoded bus and the logical views of
each constituent signal.

You can also tap on the + symbol on the bus waveform to toggle between showing the bus only or
showing bus and source waveforms.

Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and Mixed Hex.
Mixed Hex displays some fields as binary, and other fields as hexadecimal.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122
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CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

FlexRay serial bus configuration menu
Use the Flexray bus menu (optional) to set up and display a Flexray automotive network serial bus waveform.

• To set up a FlexRay serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to FlexRay.

• Double-tap the Bus waveform badge to change the settings on an existing FlexRay serial bus waveform.

FlexRay serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text using an attached keyboard.

Bus Type Set to FlexRay.
Signal Type Select the FlexRay signal type being measured.
Channel Type Set to A or B channel.
Source Select the FlexRay signal source.
Threshold Sets the threshold value for the TX or RX signal type.
High Threshold, Low
Threshold

Sets the high and low threshold values for the BM Inverted and Bdiff/BP signal types.

Bit Rate Select a bit rate. To set a custom bit rate, select Custom and enter a value in the Custom Rate field.
Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical

views of each constituent signal.
Table continued…

Menus and dialog boxes

3 Series Mixed Domain Oscilloscope Help 125

www.tehencom.com          



Field or control Description
Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and Mixed.

Mixed format displays Payload/Data and Trailer/CRC bytes as hexadecimal values. Other fields are
displayed in ASCII, decimal, or hexadecimal format.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

I2C serial bus configuration menu
Use the I2C bus menu (optional) to set up and display an I2C (Inter-Integrated Circuit) serial bus waveform.

• To set up a I2C serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to I2C.

• Double-tap the Bus waveform badge to change the settings on an existing I2C serial bus waveform.

I2C serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Table continued…
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Field or control Description
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to I2C.
SCLK Input Sets the source and threshold level for the Serial Clock Line signal.
SDA Input Sets the source and threshold level for the Serial Data signal.
Include R/W bit in Address Select Yes to display 7-bit addresses as eight bits, where the eighth bit (LSB) is the R/W bit, or display

10-bit addresses as 11 bits, where the third bit is the R/W bit.

Select No to display 7-bit addresses as seven bits, and 10-bit addresses as ten bits.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex and Binary.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

LIN serial bus configuration menu
Use this menu (optional) to set up and display a LIN (Local Interconnect Network) serial bus waveform.

• To set up a LIN serial bus
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1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to LIN.

• Double-tap the Bus waveform badge to change the settings on an existing LIN serial bus waveform.

LIN serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to LIN.
Source Set the signal source from available analog or digital channels.
Threshold Set the threshold level to define a logic high level.
Polarity Select the polarity (Normal or Inverted) to match the LIN bus being acquired.
LIN Standard Select the standard to match the LIN bus being acquired.
Bit rate Sets the bit rate.

To enter a custom bit rate, select Custom and enter the custom bit rate in the Custom Rate input box.

Include Parity Bits with ID Set to Yes to include parity bits with the ID.
Sample Point Sets the sample point from 5% to 95% of the position within the bit period or the unit interval.
Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical

views of each constituent signal.
Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and Mixed.

Mixed displays the Frame Id and parity in decimal, and everything else is displayed in hexadecimal
format.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132
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SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

MIL-STD-1553 serial bus menu
Use the MIL-STD-1553 bus menu (optional) to set up and decode a MIL-STD-1553 aeronautic network serial data bus waveform.

• To set up a MIL-STD-1553 serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to MIL-STD-1553.

• Double-tap the Bus waveform badge to change the settings on an existing MIL-STD-1553 serial bus waveform.

MIL-STD-1553 serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text using an attached keyboard.

Bus Type Set to MIL-STD-1553.
Polarity Select the polarity (Normal or Inverted) to match the MIL-STD-1553 bus being acquired.
Source Select the MIL-STD-1553 signal source.
High Threshold, Low
Threshold

Sets the valid high and low threshold values for the signal source.

RT Maximum Sets the maximum valid response time (RT) for a command.
RT Minimum Sets the minimum valid response time (RT) for a command.
Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical

views of each constituent signal.
Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, Mixed ASCII,

and Mixed Hex. Mixed ASCII displays data as ASCII, addresses as decimal, and binary bits. Mixed
Hex displays data as hexadecimal, addresses and count as decimal, and binary bits.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120
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Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

Parallel Bus configuration menu
Use this menu to set up and display a parallel bus waveform. Parallel bus decoding and triggering is included with the oscilloscope.

• To set up a Parallel serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to Parallel.

• Double-tap the Bus waveform badge to change the settings on an existing Parallel serial bus waveform.

Parallel bus configuration menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to Parallel to define a parallel bus.
Clocked Data Toggles Yes or No to use a clock signal to recover the data bits from the bus inputs.
Clock Source Sets the source for the bus clock signal. The source can be an analog or digital channel.

This field is only available when Clocked Data is set to Yes.

Clock Polarity Sets the clock signal edge (rising, falling, or both) to use for timing reference.

This field is only available when Clocked Data is set to Yes.

Table continued…
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Field or control Description
Threshold Sets the threshold value to determine high logic value.

This field is only available when Clocked Data is set to Yes.

Define Inputs Opens a Parallel Bus - Define Inputs configuration menu to set the signal sources and the bit order
(MSB to LSB) for the bus. See Parallel Bus - Define Inputs menu on page 131.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex and Binary.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

Parallel Bus - Define Inputs menu
Use this menu to select the signal sources and order for the parallel bus waveform.

To access the Parallel Bus - Define Inputs menu, double-tap a Parallel Bus badge to open the configuration menu, and tap the Define
Inputs button.
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Parallel Bus - Define Inputs menu fields and controls
Field or control Description
Parallel bus definition list Lists the signal source and thresholds of selected channels or waveforms. The MSB is at the top of the

list.

To add a signal to the Parallel bus definition list, tap a source button in the Sources list. The button
moves from the Sources list to the bottom of the bus list.

Use the arrow buttons to the right of the field to move a selected signal up or down in the list.

To remove a signal from the Parallel bus (and return it to the Sources list), tap on the signal source
button.

To change the threshold value for individual channels, tap in a selected Threshold field and use the
assigned multipurpose knob, or double-tap the field to open the keypad and enter values.

Sources Lists all available sources to use for a parallel bus. To add a source to the Parallel bus definition list,
tap a source button. The button moves from the Sources list to the bottom of the bus list.

Set All Thresholds Sets all thresholds in the Parallel bus definition list to the specified value. Enter a value and tap Apply
to set the values.

RS-232 serial bus menu
Use this menu (optional) to set up and display an RS232 serial bus waveform.

• To set up a RS-232 serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to RS-232.

• Double-tap the Bus waveform badge to change the settings on an existing RS-232 serial bus waveform.

RS-232 serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to RS-232.
Bit Rate Sets the data bit rate.

To enter a custom bit rate, select Custom and enter the custom bit rate in the Custom Rate input box.

Source Set the signal source from available analog or digital channels.
Threshold Set the threshold level to define a logic high level.
Polarity Select the polarity (Normal or Inverted) to match the RS-232 bus being acquired. Use Normal polarity

for RS-232 signals, and Inverted polarity for RS-422, RS-485, and UART buses.
Data Bits Set the number of bits that define a data packet for your RS-232 bus.
Table continued…

Menus and dialog boxes

132

www.tehencom.com          



Field or control Description
Parity Set the parity to match the RS-232 bus being acquired.
Packet View Set to On to show decoded packet level information on the bus waveform.

End of packet Select the appropriate end of packet value to match the RS-232 bus being acquired.

Available when Packet View is On.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and ASCII.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

SENT serial bus configuration menu
Use the SENT bus menu (optional) to set up and display a SENT (Single Edge Nibble Transmission) serial bus waveform.

• To decode SENT serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to SENT.

• Double-tap the Bus waveform badge to change the settings on an existing SENT serial bus waveform.
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SENT serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using virtual keyboard, or tap the field and enter
text from an attached keyboard.

Bus Type Set to SENT to set up and display a SENT serial bus waveform.
Source Select the signal source from the listed analog and digital channels.
Threshold Sets the high/low logic transition level.
Polarity Select the polarity as Normal or Inverted to match the SENT bus being acquired.
Clock Tick Sets the time period of the clock tick. The valid range is from 1 µs to 300 µs. The default is 3 µs.
Tick Tolerance Sets the tolerance, as a percent, that is acceptable for the clock tick signal to be recognized. The valid

tolerance range is from 1% to 30%. The default tolerance is 20%.
Fast Data Channels Sets the number of fast data channels. The default is 2.
Data Nibbles Sets the number of data nibbles to detect in the serial signal (3, 4, or 6).

Available when Fast Data Channels is 1.

Channel Widths (C1/C2) Sets the number of bits per channel when using two fast data channels (12/12, 14/10, or 16/8).

Available when Fast Data Channels is 2.

Pause Pulse Sets the instrument to detect a Pause pulse in the serial data. The default value is No.
Slow Channel Sets the slow channel characteristics. Tap and select from the available list of slow channel types. The

default value is None.
Display Format Sets the display format for waveforms as Bus or Bus and Waveform.

Bus sets the waveform view to display just the decoded bus information.

Bus and Waveform sets the waveform view to display both the decoded bus and the source signal
waveforms.

Decode Format Sets the decode format used to display the bus information. Formats are Hex, Binary, and Mixed.

Mixed displays the sync and pause pulse in decimal, the status in binary, and other bus information is
displayed in hexadecimal format.

The SENT serial bus options does not add corresponding bus trigger capabilities to the Trigger menu.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125
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I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

SPI serial bus configuration menu
Use the SPI bus menu (optional) to set up and display an SPI (Serial Peripheral Interface) synchronous serial bus waveform.

• To set up a SPI serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to SPI.

• Double-tap the Bus waveform badge to change the settings on an existing SPI serial bus waveform.

SPI serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to SPI.
Framing Set to Slave Select (SS) or Idle framing modes.
SCLK Input Select the channel source and threshold level for the Serial Clock signal (output from master).

Set the Polarity to rising or falling edge of the clock signal used by the master device to start
transferring bits.

SS Input Select the channel source and threshold level for the Slave Select signal to start communications with
the slave device.

Set the Polarity to use Active High or Active Low logic for the SS signal.

Available when Framing is SS.

MOSI Input Select the channel source and threshold level for the Master Out Slave/In signal.

Set the Polarity to use Active High or Active Low logic for the signal.

MISO Input Select the channel source and threshold level for the Master In Slave/Out signal.

Set the Polarity to use Active High or Active Low logic for the signal.

Table continued…
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Field or control Description
Word Size Enter the word size, in bits. Common word sizes are 8, 16, and 32.
Bit Order Set to most significant bit first (MS First) or least significant bit first (LS First).
Idle Time (Framing = ) Set the idle frame time.

Available when Framing is Idle.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex and Binary.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132

SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

USB serial bus configuration menu
Use the USB bus menu (optional) to set up and display an USB 2.0 (Universal Serial Bus) waveform.

• To set up a USB serial bus

1. Tap Math Ref Bus > Bus 1 or Bus 2 on the Settings bar.
2. Double tap the Bus badge to open the bus configuration menu.
3. Set the Bus Type to USB.

• Double-tap the Bus waveform badge to change the settings on an existing USB serial bus waveform.
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USB serial bus menu fields and controls
Field or control Description
Display Turns On or Off displaying the bus in the Waveform view.
Label Enter a label for the bus. The default label is the selected bus type.

To enter label text, double-tap the field and enter label using the virtual keyboard, or tap the field and
enter text from an attached keyboard.

Bus Type Set to USB.
Speed Set the speed to match the USB bus you are acquiring.
Signal type Set to match the USB signal you are acquiring (Single Ended or Differential). Use a differential probe to

acquire the differential USB signal.

Both Single Ended and Diff can be used to measure Full (12 Mbps) and Low (1.2 Mbps) speed USB
signals.

Source Select the channel source for the signal from a differential probe.

This field is only available when Signal Type is Diff.

High Threshold Set the high threshold level for the differential signal.
Low Threshold Set the low threshold level for the differential signal.
D+ Input Select the channel source and set the threshold level for the Data+ signal.

This field is only available when Signal Type is Single Ended.

D- Input Select the channel source and set the threshold level for the Data- signal.

This field is only available when Signal Type is Single Ended.

Display Format Sets the waveform view to show just the decoded bus information, or the decoded bus and the logical
views of each constituent signal.

Decode Format Sets the decode format used to display the bus information. Formats are Hex and Binary.

Other bus types
Serial bus types, such as CAN, LIN, Ethernet, and so on, are available as purchasable options. Once purchased and installed, the new bus
types are shown in the Bus Type menu. The serial bus options also add corresponding bus trigger capabilities to the Trigger menu.

Use the following links to access information on specific Bus configuration menus.

ARINC429 serial bus menu on page 120

Audio serial bus configuration menu on page 122

CAN serial bus configuration menu on page 123

FlexRay serial bus configuration menu on page 125

I2C serial bus configuration menu on page 126

LIN serial bus configuration menu on page 127

MIL-STD-1553 serial bus menu on page 129

Parallel Bus configuration menu on page 130

RS-232 serial bus menu on page 132
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SENT serial bus configuration menu on page 133

SPI serial bus configuration menu on page 135

USB serial bus configuration menu on page 136

See also
Bus Trigger configuration on page 211

Bus Search configuration menus on page 139

Add Results Table
Use the Results Table button to add a table of all active measurements, searches, bus decode values, and harmonics. Results tables show
values in a spreadsheet-like format.

To add a result table to the screen:

1. Tap Results Table.
2. Tap Measure, Bus1, Bus2, Search, or Harmonics to select a table type. The content displayed depends on the selected tab.

Results Table menu fields and controls
 

Field or control Description
Measurements Display a table of all the measurements in the Results bar.
Bus 1 Display a table of the bus decode results.

Each row in the event table represents a time-stamped byte, packet, or word, depending on the bus
type. As you scroll the event table using the multipurpose knob, the view point in the oscilloscope
display updates to show the position in the waveform corresponding to the event in the Event Table.

Bus 2

Search Display a table of all defined searches with each search shown on its own tab. The search mark table
shows a time-stamped listing of each event.

Harmonics Displays a table of the Harmonics measurement results (optional). Select between table view and bar
graph view using the Harmonics tab.

• To save the results table, double-tap the results table and tap Save Table to open the Save As menu.
• To change the vertical size of the results table, tap the bottom border of the table and drag it to a new location.

Search configuration menu overview
Use the Search configuration menu to define conditions that you want to mark on a channel or waveform signal.

If there is no Search badge on the Results bar, tap the Search button. A Search badge is added to the Results bar, and the Search
configuration menu opens to search type of Edge (default).

If there is a Search badge on the Results bar, double-tap the Search badge to open the Search configuration menu.

The search types and settings are similar to their corresponding trigger types (Edge, Pulse Width, Runt, and so on).

Each occurrence of the search condition is marked with a triangle along the top of the display.
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Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

 

Bus Search configuration menus
Use a Bus search to search for and mark bus-related events (Start, Stop, Missing Acq, Address, Data, and so on) on a bus waveform.

To create a new Bus search:

1. Tap Search.
2. Set the Search Type to Bus.
3. Select the bus Source.
4. Use the search menu fields to set the search parameters.

To change the settings of an existing search, double-tap the search badge to open its configuration menu and make necessary changes.

Select a link to view the configuration menu settings for a specific bus.

ARINC429 serial bus search configuration menu on page 140

Audio serial bus search configuration menu on page 142

CAN serial bus search configuration menu on page 143

FlexRay serial bus search configuration menu on page 145

I2C serial bus search configuration menu on page 147

LIN serial bus search configuration menu on page 149

MIL-STD-1553 Search configuration menu on page 150

Parallel bus search configuration menu on page 152

RS-232 serial bus search configuration menu on page 153

SPI serial bus search configuration menu on page 154

USB serial bus search configuration menu on page 155

 

Other search types
Edge Search configuration menu on page 157

Logic Search configuration menu on page 158
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Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

 

ARINC429 serial bus search configuration menu
Use the ARINC429 Search configuration menu to define conditions to search for and mark on an ARINC429 bus waveform.

Note: Requires option SRAERO.

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the ARINC429 bus to search.
Mark On Sets the type of information for which to search.
Mark When Sets the condition for which to search.
Label Sets the label pattern for which to search.

 

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Available when Mark When ≠ Inside Range or Outside Range .

Label Low Sets the low value of the label pattern range for which to search.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Available when Mark When = Label and Mark When Label = Inside Range or Outside Range.

Label High Sets the high value of the label pattern range for which to search.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Available when Mark When = Label and Mark When Label = Inside Range or Outside Range.

Table continued…
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Field or control Description
Mark When Data Sets the data condition for which to search.

 

Available when Mark On = Label & Data or Data.

Data Sets the data pattern for which to search.

 

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Available when Mark When Data ≠ Inside Range or Outside Range.

Data Low , Data High Sets the boundary data conditions when testing for in-range or out of range conditions.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Available when Mark When Data = Inside Range or Outside Range.

SSM Sets the Sign/Status Matrix (SSM) bit condition for which to search.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Available when Mark On = Data and the Data Format control in the bus definition is set to Data (19
bits) or SDI + Data (21 bits).

SDI Sets the Source/Destination Identifier (SDI) bit condition for which to search.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Available when Mark On = Data and the Data Format control in the bus definition is set to Data (19
bits).

Table continued…
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Field or control Description
Error Type Sets the error condition for which to search:

• Any - This includes Parity, Word, and Gap errors
• Parity - This error occurs if there are an even number of 1 bits, meaning that the word was

corrupted during transmission.
• Word - This error occurs if any part of the ARINC 429 format is violated; words must be 32 bits

long and contain a parity bit at position 32 and label bits at positions 1-8.
• Gap - This error occurs if there are less than 4 bit times of zero voltage between words.

 

Available when Mark On = Error.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Audio serial bus search configuration menu
Use the Audio Search configuration menu to define conditions to search for and mark on an Audio bus waveform.

Note: Requires option SRAUDIO.

 

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the Audio bus to search.
Mark On Select the type of information for which to search.
Data Sets the data pattern for which to search. Use in conjunction with the Mark When field to specify the

exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On ≠ Inside Range or Outside Range .

Table continued…
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Field or control Description
Word Sets the audio word channel for which to search.

 

Only available when Mark On = Data and the Audio bus is I2S, RJ, or LJ .

Mark When Sets the mark when condition for the specified data pattern.

 

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified search range.

 

Only available when Mark On = Data and the Audio bus is TDM .

Data Low, Data High Sets the boundary data conditions when testing for in-range or out of range conditions.

Available when Mark When is set to Inside Range or Outside Range.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

CAN serial bus search configuration menu
Use the CAN Search configuration menu to define conditions to search for and mark on a CAN bus waveform.

Note: Requires option SRAUTO.

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the CAN bus that you want to search.
Mark On Select the type of information for which to search.
Frame Type Sets the frame type for which to search.

 

BRS Bit Sets the BRS bit state for which to search.

 

Only available when Mark On = FD BRS Bits.

Table continued…
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Field or control Description
ESI Bit Sets the ESI bit state for which to search.

 

Only available when Mark On = FD ESI Bits.

Identifier Format Sets the identifier for Standard (11-bit) or Extended (29-bit for CAN 2.0B) length.

 

Only available when Mark On = Identifier or ID & Data.

Identifier Sets the identifier pattern for which to search. The number of bits shown depends on the Identifier
Format setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Identifier or ID & Data.

Search When Data Sets the data to search for.

Only available when Mark On = Identifier or ID & Data.

Data Bytes Sets the number of data bytes for which to search (one to eight bytes). Use the A knob to change the
value.

 

Only available when Mark On = Data or Identifier & Data .

Data Offset Sets the data offset in bytes to delay the trigger. Use the A knob to change the value.

 

Only available when Mark On = Data or Identifier & Data .

Data Sets the data pattern for which to search. The number of bits shown depends on the Data Bytes
setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Data or Identifier & Data .

A, B knob controls Use the A knob to select (highlight) the digit to change.

 

Use the B knob to change the value of the digit.

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.
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Field or control Description
Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

FlexRay serial bus search configuration menu
Use the FlexRay Search configuration menu to define conditions to search for and mark on a FlexRay bus waveform.

Note: Requires option SRAUTO.

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the FlexRay bus for which to search.
Mark On Select the type of information for which to search.
Indicator Bits Select the defined indicator bits type for which to search from the drop-down list: Normal (01XX),

Payload (11XX), Null (00XX), Sync (XX10), or Startup (XX11).

 

Only available when Mark On = Indicator Bits.

Indicator Bits Enter the indicator bits for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Header Fields.

Identifier Enter the frame identifier pattern for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Identifier & Data or Header Fields.

Table continued…
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Field or control Description
Cycle Count Enter the cycle count pattern for which to search. Use in conjunction with the Mark When field to

specify the exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Cycle Count and Mark When Data is not set to Inside Range or
Outside Range .

Payload Length Enter the payload length pattern for which to search. Use in conjunction with the Mark On field to
specify the exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Header Fields.

Header CRC Enter the header CRC pattern for which to search. Use in conjunction with the Mark On field to specify
the exact search condition.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Header Fields.

Data Bytes Enter the number of data bytes for which to search (one to sixteen bytes). Use the A knob to change
the value.

 

Only available when Mark On = Data or Identifier & Data.

Data Enter the data pattern for which to search. The number of bits shown depends on the Data Bytes
setting. Use in conjunction with the Mark On field to specify the exact search condition.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

 

Only available when Mark On = Data or Identifier & Data and Mark When Data is not set to Inside
Range or Outside Range.
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Field or control Description
Data Low, Data High Sets the boundary data conditions when testing for in-range or out of range conditions.

Available when Mark On = Data or Identifier & Data and Mark When Data is set to Inside Range or
Outside Range.

Data Offset Sets the data offset (Don't Care or the number of bytes). Tap the field and use the A knob to change
the value.

 

Only available when Mark On = Data or Identifier & Data.

Mark When Sets the mark when condition.

 

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified search range.

 

Only available when Mark On = Identifier or Cycle Count.

Frame Type Sets the end of frame type for which to search.

 

Only available when Mark On = End of Frame.

Error Type Sets the error type for which to search.

 

Only available when Mark On = Error.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

I2C serial bus search configuration menu
Use the I2C Search configuration menu to define conditions to search for and mark on an I2C bus waveform.

Note: Requires option SREMBD.
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Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the I2C bus that you want to search.
Mark On Select the type of information for which to search.
Direction Sets the transfer direction for which to search.

 

Only available when Mark On = Address or Address & Data.

Addressing Mode Sets the slave device address length (7 bits or 10 bits long).

 

Only available when Mark On = Address or Address & Data.

Address Sets the address pattern for which to search. The number of bits shown depends on the Address
Mode setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Address or Address & Data.

Data Bytes Sets the number of data bytes for which to search (one to five bytes). Use the A knob to change the
value.

 

Only available when Mark On = Data or Address & Data.

Data Sets the data pattern for which to search. The number of bits shown depends on the Data Bytes
setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark When = Data or Address & Data.

A, B knob controls Use the A knob to select (highlight) the character to change.

 

Use the B knob to change the value of the character.

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.
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LIN serial bus search configuration menu
Use the LIN Search configuration menu to define conditions to search for and mark on an LIN bus waveform.

Note: Requires option SRAUTO.

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the LIN bus that you want to search.
Mark On Select the type of information for which to search.
Identifier Sets the identifier pattern for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Identifier or Identifier & Data.

Data Bytes Sets the number of data bytes for which to search (one to four bytes). Use the A knob to change the
value.

 

Only available when Mark On = Data or Identifier & Data.

Data Sets the data pattern for which to search. The number of bits shown depends on the Data Bytes
setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Data or Identifier & Data.

Mark When Data Sets the mark when condition.

 

When set to Inside Range or Outside Range, fields are displayed to set a Data Low and Data High
boundary pattern for the specified search range.

 

Only available when Mark On = Data or Identifier & Data.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Table continued…
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Field or control Description
Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

MIL-STD-1553 Search configuration menu
Use the MIL-STD-1553 Search configuration menu to define conditions to search for and mark on an MIL-STD-1553 bus waveform.

Note: Requires option SRAERO.

 

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the MIL-STD-1553 bus that you want to search.
Mark On Select the type of information for which to search.
Transmit/Receive Bit Sets the transmit or receive bit state for which to search.

Only available when Mark On = Command.

Mark When Sets when to place a mark.

 

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified search range.

Only available when Mark On = Time (RT/IMG).

Maximum Time and Minimum
Time

Sets the high and low boundary for the specified search range.

 

Only available when Mark On = Time (RT/IMG).

Mark When RT Address Sets the RT address condition for which to search.

 

When set to Inside Range or Outside Range, fields are displayed to set a low and high address for
the specified search range.

 

Only available when Mark On = Command or Status.

Parity Sets the parity state for which to search.

 

Only available when Mark On = Command or Status.
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Field or control Description
Address Sets the address value for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark When RT Address ≠ Inside Range or Outside Range.

Low Address Sets the low address value for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark When RT Address = Inside Range or Outside Range.

High Address Sets the high address value for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark When RT Address = Inside Range or Outside Range.

Subaddress/Mode Sets the subaddress or mode value for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Command.

Word Count/Mode Code Sets the word count or mode count value for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Command.

Table continued…
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Field or control Description
Status Word Bits Sets the status word pattern for which to search.

 

Tap the field and use the A and B knobs to select and change the values. Selecting a bit shows a short
description of that bit's function.

 

Only available when Mark On = Command.
Data Sets the data pattern for which to search.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Available when Mark On = Data.

Error Type Sets the error condition for which to search.

 

Available when Mark On = Error.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Parallel bus search configuration menu
Use the Parallel Search configuration menu to define conditions to search for and mark on an Parallel bus waveform. You can have
multiple searches on the same bus.

Note: Parallel bus search is standard on all instruments.

 

Field or control Description
Display Enables or disables displaying search marks on this search.
Stop Acquisition if Event
Found

Stops input acquisition when the search event occurs. Default is not enabled.

Source Select the parallel bus that you want to search.
Table continued…
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Field or control Description
Data Sets the data pattern for which to search. The number of bits shown depends on how the parallel bus

is defined.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

RS-232 serial bus search configuration menu
Use the RS-232 Search configuration menu to define conditions to search for and mark on an RS-232 bus waveform. You can have
multiple searches on the same bus.

Note: Requires option SRCOMP.

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the RS-232 bus that you want to search.
Mark On Select the type of information for which to search.
Data Bytes Sets the number of data bytes (1 byte = 8 bits) for which to search (one to ten bytes). Use the A knob

to change the value.

 

Only available when Mark On = Tx Data or Rx Data.

Data Sets the data pattern for which to search. The number of bits shown depends on the Data Bytes
setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Tx Data or Rx Data.
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Field or control Description
A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

SPI serial bus search configuration menu
Use the SPI Search configuration menu to define conditions to search for and mark on an SPI bus waveform.

Note: Requires option SREMBD.

 

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the SPI bus that you want to search.
Mark On Select the type of information for which to search.
Data Bytes Sets the number of data bytes (1 byte = 8 bits) for which to search (one to sixteen bytes). Use the A

knob to change the value.

 

Only available when Mark On = Data.

Data Sets the data pattern for which to search. The number of bits shown depends on the Data Words
setting.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On = MOSI, MISO or MOSI & MISO.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.
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Field or control Description
Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

USB serial bus search configuration menu
Use the USB Search configuration menu to define conditions to search for and mark on an USB bus waveform.

Note: Requires option SRUSB2.

 

Field or control Description
Display Enables or disables displaying search marks on this search.
Source Select the USB bus that you want to search.
Mark On Select the type of information for which to search.
Data Packet Type Sets the special packet type for which to search.

 

Only available when Mark On = Data Packet.

Address Sets the token packet address pattern for which to search. Use in conjunction with the Mark When
field to specify the exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On ≠ Inside Range or Outside Range.

Token Type Sets the token packet type for which to search.

 

Only available when Mark On = Token Packet.

Endpoint Sets the token packet endpoint pattern for which to search. Use in conjunction with the Mark When
field to specify the exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Token Packet and Token Type = all except SOF (0101).
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Field or control Description
Frame Number Sets the frame number pattern for which to search. Use in conjunction with the Mark When field to

specify the exact search condition.

 

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Only available when Mark On = Token Packet and Token Type = SOF (0101).

Data Packet Type Sets the data packet type for which to search.

 

Only available when Mark On = Data Packet.

Data Bytes Sets the number of data bytes for which to search (one to sixteen bytes). Tap the field and use the A
knob to change the value.

 

Only available when Mark On = Data Packet.

Data Offset Sets the data offset (Don't Care or the number of bytes). Tap the field and use the A knob to change
the value.

 

Only available when Mark On = Data Packet.

Data Sets the data packet pattern for which to search. The number of bits shown depends on the Data
Bytes setting. Use in conjunction with the Mark When field to specify the exact search condition.

 

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

 

Only available when Mark On ≠ Inside Range or Outside Range.

Data Low, Data High Sets the boundary data conditions when testing for in-range or out of range conditions.

Available when Mark When is set to Inside Range or Outside Range.

Mark When Sets the mark when condition.

 

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified search range.

 

Only available when Mark On = Handshake Packet, Error, Special Packet, Data Packet, or Token
Packet and Token Type is set to anything but SOF (0101).
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Field or control Description
A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Or double-tap the field and use the virtual keypad to enter the data. See Binary, decimal, hex, and
octal virtual keypads on page 243.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Edge Search configuration menu
Use the Edge search to mark when the specified edge condition occurs on a waveform.

To create a new edge search:

1. Tap Search.
2. Set the Search Type to Edge.
3. Select the search Source.
4. Use the menu fields to set the search parameters.

To change the search settings, double-tap the search badge and make necessary changes.

Edge Search configuration menu fields and controls
 

Field or control Description
Display Sets the display of the mark icons on or off.

Source Lists the source channel or waveform to use to trigger or search. Types that require multiple inputs will
replace this control with a different source definition control.

Coupling Lists the coupling to use to trigger or search.
Level Sets the amplitude level that the signal must pass through to be considered a valid transition.
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Slope Sets the signal transition direction to detect. (rising, falling, or either direction).
Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139
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Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

 

Logic Search configuration menu
Use the Logic search to mark when specified logic conditions occur on an analog, digital, math, or reference waveform.

To create a new logic search:

1. Tap Search.
2. Set the Search Type to Logic.
3. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Logic Search configuration menu fields and controls
 

Field or control Description
Display Sets the display of the mark icons to either On or Off. If you have multiple searches defined, the

control turns off just the marks for the selected search.
Search Type Set to Logic.
Use Clock Edge? Enables or disables finding logic patterns that occur on the specified clock edge.

 

Yes places marks on the clock waveform wherever the logic pattern occurs.

 

No places marks on the input signal waveform(s) wherever the logic pattern occurs.

Logic Pattern: Define Inputs Opens the Logic Search-Define Inputs configuration menu where you define the logic state (High, Low,
or Don't Care), and the signal threshold level that defines the logic state for each analog or digital
signal. See Define Inputs.

Mark When Defines the waveform logic event to mark, when Use Clock Edge is set to No.

• Goes True: All conditions change to a true state.
• Goes False: All conditions change to a false state.
• Is True > Limit: Condition remains true longer than a specified time.
• Is True < Limit: Condition remains true for less than a specified time.
• Is True = Limit: Condition remains true for a specified time (within ± 5%).
• Is True ≠ Limit: Condition does not remain true for a specified time (within ± 5%).
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Field or control Description
Clock Source Sets the signal to use as the clock. The clock source can be an analog, digital, math, or reference

waveform.
Clock Edge Sets the polarity of the clock edge (rising or falling) for evaluating the other menu conditions. The Logic

menu also lets you set the clock edge to either edge.
Clock Threshold Sets the threshold level that the clock signal must pass through to be considered a valid transition. The

clock threshold value is independent of the input signal threshold(s).
Define Logic Sets the logic condition that must occur with all inputs.

• AND: All conditions are true.
• OR: Any condition is true.
• NAND: One or more conditions are true.
• NOR: No conditions are true.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

Logic Search - Define Inputs configuration menu
Use the Define Inputs menu to select the logic condition to search on, and the logic threshold value, for each channel.

To open the Logic Search-Define Inputs configuration menu:

1. Double-tap the Logic Search badge on the Settings bar.
2. Tap the Logic Pattern > Define Inputs invoker button.

Logic Search - Define Inputs configuration menu fields and controls
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Field or control Description
Ch(x) (analog channels) or
D(x) (digital Channels

Use to select the logic condition, of the signal source, on which to perform the logic search (High,
Low, Don't Care).

 

If a channel is a digital channel, tap the + symbol to open the list of digital inputs (D15-D8 or D7-D0)
from which to select individual logic conditions for the digital signals.

 

Use the Threshold field to set the signal level that must be exceeded for that signal to be true (logical
1).

Set All Sets all signal sources to detect a logic High, Low, or Don't Care condition.

 

Pulse Width Search configuration menu
Use the Pulse Width search to mark a waveform whenever the specified pulse width condition occurs.

To create a new pulse width search:

1. Tap Search.
2. Set the Search Type to Pulse Width.
3. Select the search Source.
4. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Pulse Width Search menu fields and controls

 

Field or control Description
Display Sets the display of the mark icons on or off.

Search Type Set to Pulse Width.
Source Lists the source channel or waveform to use to trigger or search. Types that require multiple inputs will

replace this control with a different source definition control.

Mark When • < Limit: A pulse width is less than the specified time limit.
• > Limit: A pulse width is greater than the specified time limit.
• = Limit: A pulse width is equal to the specified time limit.
• ≠ Limit: A pulse width does not equal (is greater than or less than) the specified time limit.
• Inside Range: A pulse width is in the specified time range.
• Outside Range: A pulse width is outside of the specified time range.

Level Sets the amplitude level that the signal must pass through to be considered a valid transition.
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Table continued…
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Field or control Description
Time Limit Sets the time period condition to be met.
High Time Limit Sets the longest acceptable pulse width time period for the range condition.

 

Only available when Mark When = Inside Range or Outside Range.

Low Time Limit Sets the shortest acceptable pulse width time period for the range condition.

 

Only available when Mark When = Inside Range or Outside Range.

Polarity Sets the polarity of the pulse to detect (positive pulse only, negative pulse only, or a positive or
negative pulse).

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

 

Rise/Fall Time Search configuration menu
Use the Rise/Fall Time search to mark occurrences where the rise or fall time is less than, greater than, equal to, or not equal to a
specified time limit.

To create a new rise/fall time search:

1. Tap Search.
2. Set the Search Type to Rise/Fall Time.
3. Select the search Source.
4. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Rise/Fall Time Search configuration menu fields and controls
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Field or control Description
Display Sets the display of the mark icons on or off.

Search Type Set to Rise/Fall Time.
Source Lists the source channel or waveform to use to trigger or search. Types that require multiple inputs will

replace this control with a different source definition control.
Mark When • < Limit: A signal has a rise/fall time less than the specified time limit.

• > Limit: A signal has a rise/fall time greater than the specified time limit.
• = Limit: A signal has a rise/fall time that is equal to the specified time limit (±5%).
• ≠ Limit: A signal has a rise/fall time that does not equal (is greater than or less than) the specified

time limit (±5%).

Time Limit Sets the time period condition to be met.
Slope Sets the signal transition direction to detect. (rising, falling, or either direction).
Upper Threshold Sets the upper amplitude level through which the signal must pass to be considered a valid transition.

Lower Threshold Sets the lower amplitude level through which the signal must pass to be considered a valid transition.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

 

Runt Search configuration menu
Use the Runt search to mark a waveform where a pulse crosses one threshold but fails to cross a second threshold before recrossing the
first threshold.

To create a new runt search:

1. Tap Search.
2. Set the Search Type to Runt.
3. Select the search Source.
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4. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Runt Search configuration menu fields and controls
 

Field or control Description
Display Sets the display of the mark icons on or off.

Search Type Set to Runt.
Source Lists the source channel or waveform to use to trigger or search. Types that require multiple inputs will

replace this control with a different source definition control.

Mark When • Occurs: A runt signal event occurs.
• < Limit: A runt signal event occurs that has a pulse width less than the specified time limit.
• > Limit: A runt signal event occurs that has a pulse width greater than the specified time limit.
• = Limit: A runt signal event occurs that has a pulse width that is equal to the specified time limit

(±5%).
• ≠ Limit: A runt signal event occurs that has a pulse width that does not equal (is greater than or

less than) the specified time limit (±5%).

Time Limit Sets the time period condition to be met.

 

Only available when Mark When = < Limit, > Limit, = Limit, or != Limit.

Polarity Sets the polarity of the pulse to detect (positive pulse only, negative pulse only, or a positive or
negative pulse).

Upper Threshold Sets the upper amplitude level through which the signal must pass to be considered a valid transition.

Lower Threshold Sets the lower amplitude level through which the signal must pass to be considered a valid transition.

Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165
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Setup and Hold Search configuration menu
Use the Setup and Hold search type to mark a waveform when a data signal changes state inside of a specified setup and hold time,
relative to a specified clock signal.

To create a new setup and hold search:

1. Tap Search.
2. Set the Search Type to Setup & Hold.
3. Select the search Clock Source.
4. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Setup & Hold Search configuration menu fields and controls
 

Field or control Description
Display Sets the display of the mark icons on or off.

Search Type Set to Setup & Hold.
Clock Source Sets the signal to use as the clock. The clock source can be an analog, digital, math, or reference

waveform.
Clock Threshold Sets the threshold level that the clock signal must pass through to be considered a valid transition. The

clock threshold value is independent of the input signal threshold(s).
Clock Edge Sets the polarity of the clock edge (rising or falling) for evaluating the other menu conditions. The Logic

menu also lets you set the clock edge to either edge.
Data Sources Sets the data signal source(s). All selected sources must meet the specified setup and hold times. See

Setup and Hold Search - Define Inputs configuration menu on page 165.
Setup Time Sets the length of time that data signal should be stable and not change before a clock edge occurs.
Hold Time Sets the length of time that data signal should be stable and not change after a clock edge occurs.
Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162
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Timeout Search configuration menu on page 165

 

Setup and Hold Search - Define Inputs configuration menu
Use the Define Inputs menu to select the data signal source(s) and set their threshold level(s).

To open the Setup & Hold Search - Define Inputs menu:

1. Double-tap a Setup & Hold Search badge on the Results bar.
2. Tap the Data Sources > Define Inputs button.

Setup and Hold Search - Define Inputs configuration menu fields and controls
 

Field or control Description
Ch(x) (analog channels) or
D(x) (digital Channels

Use to add (Include) or exclude (Don't Include) the data signal(s) from available input channels and
waveforms.

 

If a channel is a digital channel, tap the + symbol to open the list of digital inputs (D15-D8 or D0-D7)
from which to select for that channel.

 

Use the Threshold fields to set the signal level that must be exceeded for the signal transition to be
true.

Set All Use to Include or Don't Include all available channels and waveforms as data signals.

Timeout Search configuration menu
Use the Timeout search to mark a waveform when it does not detect an expected pulse transition within a specified period of time, such as
when a signal gets stuck either high or low.

To create a new timeout search:

1. Tap Search.
2. Set the Search Type to Timeout.
3. Select the search Source.
4. Use the menu fields to set the search parameters.

To change the settings on an existing search, double-tap the search badge and make necessary changes.

Timeout Search menu fields and controls
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Field or control Description
Display Sets the display of the mark icons to either On or Off. If you have multiple searches defined, the

control turns off just the marks for the selected search.

Sets the display of the mark icons on or off.

Search Type Set to Timeout.
Source Lists the source channel or waveform to use to trigger or search. Types that require multiple inputs will

replace this control with a different source definition control.
Mark When • Stays High: The signal stays above the specified threshold level longer than the specified time.

• Stays Low: The signal stays below the specified threshold level longer than the specified time.
• Either: The signal stays above or below the specified threshold level longer than the specified

time.

Threshold Sets the amplitude level that the signal must pass through to be considered a valid transition.
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Time Limit Sets the time period condition to be met.
Copy Trigger Settings to
Search

Sets the search criteria to match the current oscilloscope trigger settings. If the trigger settings are not
valid in Search, this control is either not available or grayed out.

Copy Search Settings to
Trigger

Sets the current oscilloscope trigger settings to match the search criteria.

Other search types
 

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161

Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

 

Analog Channel configuration menu
Use the Analog Channel configuration menu to set up analog channel vertical settings, probe settings, deskew settings, external
attenuation, and alternate units for analog channel inputs.

To open an analog channel configuration menu, double-tap an analog channel badge. The following text describes analog channel
settings. For digital channel settings, see Digital channel configuration menu on page 181.
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Vertical Settings panel, fields and controls
Field or control Description
Display Toggles display of the channel On and Off.

Invert Toggles invert of the channel On and Off. Default is off.

Vertical Scale Set the scale using the multipurpose knob, double-tap to bring up the virtual keypad, or tap the up and
down arrows to change the scale.

Offset Set the offset using the virtual keypad.

Set to 0 Sets the offset to 0.

Position Set the vertical position using the virtual keypad.

Set to 0 Sets the waveform zero volt level to the center of the waveform view.

Label Add a label to the channel display using the virtual keypad.

Bandwidth Limit Select the bandwidth limit from the drop-down list. Lower bandwidth limits noise and can provide a
cleaner view of the signal. Bandwidth is shown in the channel badge and a BW icon indicates that the
bandwidth of the channel is lower than it theoretically could be due to a user setting or the attached
probe.

Coupling Sets the input coupling to DC or AC:

• DC coupling passes all input signals to the input channel.
• AC coupling passes the input signals above 60 Hz to the input channel.

Termination Sets the input termination to 1 MΩ or 50 Ω. If you are using a supported TPP probe, this value is
automatically set by the probe and these controls are not available.

Other settings panels
Probe Setup Use to see probe information, check the probe compensation status, compensate the probe, or restore

the factory defaults

.

 

See Probe Setup panel (Channel configuration menu) on page 168.

 

See Probe Compensation configuration menu (analog channels Probe Setup panel) on page 169.

Other Use to adjust signal delay to align signal arrival at the oscilloscope between probes and/or cables, set
external attenuation, and set alternate units.

 

See Other panel (Channel configuration menu) on page 169.
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Probe Setup panel (Channel configuration menu)
Use the Channel configuration menu Probe Setup panel to see probe information, check the probe compensation status, compensate the
probe, or restore the factory defaults.

To open the Probe Setup panel:

1. Double-tap an analog Channel badge on the Settings bar to open the Channel configuration menu.
2. Tap the Probe Setup panel.

Probe Setup panel fields and controls
Available fields and controls vary with the type of probe that is attached. For more information, consult the probe documentation.

Field or control Description
Probe Information View probe information such as probe type, serial number, version, propagation delay, and its

attenuation.
Probe Compensation Status View the probe compensation status: Default, Pass, Running, or Fail.
Compensate Probe Displays the probe compensation dialog. This is only available for probes that support automatic

compensation.
Restore Factory Defaults Delete the stored compensation values for this probe and channel combination and restore the factory

defaults. This is only available for probes that support automatic compensation.

Field or control Description
Probe Information View probe information such as probe type, serial number, version, propagation delay, and its

attenuation.
Probe Compensation Status View the probe compensation status: Default, Pass, Running, or Fail.
Compensate Probe Displays the probe compensation dialog. This is only available for probes that support automatic

compensation.
Mode Select the probe operating mode from the drop down list (Differential, Common Mode, A, or B).
Offset Enter the A or B offset value. This value is the same as the Offset in the Settings panel.
Differential Offset Tracking When checked, the Differential Offset Tracking mode is Tracking. When unchecked, the Differential

Offset Tracking is Manual.
Differential Offset When in manual mode, enter the Differential Offset value.
Common Mode Offset When in manual mode, enter the Common Mode Offset value.
Common Mode Offset Tracking When checked, the Common Mode Offset Tracking mode is Tracking. When unchecked, the Common

Mode Offset Tracking is Manual.
VTerm Tracking When checked, the VTerm mode is Tracking. When unchecked, the VTerm is Manual.
VTermA When in manual mode, enter the VTermA value.
VTermB When in manual mode, enter the VTermB value.

Probe error messages are also displayed in this setup panel, see Error messages and badges on page 49.

See also
 

Probe Compensation configuration menu (analog channels Probe Setup panel) on page 169

Other panel (Channel configuration menu) on page 169
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Deskew configuration menu (Other panel Channel configuration menu) on page 170

 

Probe Compensation configuration menu (analog channels Probe Setup panel)
Use this menu to compensate probes that support automatic frequency compensation. This menu is only available when a compensation-
supported probe is installed on the channel.

To open the Probe Compensation dialog:

1. Double-tap the Channel badge on the Settings bar to open the channel configuration menu.
2. Tap the Probe Setup panel.
3. Tap Compensate Probe.

Probe Compensation dialog
Available fields and controls vary with the type of probe that is attached. For more information, consult the probe documentation. Read the
information on the menu before starting the probe compensation process.

Field or control Description
Compensate Probe Compensates the attached probe. Before compensating the probe, read the instructions in the dialog.
Restore Factory Defaults Restores the probe compensation factory defaults and removes the previous compensation results.
Probe Compensation Status Probe compensation status can be Running, Passed, Failed or Default.

See also
 

Other panel (Channel configuration menu) on page 169

Deskew configuration menu (Other panel Channel configuration menu) on page 170

 

Other panel (Channel configuration menu)
Use the Other panel to set the channel deskew, external attenuation, and alternate vertical scale units.

To open the analog Channel configuration menu Other panel:

1. Double-tap an analog Channel badge on the Settings bar to open the Channel configuration menu.
2. Tap the Other panel.

Other panel fields and controls
Not all items listed in the table are shown for all measurements; The panel only shows fields and controls relevant to the selected
measurement.

Field or control Description
Deskew Sets or displays the probe deskew value.

Use Deskew to make display and measurement adjustments for probes that have differing propagation
delays. This is especially important when using a current probe in conjunction with a voltage probe.

Table continued…
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Field or control Description
Set to 0 Sets the probe deskew value to zero (0) seconds.
Multi-Channel Opens a Deskew configuration menu that allows you to deskew multiple channels (two at a time).
External Attenuation Double-tap the numeric fields to set the external attenuation using the virtual keypad. Use this control

to set the input/output ratio of any external attenuation or gain between the signal and input channels.
Probe type Selects the probe type.
Measure Current Toggles between Yes and No. This control is only visible when Probe Type is set to Voltage.
Ratio Sets the ratio using the virtual keypad. These fields show the conversion from volts to amps and amps

to volts. As you change one, the other changes as well. This control is only present when Measure
Current is set to Yes.

Set to Unity Sets the external attenuation ratio to unity. Only shown when Alternate Units = On.

See also
 

Probe Compensation configuration menu (analog channels Probe Setup panel) on page 169

Deskew configuration menu (Other panel Channel configuration menu) on page 170

 

Deskew configuration menu (Other panel Channel configuration menu)
Use the Deskew configuration menu to make display and measurement adjustments for analog probes that have differing propagation
delays. This is especially important when using a current probe in conjunction with a voltage probe for power measurements.

To open the Deskew configuration menu:

1. Double-tap an analog Channel badge on the Settings bar to open the Channel configuration menu.
2. Tap the Other panel.
3. Tap the Multi-Channel button.

Use the controls in the Deskew menu to set the deskew parameters to recommended values, based on the nominal propagation delay of
supported probes. The oscilloscope automatically loads the nominal propagation delay values of TPP probes (TekProbe II probes require
use of a TPA-BNC adaptor).

Note: This deskew menu does not actively test and adjust the probe delay between channels; it uses the delay values stored in
supported probes, or a custom propagation delay value that you enter, to set the propagation delay to zero between the reference
channel probe and one or more other probes.

To actively adjust probe delay using a signal, see Deskew analog input channels - quick visual method on page 60 and Deskew
analog input channels - measurement method on page 61.

Deskew menu fields and controls
Available fields and controls vary with the type of probe that is attached. For more information, consult the probe documentation.

Field or control Description
From Source Select from the drop-down list the channel to deskew from (your reference channel for deskewing).
To Source Select from the drop-down list the channel to deskew to (the channel that you want to match the From

Source reference channel).
Table continued…
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Field or control Description
Probe If the oscilloscope recognizes the probe attached to the channel, the Probe field shows the

nomenclature of the attached probe.

 

If the oscilloscope does not recognize the probe attached to the channel, the Probe field shows a
drop-down list from which you can select the probe that is attached to the selected channel.

 

If the attached probe is not in the list, select Custom (at the bottom of the list) and enter the probe
propagation delay in the Propagation Delay field.

Propagation Delay This field lists the default propagation delay of the attached probe. A positive value shifts a channel to
the left.

OK, deskew Sets the oscilloscope to add or subtract the delay values of the To Source channel such that the delay
between the two channels is as close to 0 as possible.

See also
 

Probe Compensation configuration menu (analog channels Probe Setup panel) on page 169

Other panel (Channel configuration menu) on page 169

Deskew analog input channels - measurement method on page 61

Deskew analog input channels - quick visual method on page 60

AFG configuration menu
Use the AFG configuration menu to set the output signal parameters for the optional arbitrary/function generator. Use the AFG to simulate
signals within a design or add noise to signals to perform margin testing.

To open the AFG configuration menu:

1. If Off, tap the AFG button on the Settings bar. When Output is set to On, the oscilloscope changes the AFG button to an AFG badge
that shows the AFG settings.

2. If On, double-tap the AFG badge to open the AFG menu.

Arbitrary/Function Generator overview
The function generator provides output of predefined waveforms up to 50 MHz. Choose between Sine, Square, Pulse, Ramp, DC, Noise,
Sin(x)/x, Gaussian, Lorentz, Exponential Rise, Exponential Decay, Haversine, Cardiac and Arbitrary signals. The function generator also
supports AM/FM modulation.

You can select a predefined waveform or load a saved .isf- or .csv-format waveform from storage (USB drive).

Arbitrary/Function Generator Output menu fields and controls
Not all items listed in the table may be shown for all waveform types. The configuration menu only shows fields and controls relevant to the
selected Waveform Type.

The output connector is on the rear panel, labeled AFG Out.
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Note: The AFG output is turned off when setups or sessions are recalled even if they were saved with the AFG on.

Field or control Description
Output Toggles the output On or Off.
Waveform Type Tap to select an available waveform from the list. Waveform types include: Sine, Square, Pulse, Ramp,

DC, Noise, Sin(x)/x, Gaussian, Lorentz, Exponential Rise, Exponential Decay, Haversine, Cardiac, and
Arbitrary.

Load From Select the source of the waveform from the drop-down list. Navigate to and select a waveform file to
load into the AFG memory.

Choose from the following locations (Channel 1 is the default location):

• Active analog channels
• Active digital channels
• Active math waveforms
• Active reference waveforms
• Arb memory locations
• File

 

Available when Waveform Type = Arbitrary.

Waveform File Shows the loaded waveform file path and name. Tap to select a waveform file to load into the AFG
waveform memory from the drop-down list of the last 20 waveforms that have been loaded using the
Load button.

Symmetry Sets the symmetry of the ramp using the keypad or multipurpose knob.

 

Available when the Waveform Type = Ramp.

Width Sets the width of the pulse using the keypad or multipurpose knob.

 

Available when the Waveform Type = Pulse.

Duty Cycle Sets the duty cycle of the square wave using the keypad or multipurpose knob.

 

Available when the Waveform Type = Square.

Frequency Sets the frequency of the waveform using the keypad or multipurpose knob. The frequency range is
0.1 Hz to 50 MHz, in increments of 0.1 Hz.

Period Sets the period of the waveform using the keypad or multipurpose knob.
Amplitude Sets the amplitude of the waveform using the keypad or multipurpose knob.
Offset Sets the offset of the waveform using the keypad or multipurpose knob.
High Level Sets the High signal amplitude of the waveform using the keypad or multipurpose knob.
Low Level Sets the low signal amplitude of the waveform using the keypad or multipurpose knob.
Table continued…
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Field or control Description
Load Impedance Selects either 50 Ω or High Z (1 MΩ) output load impedance.

Load impedance scales the vertical settings to show what the load would see based on the load
impedance. Since the AFG is a 50 Ω source, for most accurate operation, set the load impedance to
50 Ω and set the input channel to 50 Ω.

Add Noise Toggles noise on and off. Set the amount of noise to add to the output signal using the keypad or the
multipurpose controls.

 

When Modulation is on, Add Noise is not available.

OK, Load Waveform Loads the selected waveform.
Browse Browse to the desired waveform.
Save Waveform Opens a Save As menu for saving AFG waveforms to internal waveform slots or to an external file

location.

Modulation menu fields and controls

Note: The modulation menu is not available when the Waveform Type is set to DC, Pulse, Noise, or Cardiac.

Field or control Description
Modulation Toggles the modulation On or Off.
Modulation Type Toggle between AM or FM modulation. The default modulation is AM.
Frequency Sets the frequency of the modulation using the keypad or multipurpose knob.
Modulation Shape Select the modulation shape from the drop-down list.

• Sine
• Square
• Triangle
• Up Ramp
• Down Ramp
• Noise

Depth Sets the depth of the modulation using the keypad or multipurpose knob.

 

Only shown when the Modulation Type = AM.

Deviation Sets the deviation of the modulation using the keypad or multipurpose knob.

 

Only shown when the Modulation Type = FM.

AFG output amplitude ranges by impedance (peak to peak)
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Waveform 50 Ω High Z
Sine 10 mV to 2.5 V 20 mV to 5 V
Square 10 mV to 2.5 V 20 mV to 5 V
Pulse 10 mV to 2.5 V 20 mV to 5 V
Ramp 10 mV to 2.5 V 20 mV to 5 V
DC 0 V to ±1.25 V 0 V to ±2.5 V
Noise 10 mV to 2.5 V 20 mV to 5 V
Sine(x)/x 10 mV to 1.5 V 20 mV to 3 V
Gaussian 10 mV to 1.25 V 20 mV to 2.5 V
Lorentz 10 mV to 1.2 V 20 mV to 2.4 V
Exponential Rise 10 mV to 1.25 V 20 mV to 2.5 V
Exponential Decay 10 mV to 1.25 V 20 mV to 2.5 V
Haversine 10 mV to 1.25 V 20 mV to 2.5 V
Cardiac 10 mV to 2.5 V 20 mV to 5 V
Arbitrary 10 mV to 2.5 V 20 mV to 5 V

 

Save As configuration menu (AFG menu)
Use this menu to configure saving AFG waveforms.

To access the Save As configuration menu, tap AFG on the global settings bar and tap Save Waveform.

Save As configuration menu fields and controls
The following fields and controls are available.

Field or control Description

File navigation pane Lists the location where the file will be saved. The default value is the last location to which a file was
saved. Navigate to and select the location to which to save the file.

Use the + and - buttons to navigate the file directory.

 

The - button closes the folder.

 

The + button opens a folder.

Removable media devices indicate their remaining free space in the title of the device.

The size of individual files is indicated in the Size column.

The date and time of the last modification to files and folders is displayed in the Date Modified column.

Table continued…
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Field or control Description
File Name The file name assigned to the file. The default value is either the user-entered name used to last save

this file type, or a numeric value calculated by the instrument. The default value is Tek000.

 

Tap on the file name and use a keyboard to enter a new file name. Or double-tap on the file name to
open the virtual keyboard and enter a file name.

Format Lists the available formats to which you can save files. The available save formats are set by the type
of file being saved.

 

Tap the field and select the save format.

OK, Save Waveform Saves the file to the specified location, closes the Save As configuration menu, and displays a
confirmation message.

RF configuration menu
Use the RF configuration menu to set RF channel vertical settings, trace settings, probe type, attenuation, and units for RF channel inputs.

To open an RF Channel configuration menu, double-tap the RF Channel badge.

1. If Off, tap the RF button on the Settings bar. The oscilloscope changes the RF button to an RF badge that shows the RF settings.
2. If On, double-tap the RF badge to open the RF menu.

RF Settings panel, fields and controls
 

Field or control Description
Display Toggles display of the channel On and Off.

Reference Level Sets the approximate maximum power level, as shown by the baseline indicator at the top of the
frequency graticule using the multipurpose knob, double-tap to bring up the virtual keypad, or tap the
up and down arrows to change the level.

Auto Level Directs the oscilloscope to automatically calculate and set the reference level for you.

Scale Sets the scale using the multipurpose knob or double-tap to bring up the virtual keypad to change the
scale.

Position Sets the vertical position using the virtual keypad. You will move the baseline indicator up or down.
This is useful if you want to move signals onto the visible display.

Set to 0 Sets the waveform zero level to the center of waveform view.

Label Adds a label to the channel display using the virtual keypad.

Table continued…
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Field or control Description
Units Selects the units from the drop-down list. Choices are: dBm, dBμW, dBmV, dBμV, dBmA, and dBμA.

This is useful if your application requires a different unit of measurement than that being currently
displayed.

Amplifier Mode Sets whether to use an attached TPA-N-PRE preamplifier or bypass the amplifier.

Traces Select the four different spectrum trace types that you can display.

 

See Traces panel (RF configuration menu) on page 176.

Field or control Description
Other settings panels
Probe Setup Use to see probe information, check the probe compensation status, compensate the probe, or restore

the factory defaults

.

 

See Probe Setup panel (Channel configuration menu) on page 168.

 

See Probe Compensation configuration menu (analog channels Probe Setup panel) on page 169.

 

See #unique_193.

Other Use to adjust signal delay to align signal arrival at the oscilloscope between probes and/or cables, set
external attenuation, and set alternate units.

 

See Other panel (Channel configuration menu) on page 169.

Traces panel (RF configuration menu)
Use the RF configuration menu Traces panel to select spectrum traces, detection type, detection method, number of averages, and enable
spectrogram.

To open the Traces panel:

1. If Off, tap the RF button on the Settings bar, the instrument changes the RF button to an RF badge that shows the RF settings.
2. Double-tap the RF badge to open the RF configuration menu.
3. Tap the Traces panel.

Traces panel, fields and controls
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Field or control Description
Spectrum Traces Toggles the different spectrum trace types on and off. The frequency domain window supports four

spectrum traces. You may turn each of these traces on or off independently. You can display all or
some of them simultaneously.

Normal trace: Each acquisition is discarded as new data is acquired.

Max hold trace: The maximum data values are accumulated over multiple acquisitions of the Normal
trace.

Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal
trace.

Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power
averaging, which occurs before the log conversion. Each power of 2 averaging reduces the displayed
noise by 3 dB.

Detection Method Selects the method to reduce the FFT output to the display width.

Detection Type Selects how the instrument compresses the FFT output to fit the display. The choices are: +peak,
sample, average, and -peak.

+Peak: Uses the highest amplitude point in each interval.

Sample: Uses the first point in each interval.

Average: Averages all points in each interval.

–Peak: Uses the lowest amplitude point in each interval.

Number of Averages Sets the number of averages to use when using the Average detection type. This control is only
present when Average is checked.

Spectrogram Toggles Spectrogram display on and off. The spectrogram display is useful for monitoring slowly-
changing RF phenomena. The x-axis represents frequency, just like the typical spectrum display. The
y-axis represents time. Color indicates amplitude. See Spectrogram display on page 258 for more
information.

Horizontal badge configuration menu
Use this menu to configure the acquisition and display of the RF input.

To open the spectral configuration menu:

1. If Off, tap the RF button on the Settings bar, the instrument changes the RF button to an RF badge and displays the Spectral badge.
2. Double-tap the Horizontal badge to open the configuration menu.

Horizontal badge configuration menu, fields and controls
 

Field or control Description
Center Frequency Set the center frequency using the multipurpose knob or double-tap to bring up the virtual keypad.

Table continued…
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Field or control Description
Span Selects the portion of the spectrum to view on the display. Tap to set the span using the multipurpose

knob, double-tap to bring up the virtual keypad, or tap the up and down arrows to change the span

Start Frequency Set the start frequency using the multipurpose knob or double-tap to bring up the virtual keypad.

Stop Frequency Set the stop frequency using the multipurpose knob or double-tap to bring up the virtual keypad.

RBW Mode Selects the resolution bandwidth mode, either Auto or Manual.

Span:RBW Set the Span to RBW ratio using the multipurpose knob or double-tap to bring up the virtual keypad.
This control is present when RBW Mode is set to Auto.

RBW Set the resolution bandwidth using the multipurpose knob or double-tap to bring up the virtual keypad.
This control is present when RBW Mode is set to Manual.

Window Tap and select the window from the list. The choices are:

• Rectangular (See Rectangular window on page 285.)
• Hamming (See Hamming window on page 285.)
• Hanning (See Hanning FFT window on page 284.)
• Blackman-Harris (See Blackman-Harris FFT window concepts on page 284.)

The choice of which window to use depends upon what you want to measure and your source’s signal
characteristics.

Spectral math configuration menu
The spectrum math feature lets you create a math waveform by adding or subtracting frequency traces. Spectrum Math is only available
when the instrument is acquiring in RF mode.

To turn on a spectral math, with RF on, tap the Add Math Ref Bus button and select Math.

To open the spectral math configuration menu, double-tap a spectral math badge.

Spectral math configuration menu, fields and controls
 

Field or control Description
Display Toggles the spectral math display on and off.

Label Add a label to the math trace using the virtual keypad.

Source 1 Select Source 1 from the list of valid sources.

Source2 Select Source 2 from the list of valid sources.

Operand Select a math operator from the list.
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Spectral Ref configuration menu
Use this menu to manage spectral reference waveforms and traces, including the display or removal of each reference waveform or trace
from the display.

To trun on a spectral ref, with RF on, tap the Add Math Ref Bus button and select Ref.

To open the spectral ref configuration menu, double-tap a spectral ref badge.

Spectral Ref configuration menu, fields and controls
 

Field or control Description
Display Toggles the spectral ref on and off.

Label Add a label to the reference display using the virtual keypad.

Scale Set the scale using the multipurpose knob, double-tap to bring up the virtual keypad, or tap the up and
down arrows to change the scale.

Position Set the position using the multipurpose knob, double-tap to bring up the virtual keypad.

Set to 0 Sets the position to 0.

Ref Details Readout with setup information saved with the waveform.

Cursor configuration menu
Cursors are on-screen lines (bars) that you position to take manual measurements on signals. They appear as horizontal and/or as vertical
lines.

To display cursors on the screen:

1. Tap the Cursors button in the upper right of the display, or
2. Push the Cursors front-panel button to toggle cursors on or off.

To open the Cursors configuration menu:

1. Double-tap a cursor readout or cursor line, or
2. Touch and hold a cursor readout or cursor line and select Configure Cursors from the right-click menu.

Cursor configuration menu fields and controls
Some fields or controls are only available when certain other controls are selected.

Field or control Description
Display Toggle cursor On or Off.
Bring Cursors On Screen Brings the cursors on screen. This is only available in time domain mode.
Reference To Center Brings the reference to center screen. This is only available in frequency domain mode.
Table continued…
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Field or control Description
Cursor Type Select the cursor type from the drop-down list.

 

Waveform cursors measure vertical amplitude and horizontal time parameters simultaneously at the
point the cursor crosses a waveform.

 

Screen cursors use two horizontal and two vertical bars that span the graticule to take manual
measurements.

Source Select the source waveform from the drop-down list. Default is the selected waveform.
Cursor A X-Position Set a specific x-axis position for Cursor A using the multipurpose knob, or double-tap to set the

position using the keypad.
Cursor B X-Position Set a specific x-axis position for Cursor B using the multipurpose knob, or double-tap to set the

X-Position using the keypad.
Cursor Mode Select the cursor mode. This is only available in time domain mode.

 

Independent mode sets multipurpose knobs A and B to move each cursor separately (default).

 

Linked mode sets multipurpose knob A to move both cursors at the same time. Knob B will still move
cursor B independently of knob A.

Readout Selects the readout mode, Abosolute or Delta. Delta readouts are relative to the Reference Marker.
This is only available in frequency domain mode.

Date and Time configuration menu
Use this menu to set the date, time, and UTC offset.

To open the Date and Time configuration menu, double-tap on the Date/Time badge in the lower-right corner of the oscilloscope display.

Date and Time configuration menu fields and controls
 

Field or control Description
Display Toggles display of the date and time On or Off.

 

When turned off, tap on the blank area below the Status badge, in the lower-right corner of the
oscilloscope display, to open the configuration menu and set display to On.

Year Use the multipurpose knob to set the year.
Month Select from the list.
Day Use the multipurpose knob to set the day
Hour Use the multipurpose knob to set the hour.
Table continued…
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Field or control Description
Minute Use the multipurpose knob to set the minute.
UTC Offset Use the multipurpose knob to set the offset.
Ok, Set Date & Time Applies your date and time settings.

 

Digital channel configuration menu
Use the Digital channel menu to enable individual digital channels, set their thresholds, and add labels.

To open the Digital channel configuration menu, double-tap a Digital channel badge. You can also double-tap on the digital channel
handles to open the menu.

Digital channel settings fields and controls
 

Field or control Description
Display Toggle display of the channels On and Off. You can turn the channel off and then back on and have the

same bits displayed as before.
Height Sets the relative height of the digital waveform on the screen.
D7-D0 Bit Toggles individual channels (bits) on or off and remove them from the display.
D7-D0 Threshold Sets threshold level values for the D7-D0 data channels.
D15-D8 Bit Toggles individual channels (bits) on or off and remove them from the display.
D15-D8 Threshold Sets threshold level values for the D15-D8 data channels.
Label Enter label text for individual data channels. The label is shown to the right of the corresponding digital

channel.
Turn All Off Turns off the digital channel group and becomes Turn All On.
Turn All On Turns on the digital channel group and becomes Turn All Off.

Right-click menu differences
A right click (touch and hold) on the digital channel waveform handle opens a menu to turn off that instrument channel, configure the
overall digital channel settings, or add a label to the digital channel.

A right click (touch and hold) on the handle of individual digital bits in a digital channel waveform opens a menu to turn off that digital bit,
configure the overall digital channel settings, or add a label to the individual bit.

See also
Analog channel configuration menu
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More (DRAW A BOX Menu)
Use this menu to toggle the Waveform view box draw mode between Zoom area mode and Mask segment mode.

To use the More (DRAW A BOX) menu:

1. Tap the More button (located at the top right of the Results Bar) to open the DRAW A BOX window.
2. Tap Zoom on the DRAW A BOX window to enable drawing a zoom box area on the screen. The mode stays in Zoom mode until

changed.
3. Tap Mask on the DRAW A BOX window to enable drawing Mask Testing segments on the screen. The mode stays in Mask mode until

changed.
4. Tap outside the menu. The Draw Zoom/Mask changes to reflect the function selected.

See also
Mask testing waveforms on page 92

DVM configuration menu
Use this menu to set up the optional digital voltmeter (DVM) function to use probes to measure AC, DC, or AC+DC voltages.

To open the digital voltmeter menu:

1. If the DVM is Off, tap the DVM badge on the Settings bar. This adds a DVM badge to the top of the Results Bar, using the source that
was selected the last time the DVM was added to the Results bar.

2. If the DVM is On, double-tap the DVM badge to open its configuration menu.

Note: Selecting a source in the DVM configuration menu does not automatically turn on (display) the source channel if the source
channel is not already on.

DVM configuration menu fields and controls
 

Field or control Description
Display Toggles the DVM badge On and Off.
Autorange Toggles autoranging On and Off. Autorange is not available when the oscilloscope is triggering on the

same channel that is being measured.
Source Select the channel to measure from the drop-down list. The DVM can only measure analog channels.
Mode Select DC, AC RMS, or DC+AC RMS measurement modes.
Show Basic Statistics in
Badge

Toggles showing DVM measurement statistics in the DVM badge On and Off.

Menu bar overview
The Menu bar provides access to file, utility, and help functions.

The Menu bar
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Field or control Description
File Provides typical system file management operations such as opening, saving, moving, and renaming

files.

See Recall configuration menu (File menu) on page 183.

See Save As configuration menu (File menu) on page 185.

See File Utilities configuration (File menu) on page 188.

Autoset executes an immediate Autoset operation. See Quickly display a waveform
(autoset) on page 63 .

Default Setup immediately restores the oscilloscope to factory default settings. See Using Default
Setup on page 76.

Shutdown powers off the oscilloscope.

Edit Provides a menu to Undo or Redo the last UI operation. See Undo, Redo (Edit menu) on page 191.
Utility Use to set user preferences, configure input, output, and network settings, run self tests, verify

calibration status and run signal path compensation, and erase nonvolatile memory.

See User Preferences (Utility menu) on page 191.

See I/O (Utility menu) on page 192.

See Self Test configuration menu (Utility menu) on page 195.

See Calibration configuration menu (Utility menu) on page 196.

See Security configuration menu (Utility menu) on page 197.

See Demo (Utility menu) on page 200.

Help Use to open the Help viewer and display current instrument software and option license information.

See Help (Help menu) on page 200.

See About (Help menu) on page 200.

Recall configuration menu (File menu)
Use this menu to recall (load) reference waveforms and instrument setups.

Drive name Drive letter Drive or physical USB port location
Root drive Instrument Storage User-accessible memory on the oscilloscope

Front panel E USB 2.0 (top)

F USB 2.0 (bottom)
Rear panel G USB 2.0

H USB 2.0 device port provides USBTMC support
Network location I through Z Network storage locations

To open the file Recall configuration menu:

1. Tap File on the menu bar.
2. Tap Recall to open the Recall configuration menu.
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Recall configuration menu fields and controls
 

Field or control Description

File type to open (tabs) Tabs on the left let you set which type of file to recall (Waveform or Setup).

Directory structure The Name column lists the directory structure, opening at the root (/) level. Use to quickly navigate to a
file.

 

Tap to list the contents of the directory in the Name pane.

 

Tap the + button to display the directory and any subdirectories under it. Tap the - button to close that
directory structure.

 

Drag the scroll bar up and down to show more entries.

+ and - Use the + and - buttons to navigate the file directory.

 

The - button closes the folder.

 

The + button opens a folder.

Scroll bar Use the scroll bar to access additional files and folders, when available.

Recall To: Select which reference waveform location to store the recalled waveform in. Text is included below the
buttons that indicates the last time the selected reference was modified.

OK, Recall Waveform Recalls the selected file. Button is not available if installing a setup. This button is grayed out if a valid
file is not selected in the navigation pane.

 

Recalling a waveform file adds a Reference waveform badge to the Settings bar and displays the
waveform as it fits in the current Horizontal setting.

OK, Recall Setup Recalls the selected file and immediately sets the oscilloscope to the settings in the file. Button is
not available if installing a waveform. This button is grayed out if a valid file is not selected in the
navigation pane.

Drive and USB port designations
Use the following table to determine which drive to select when navigating to and/or selecting a file on system memory or a connected
USB memory device.

Drive name Drive letter Drive or physical USB port location
Root drive Instrument Storage User-accessible memory on the oscilloscope

Table continued…
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Drive name Drive letter Drive or physical USB port location
Front panel E USB 2.0 (top)

F USB 2.0 (bottom)
Rear panel G USB 2.0

H USB 2.0 device port provides USBTMC support
Network location I through Z Network storage locations

Save As configuration menu (File menu)
Use this menu to configure saving screen captures, waveforms, and oscilloscope setup files.

To access the Save As configuration menu, tap File on the menu bar and select Save As....

Note: Selecting File > Save the first time after powering up the instrument opens the Save As configuration menu. This lets you
set or verify the save locations for all types of information you can save.

Once the Save As configuration menu has been opened and closed, the next time you select Save causes the instrument to
automatically save the file type last selected in the Save As configuration menu. This lets you quickly save files with a simple
menu selection.

Saving files with the front-panel User button
Pushing the front-panel Save button automatically saves the file type last selected in the Save As configuration menu. If no saves have
been performed since the instrument power-up, pushing the Save button opens the Save As configuration menu. Select the type of save
operation you want to perform and tap OK. After that, pushing the Save button automatically saves the file type.

Note: The Save button is not assigned a specific save type by default; it retains whatever save action was last selected in the
Save As configuration menu.

Save As configuration menu fields and controls
The following fields and controls are common to all Save As actions.

Field or control Description
File save type Tabs on the left let you set which type of file to save (Screen Capture, Waveform, Setup, or All).

Selecting a file type sets the file extensions in the Save As Type field to the correct value.

File navigation pane Lists the location where the file will be saved. The default value is the last location to which a file was
saved. Navigate to and select the location to which to save the file.

Use the + and - buttons to navigate the file directory.

The - button closes the folder.

The + button opens a folder.

Removable media devices indicate their remaining free space in the title of the device.

The size of individual files is indicated in the Size column.

The date and time of the last modification to files and folders is displayed in the Date Modified column.

The navigation window only shows files relevant to the menu it's contained in and the choices the you
make. For example, when set to recalling waveforms, the only files shown will be waveform files.

Table continued…
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Field or control Description
File Name The file name assigned to the file. The default value is either the user-entered name used to last save

this file type, or a numeric value calculated by the instrument if this file type has not previously been
saved with a custom file name. The default value is Tek000.

Tap the down arrow on the right edge of the field to display and select from a list of recently-saved file
names.

Tap on the file name and use a keyboard to enter a new file name. Or double-tap on the file name to
open the virtual keyboard and enter a file name.

Format Lists the available formats to which you can save files. The available save formats are set by the type
of file being saved.

Tap the field and select the save format.

Screen Capture tab fields and controls
The following settings are specific for saving a screen capture

Field or control Description
File save type Use the Screen Capture tab to save a screen image to a file. Selecting Screen Capture sets the file

extensions in the Save As Type field to available graphic file formats.
Format Lists the available formats to which you can save files. The available save formats are set by the type

of file being saved.

Tap the field and select the graphic save format.

Ink Saver Toggles Ink Saver mode on and off.
OK, Save Screen Capture Saves the file to the specified location, closes the Save As configuration menu, and displays a

confirmation message.

Waveform tab fields and controls
The following settings are specific for saving a waveform.

Field or control Description
File save type Use the Waveform tab to save waveform(s) to a file. Selecting Waveform sets the file extensions in

the Save As Type field to available waveform file formats.
Save As Type Lists the available formats to which you can save files. The available save formats are set by the type

of file being saved.

Tap the field and select the graphic save format.

Format Select the waveform save format.
Source Sets the waveform source to save. You can save a single waveform, or save all active (displayed)

waveforms.
Table continued…
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Field or control Description
Gating Sets the method to save a specified part of the waveform data.

None saves the full waveform data (default).

Cursors saves the waveform data located between the vertical cursors. If cursors aren't on when
selecting cursor gating, the cursors are activated.

Screen saves the waveform data that is on the screen.

Gating notes:

• Default Setup restores Gated Save to its default setting (None).
• The state of Gated Save gets saved in Setup and Session files.
• Gated saves do not work on plot waveform data.
• Gating cannot be used to save waveform data while in FastFrame mode.

OK, Save Waveform Saves the file to the specified location, closes the Save As configuration menu, and displays a
confirmation message. The active (displayed) waveforms are saved.

Setup tab fields and controls
The following settings are specific for saving an instrument setup.

Field or control Description
File save type Use the Setup tab to save the instrument setup and measurement settings to a file. Selecting Setup

sets the file extension in the Save As Type field to .set.
OK, Save Setup Saves the file to the specified location, closes the Save As configuration menu, and displays a

confirmation message.

Save All tab fields and controls
The following settings are specific for saving all file types including: screen capture, waveforms, and setup files. An external drive (USB)
must be connected to save all file types.

Note: The save all function saves each file type according to the latest save settings in the Screen Capture, Waveform, and
Setup tabs.

Field or control Description
File save type Use the All tab to save all file types. All files saved use the user-specified file name followed by

extensions that distinguish the file types. The types of files saved is determined by the configuration of
your instrument.

Save Saves the files to the specified location, closes the Save As configuration menu, and displays a
confirmation message.
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Print configuration menu
Use this menu to print a screen capture.

Print configuration menu fields and controls.
Field or control Description
Add Printer Opens the Add Printer configuration menu.
Delete Printer Deletes the selected printer.
Set as Default Sets the selected printer as the default printer.
Printer list Displays the available printers with the selected printer highlighted.
Orientation Select Landscape or Portrait print mode.
Ink Saver Toggles Ink Saver mode on and off.
Print Preview Displays what will be printed as long as you touch the button.
OK Print Prints the screen capture to the specified printer and closes the Print configuration menu.

Add Printer configuration menu
Use this menu to add a new printer or specify an email address.

Print configuration menu fields and controls.
Field or control Description
Printer Type Specify a Network printer or an E-mail.
Printer Name Use the keyboard to enter the printer name. Only available when Network is selected.
Server Name Use the keyboard to enter the server name. Only available when Network is selected.
Server IP Address Use the keypad to enter the server IP address. Only available when Network is selected.
Printer E-mail Address Use the keyboard to enter the printer email address. Only available when E-mail is selected.
SMTP Server Name Use the keyboard to enter the SMTP server name. Only available when E-mail is selected.
Server Port Use the keypad to enter the port number of the server. Only available when E-mail is selected.
Host Wanted Use the keyboard to enter the host wanted. Only available when E-mail is selected.
User Name Use the keyboard to enter your user name. Only available when E-mail is selected.
User Password Use the keyboard to enter your password. Only available when E-mail is selected.
OK, Add Printer Adds the printer to the list of available printers and closes the menu.

File Utilities configuration (File menu)
Use this menu to copy, paste, delete, and rename files, create folders, and mount and unmount memory devices.

To access the File Utilities configuration menu, select File > File Utilities from the Menu bar.
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File Utilities configuration menu fields and controls
Field or control Description

File navigation pane Shows the current directory structure. Navigate to and select the files or folder to act on.

Use the + and - buttons to navigate the file directory.

 

The - button closes the folder.

 

The + button opens a folder.

Removable media devices indicate their remaining free space in the title of the device.

The size of individual files is indicated in the Size column.

The date and time of the last modification to files and folders is displayed in the Date Modified column.

Drag the scroll bar up and down to show more entries.

Use the + and - buttons to navigate the file directory.

 

The - button closes the folder.

 

The + button opens the folder.

Copy Copies the selected file in the filename pane to memory.
Paste Pastes the file from the last Copy action in the current File Utilities session into the current location.
Delete Deletes the selected file or folder.
Rename Renames the selected file or folder.
New Folder Creates a new folder.
Mount Mount the selected drive.

 

For USB drives, Mount opens the file writing session on the attached USB device to let you write to
the device. The device is also added to the Drive column of menus that can access drives.

Unmount Unmount the selected drive. Select the drive letter and tap Unmount.

 

For USB drives, Unmount closes the file writing session on the attached USB device to let you
disconnect the device from the USB port. The device is also removed from the Drive column of menus
that can access drives.

Drive and USB port designations
Use the following table to determine which drive to select when navigating to and/or selecting a file on system memory or a connected
USB memory device.
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Drive name Drive letter Drive or physical USB port location
Root drive Instrument Storage User-accessible memory on the oscilloscope

Front panel E USB 2.0 (top)

F USB 2.0 (bottom)
Rear panel G USB 2.0

H USB 2.0 device port provides USBTMC support
Network location I through Z Network storage locations

Mount Network Drive configuration menu
Use this menu to connect to a network device, such as a PC or a file server, to save setups, waveforms, and screen images directly to the
drive or to recall waveforms or setups from the drive.

To save to or recall files from a network drive, you must first connect your oscilloscope to the network.

Note: Consult your network administrator for information related to your network.

To open the Mount Network Drive menu:

1. Select File > File Utilities from the Menu bar.
2. Tap Mount to open the Mount Network Drive menu.

Mount Network Drive configuration menu fields and controls
Field or control Description
Drive Letter Shows the current list of available (unassigned) drive letters. Tap on the list and select a drive letter to

assign to the network drive.
Specify Server Sets how you specify the server location; by server Name or IP address.
Server Name The server name associated with the remote drive. Double-tap the field and enter the server name.

This control is only present when Specify Server is set to Name.

If the remote drive is connected to a specific domain, ensure that fully qualified domain name (FQDN)
is specified under the domain name in the Utility> I/O>LAN configuration menu. The oscilloscope
restart is required after entering the domain name.

If the domain name is not specified under the Utility> I/O>LAN configuration menu, ensure that entire
server name along with fully qualified domain name is specified while mounting.

Server IP Address The IP address of the server. Tap the field and enter the network drive's IP address. This control is only
present when Specify Server is set to IP Address.

Path The path to the network drive. Double-tap the field and enter the network drive path information.
User Name If the drive you are mounting is password-protected, use this field to enter the user name associated

with the drive. Double-tap the field and enter the user name.
Password If the drive you are mounting is password-protected, use this field to enter the password associated

with the drive. Double-tap the field and enter the password.
Table continued…
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Field or control Description
Domain Sets the Domain of the intranet for the network drive. If the network drive you are mounting is

connected to a specific domain, use this field to enter the domain of the intranet associated with the
network drive.

Cancel Closes the menu without taking any action.
Enter Submits the drive access information to the network drive server. If successful, the menu is dismissed,

a confirmation message is displayed, and the drive is added to the Drive column of file menus that
access drives.

If not successful, the menu remains on screen and an error message is displayed. Use the error
message to resolve the login problem.

Undo, Redo (Edit menu)
The Edit menu lets you Undo or Redo last UI action. Tap Undo or Redo. Not all oscilloscope actions can be undone.

User Preferences (Utility menu)
Use this menu to set global display and other user preferences.

To open the User Preferences menu:

1. Tap Utility menu.
2. Tap User Preferences to open the configuration menu.

User preferences fields and controls
Field or control Description
Language Select the language from the list. English is the default.
Measurement Annotations Annotations show the exact segment of the waveform from which the measurement is derived. The

annotation types consist of horizontal bars, vertical bars, or cross-hatch marks.

Auto sets annotations to display if valid for the measurement. To view annotations for a measurement,
select that measurement badge. If annotations are valid for that measurement, they are added to the
measurement source waveform.

Off turns off display of measurement annotations.

Backlight Intensity Selects the intensity of the backlight.

Note: Performing an Autoset resets the backlight value to High.

Auto-Dim Select On to automatically dim the screen backlight after a specified time.
Time Sets the amount of time to wait before the display is dimmed. Tap in the field and use the knob to

change the time value, or double-tap to open the virtual keypad and set a time value.

Available only when Auto-Dim is On.

Right Clicks via Touch Turns On or Off the ability to use touch and hold method to open right-click menus on badges and
other screen items.

Table continued…
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Field or control Description
Time Sets the time it takes to respond to a touch and hold before opening a right-click menu.

 

Available only when Right Clicks via Touch is On.

Assign Save Button To Quick
Print

Assigns the Save button to quick print. When your printer is set up, and this button is checked,
pressing the front panel Save button will print to your printer. If a printer has not been set up, the Print
configuration menu is opened.

Displayed Colors Tap and select either Normal or Inverted colors to set how the instrument displays waveforms and
plots.

Normal shows waveforms and plots in color with a black background.

Inverted makes the waveform background white, with graticule marking in black. Use this setting to
save ink on printed screen captures.

I/O (Utility menu)
Use this configuration menu to set up a LAN, USB Device Port, Socket Server, and AUX OUT signal parameters.

To open the I/O menu:

1. Tap the Utility menu.
2. Tap I/O....

Entering and applying LAN network changes
 

When first opening the I/O menu LAN panel, the Network Address is set to Auto (default setting) and the Apply Changes button is grayed
out (inactive) in the LAN panel.

When you select any editable input box and start entering data, the Apply Changes button becomes active, and the characters being
entered are bolded and italicized. Bold italicized text means that the values have not been applied to the oscilloscope settings.

When you tap the Apply Changes button, all changes are saved (takes about 10 seconds), the text is changed to normal font (nonbold,
nonitalic), and the Apply Changes button becomes inactive.

If you tap outside the I/O menu before you tap the Apply Changes button, the menu closes and none of your changes are saved.

LAN panel fields and controls
 

Field or control Description
LAN Status A readout that indicates the status of the LAN connection, either a Green circle with the word Ok or a

Red circle with an error message.
Host Name The instrument host name is displayed. To change the name, double-tap and enter a name in the

virtual keyboard.
Network Address Select Manual or Automatic mode. The current Instrument IP Address, Gateway IP Address, Subnet

Mask, and DNS IP Address are displayed. In Manual mode the fields are editable.
Table continued…
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Field or control Description
Domain Name The instrument domain name is displayed. To change the name, double-tap and enter a name in the

virtual keyboard.
Instrument IP Address Use the multipurpose knobs to enter the address. Use the A knob to select the digit, and the B knob to

change the value.

Only available to edit when Network Address = Manual

Subnet Mask Use the multipurpose knobs to enter the mask. Use the A knob to select the digit, and the B knob to
change the value.

 

Only available to edit when Network Address = Manual

Service Name The instrument service name is displayed. To change the name, double-tap and enter a name in the
virtual keyboard.

Gateway IP Address Use the multipurpose knobs to enter the address. Use the A knob to select the digit, and the B knob to
change the value.

Only available to edit when Network Address = Manual

DNS IP Address Use the multipurpose knobs to enter the address. Use the A knob to select the digit, and the B knob to
change the value.

Only available to edit when Network Address = Manual

MAC Address A readout of the instrument MAC Address. This field is not editable.
e*Scope HTTP Port A readout of the instrument e*Scope HTTP port number. This field is not editable.
Test Connection Test the connection. If the connection test is successful, then OK is displayed. If the test is

unsuccessful, then No Response is displayed.
LAN Reset Display the LAN Reset configuration menu (Utility > I O menu) on page 195.
Apply Changes Apply changes made on this panel to the instrument.

Note: No changes are made to instrument settings until you tap the Apply Changes button.

USB Device Port fields and controls
Use the USB Device Port panel to enable or disable the USB port and set the GPIB Talk/Listen address. Use USB ports to connect a USB
memory device, keyboard, or for direct PC control of the oscilloscope using USBTMC protocol.

Field or control Description
USB Device Port Toggles the USB device port On and Off.
USBTMC Configuration Displays the USBTMC configuration information.
GPIB Talk/Listen Address Enter the address using the virtual keypad.

Socket Server panel fields or controls
Use the following socket server settings to set up and use a socket server between your oscilloscope and a remote terminal or computer.
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Field or control Description
Socket Server Toggles the socket server On or Off.
Protocol Tap to select a protocol, either None or Terminal.

A communication session run by a user at a keyboard typically uses a terminal protocol. An automated
session might handle its own communications without such protocol from the oscilloscope.

Port Enter the port number using the multipurpose knob or virtual keypad.

AUX Out panel fields and controls
Use the following settings to select the signal that is output on the rear-panel AUX Out signal connector.

Field or control Description
AUX Out Signal Select the signal type to send to the AUX Out connector.

 

Trigger sends a pulse for each trigger occurrence. The instrument will output a negative edge during a
specified trigger or other event.

Event sends a pulse for each event occurrence.

AFG sends a pulse that is synchronized to the AFG output signal.

Using Telnet to communicate with the oscilloscope
1. After you have set up the socket server parameters and set the Protocol to Terminal, the computer is ready to communicate with the

oscilloscope. If you are running an MS Windows PC, you could run its default client Telnet, which has a command interface. One way
to do this is by typing Telnet in the Run window. The Telnet window will open on the PC.

Note: On MS Windows 10, you must first install Telnet.

2. Start a terminal session between your computer and your oscilloscope by typing in an open command with the oscilloscope's LAN
address and port number.

You can obtain the LAN address by taping Utility > I/O. In the LAN panel the Instrument IP Address is displayed. You can obtain the
port # by taping Socket Server and viewing current Port number in the Port field of the menu.

For example, if the oscilloscope IP address was 123.45.67.89 and the port # was the default of 4000, you could open a session by
writing into the MS Windows Telnet screen: o 123.45.67.89 4000.

The oscilloscope will send a help screen to the computer when it has finished connecting.
3. You can now type in a standard query, such as, *idn?.

The Telnet session window will respond by displaying a character string describing your instrument.

You can type in more queries and view more results using this Telnet session window. You can find the syntax for relevant commands,
queries and related status codes in the Programmer Manual that is available at the Tektronix website.

Note: Do not use the computer’s backspace key during an MS Windows Telnet session with the oscilloscope.
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LAN Reset configuration menu (Utility > I O menu)
Use this menu to reset the Local Area Network (LAN) settings to the listed default settings.

To open the LAN Reset dialog:

1. Tap Utility in the Menu bar.
2. Tap I/O... .
3. Tap the LAN Reset button to open the LAN Reset configuration menu.
4. Tap OK to reset the LAN settings.
5. Tap Cancel to close the dialog without taking any action, and return to the I/O configuration menu.

LAN Reset default settings
 

Function Setting
Network address Automatic
DHCP Enabled
BOOTP Enabled
mDNS & DNS-SD Enabled
e* Scope Password Protection Disabled
LXI Password Protection Disabled
e* Scope and LXI Password Empty string (default)

See also
 

I/O (Utility menu) on page 192

 

Self Test configuration menu (Utility menu)
Use this menu to view power-on diagnostic results, run extended self tests, and verify the 250 kΩ termination control works on input
channels.

To open the Self Test configuration menu:

1. Tap Utility in the Menu bar.
2. Tap Self Test....

Tap anywhere outside of the menu to close the menu.

Note: Remove all input signals before running the extended self tests.
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Self Test configuration menu fields and controls
Field or control Description
250 kΩ Verification Opens a menu to verify that 250 kΩ termination can be enabled or disabled for each channel. Closing

the menu restores the normal termination setting.

Error Log Opens a menu that lets you view the instrument log file. The log file is a valuable information resource
when working with Tektronix Customer Support to troubleshoot a problem or report an issue.

Power-on Self test Results Displays the power-on self test status (Passed or Failed).

Extended Self Test Results Lists the status of each Extended self tests (Passed or Failed).

If one or more tests fail at power-on, tap on Run Self Test and see if the test or tests continue to fail. If
tests continue to fail, contact your nearest Tektronix Service Center for help with resolving the problem.

Run N Times Double tap to open the Run N Times menu and set the number of times to run the extended self tests.

Run Self Test / Abort Self Test Runs the extended self tests. While tests are running, the button changes to Abort Self Test. When
self tests are stopped, the button reverts to Run Self Test.

Note: Remove all input signals before running the extended self tests.

Tap the Abort Self Test button anytime to stop testing.

Calibration configuration menu (Utility menu)
Use this menu to perform a signal path compensation or view the factory calibration status.

To open the Calibration configuration menu:

1. Tap Utility in the Menu bar
2. Tap Calibration... .

Calibration configuration menu fields and controls
 

Field or control Description
Factory Adjustment Status This area at the top of the menu lists the instrument calibration status. Factory Adjustment Status

should be Passed.

 

If an instrument becomes uncalibrated, this displays a red Uncalibrated status. Contact your nearest
Tektronix Service Center for assistance.

SPC Status Indicates the status of the last SPC run (Pass, Failed, or Running). Also indicates how long ago the
last SPC was run.

Table continued…
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Field or control Description
Run SPC Signal path Compensation (SPC) corrects for internal DC inaccuracies caused by temperature

variations and/or long-term drift in circuits.

Note: SPC takes less than10 minutes per channel to run.

Allow the instrument to warm up for 20 minutes before running SPC.

Remove all probes, cables, and adapters from all input connectors before running SPC.

Tap Run SPC to run signal path compensation.

Security configuration menu (Utility menu)
If you have acquired confidential data, use TekSecure® to erase the oscilloscope memory before you return the oscilloscope to general
use.

To run the Security process:

Note: Save any important waveform, screen capture, instrument setup, report, and session files to external memory before
running TekSecure. All such files will be erased.

1. Tap Utility in the Menu bar.
2. Tap Security... .
3. Tap Run TekSecure to erase nonvolatile memory. It will take approximately seven minutes to erase the memory.
4. To exit the dialog without running TekSecure, tap outside of the configuration menu.
5. Push the Default Setup front panel button to load memory with the instrument factory settings.

Note: You cannot stop the TekSecure process once it is started.

Note: Do not power down the instrument while TekSecure is running.

Note: TekSecure does not erase calibration constants or instrument firmware.
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Table 15: Security configuration menu fields and controls

Field or control Description

TekSecure Erase Memory Erases nonvolatile memory. It will take approximately several;
minutes to erase the memory.

Note: You cannot stop the TekSecure process once it is
started.

Do not power down the instrument while TekSecure is
running.

Save any important waveform, screen capture, instrument
setup, report, and session files to external memory before
running TekSecure.

TekSecure does not erase calibration constants or
instrument firmware.

Advanced panel (Optional) Set password for enabling I/O ports and firmware updates.
Set Password Use the keyboard to enter a password.
Enter Password Use the keyboard to enter the password. This is only available

when a password has been set.
Change Password Use the keyboard to change the password. This control is only

present when a password has been set and entered.
I/O Ports (USB, LAN) Enable (On) or disable (Off) all USB ports (Device and Host) and

the LAN port.
Firmware Updates Enable (On) or disable (Off) the ability to update the oscilloscope

firmware.

Enter Password configuration menu (optional)
Use this function to enter the password to access optional security functions. This menu is only shown on instruments with the optional
security function installed.

To enter the password to allow changing the selected security feature state (On or Off):

1. Tap Utility in the Menu bar.
2. Tap Security.
3. Tap Advanced to open the Advanced panel.
4. If a password has not been entered and set, tap Set Password and enter the New Password. Tap the Repeat New Password field

and reenter the password. Tap Set Password to set the password and close the dialog.
5. If a password is set, tap Enter Password and enter the password.
6. Tap Enter Password to enter the password and close the dialog.

After entering the password you can do the following:

• Change your password
• Enable or disable the I/O ports
• Enable or disable firmware updates
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Enter Password configuration menu fields and controls
 

Field or control Description
Enter Password Enter the password. The valid range of characters for the password is from one to 32 characters.

Entering no characters or more than 32 characters results in an error message.

Note: If the instrument has a keyboard attached, and you have disabled the USB ports,
double-tap on the password field to open the virtual keyboard and enter the password.

Change Password Use the displayed controls to change to a new password.
I/O Ports (USB, LAN) After entering the password, tap to toggle the I/O ports on or off.
Firmware Updates After entering the password, tap to enable/disable firmware updates.

Set Password configuration menu (optional)
Use this function to set the password used to access the optional security functions. This menu is only shown on instruments with optional
security functions installed.

To access the Set Password configuration menu:

1. Tap Utility in the Menu bar.
2. Tap Security.
3. Tap Advanced to open the Advanced panel.
4. Tap Set Password.
5. In the New Password field, enter the new password.
6. In the Repeat New Password field, enter the new password.
7. Tap Set New Password to set the password and close the menu.

Set Password menu fields and controls 5

 

Field or control Description
Set Password Opens the dialog for changing the password. 6

Password Enter the new password.
Repeat Password Reenter the new password.
Set New Password After entering the new password, tap Set Password to set the password and close the dialog.
I/O Ports (USB, LAN) After entering the password, tap to toggle I/O Ports on or off.
Firmware Updates After entering the password, tap to enable/disable firmware updates..

5 If the instrument has a keyboard attached, and you have disabled the USB ports, double-tap on the password field to open the virtual keyboard and enter the
password.

6 The valid range of characters for the password is from one to 32 characters. Entering no characters or more than 32 characters results in an error message.
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Demo (Utility menu)
Use this menu to access demonstrations of key oscilloscope features.

To open the Demo configuration menu, tap Utility > Demo... in the Menu bar.

Demo menu fields and controls
 

Field or control Description
Demo overview pane The upper section of the menu shows an overview of the demonstration available in the selected

panel. This pane may also contain a screen shot showing the waveforms and capability being
demonstrated.

Demo buttons Selecting a button updates the upper half of the menu to show the relevant content (and image if
available) for the selected demonstration.

Recall Demo Session Loads the session file for the selected demonstration.
Cancel Exits the menu without making any changes.

 

Help (Help menu)
Tap Help > Help to open the Help viewer. This Help viewer is similar in operation to traditional help viewers.

About (Help menu)
Use the About configuration menu to show instrument information and installed options, and to install a license.

To open the About menu:

1. Tap Help on the menu bar.
2. Select About from the menu to open the About configuration menu.

About configuration menu fields and controls
 

Field or control Description
System information Provides system-related information such as model, bandwidth, serial number, and installed firmware

version. Provide this information when communicating with Tektronix to purchase option licenses or
communicate with Customer Support.

Probes Detected Lists probes connected to the instrument. Probes may list the probe model, serial number, and
installed probe firmware version.

Some probes may show their attenuation factor.

Note: Connecting or disconnecting probes while the About menu is open does not update the
Probes Detected list. The Probes Detected list is not dynamic.

Options Lists the options installed on the instrument.
Table continued…
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Field or control Description
Install License This button opens the Install License dialog to enter your license key.

Horizontal configuration menu
Use this menu to set horizontal parameters and enable trigger delay.

To open the Horizontal configuration menu, double-tap the Horizontal badge in the Settings bar.

Horizontal configuration menu fields and controls
 

Field or control Description
Horizontal Scale Set the Horizontal Scale using the assigned multipurpose knob, double-tap to set the scale using the

virtual keypad, or tap the up and down arrows. You can also use the front-panel Horizontal Scale knob
to change this value.

 

The horizontal scale determines the size of the acquisition window relative to the waveform. You can
scale the window to contain a single waveform edge, a single cycle, several cycles, or thousands of
cycles.

Delay Delay positions the trigger event to a specified time relative to the center of the waveform record. Use
delay to focus on events that occur before (pretrigger) or after the trigger point (posttrigger).

Position Set the trigger Position using the assigned multipurpose knob or double-tap to set the Position using
the virtual keypad.

 

When horizontal Delay is on, the time from the trigger point to the horizontal reference (center of
waveform record) is the horizontal delay. The horizontal position determines the number of pretrigger
and posttrigger samples in the waveform record.

 

When horizontal delay is off, the trigger point and the horizontal reference are at the same time in the
middle of the waveform record.

Set to 0 s Sets the delay position to 0 s (center of the waveform record).

Only available when Delay = On.

Set to 10% Sets the trigger delay to 10% of the waveform record.

 

Only available when Delay = Off.

Record Length Select the Record Length from the drop-down list.
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Mask Definition Segment configuration menu
Use the Mask Definition Segment menu to edit mask segment parameters. Double tapping a mask segment opens the Mask Definition
Segment configuration menu.

To open the Mask Definition Segment menu, double-tap on a mask segment.

To create a mask segment, see Create a Mask on page 92

Mask Settings panel fields and controls

Field or control Description
Mask Defined By Define the way you edit the mask. The default option is Segments.
X-Axis Sets the x co-ordinate of the mask vertex.
Y-Axis Sets the y co-ordinate of the mask vertex.
Insert Point Inserts a new row above the selected row and creates a new vertex on the segment shape. The new

vertex is halfway between the vertices defined in the prior row and the following row in the table.
Delete Point Deletes the currently selected point and moves all rows below it up one row. Available when the

number of points is greater than four.
Table continued…
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Field or control Description
Clear Table Deletes all but four data points from the table. The remaining data points are set to a default triangle.
Vertical Tolerance Tap the Vertical Tolerance field and enter the tolerance value as divisions of the current channel

settings. Or double-tap on the field and use the A knob to change the value.
Horizontal Tolerance Tap the Horizontal Tolerance field and enter the tolerance value as divisions of the current channel

settings. Or double-tap on the field and use the B knob to change the value.
Update Mask Now Updates the mask as per the configured tolerance values.

Save panel fields and controls

Field or control Description
Save Mask Saves the mask in the desired location with the given file name.

Right click menu functions associated with mask definition segments
The following mask definition functions are available when you right click on a mask segment.

Field or control Description
Configure Segment Opens the Mask Definition Segment configuration menu for the selected segment.
Delete Segment Deletes the selected segment.
Delete All Deletes all segments associated with the mask.

Tolerance Mask controls
Field or control Description
Configure Mask Opens the Mask Definition Segment configuration menu for the selected mask.
Delete Mask Deletes the selected mask.

Mask Test badge configuration menu
Use the Mask Test badge menu to edit the settings of a mask test and define the actions to be taken according to the results.

To open the Mask Test badge configuration menu, double-tap on the badge.

A Mask Test badge is created when the first segment of a mask is defined.
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Test Settings panel fields and controls

Field or control Description
Mask Test Turns the mask test On or Off.
Mask Display Turns the mask display On (default) or Off. Turning off the mask display turns off the mask test also.
Label The text field to add a label to the mask test badge. By default, this field is blank.
Source Lists the valid source signals for mask testing.
Show segment hits in badge A checkbox to display the hits on each segment in the badge. By default, the setting is unchecked.
Number of Waveforms The numeric field to define the number of waveforms to test against. Maximum number of waveforms

that can be tested is 1G.
Failure Threshold The numeric field to set the failure threshold in number of acquisitions.

Right click menu functions associated with the Mask Test badge
The following functions are available when you right click on a mask test badge.

Field or control Description
Configure Mask Test Opens the Mask Test badge configuration menu for the selected badge.
Delete Mask Test Deletes the selected mask test badge.

Math configuration menu overview
Math waveforms are created by combining and/or mathematically transforming source waveforms into a new waveform for analysis. Use
this menu to create math waveforms (basic or advanced) or add an FFT (Fast Fourier Transform) waveform to the screen.

To access a Math configuration menu, tap the Add Math Ref Bus badge on the Settings bar. Tap the Math button to add a Math waveform
badge. Double-tap the Math badge to open the configuration menu.

Use the following links to access information on the Math waveform menus and settings.

Math configuration menu on page 205

Equation Editor (Math configuration menu) on page 207

Menus and dialog boxes

204

www.tehencom.com          



Math configuration menu
Use this menu to set math waveform parameters, create basic and advanced math waveforms, or add an FFT (Fast Fourier
Transformation) waveform to analyze the frequency components of a waveform.

To access the Math menu, double-tap a Math waveform badge. If no Math badge is present, tap the Add Math Ref Bus button, tap Math
to add a math badge, and double-tap the Math badge to open the menu.

Math configuration menu fields and controls
 

Field or control Description
Display Turns the math waveform or FFT On or Off.
Vertical Scale Sets the vertical graticule scale units. Tap the arrows to change the value, tap and use the assigned

multipurpose knob to change values, or double-tap to open the virtual keypad to enter a specific value.
Auto Scale Toggles Auto Scale mode on or off. Auto Scale calculates the vertical scale and position to center and

display the entire waveform.
Label Enter a label for the math waveform.
Vertical Position Sets the vertical position of the math waveform.
Set to 0 Sets the vertical position of the math waveform to zero (vertical center of the screen.
Math Type Sets the type of math waveform to display.

 

Basic creates a math waveform by adding, subtracting, multiplying, or dividing two analog waveforms.

 

FFT creates an FFT math waveform of the specified signal to display the frequency components of that
signal.

 

Advanced allows you to define a more complex math expression. This mode also provides access to
the Equation Editor.

Source, Source1, Source 2 Defines the signal source or sources for a Basic or FFT math waveform.

 

Basic and FFT math waveforms are created from analog channels only (Ch, Math, or Ref).

 

Available when Math Type = Basic or FFT.

Basic math operation list Located between the Source 1 and Source 2 fields. A drop-down list to select a basic math operation
(add, subtract, multiply, or devide) to apply to the two sources.

 

Available when Math Type = Basic.

Table continued…
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Field or control Description
Math Expression Math Expression shows the current advanced math expression.

 

Tap Edit to open the Equation Editor to edit the displayed equation. You can also double-tap on an
equation in this field and directly edit the equation using the virtual keyboard. See Equation Editor
(Math configuration menu) on page 207.

 

Available when Math Type = Advanced

Edit Opens the Equation Editor to create advanced math waveforms from analog channels, reference,
measurement, and variable sources.

 

Tap the Edit button to open the Equation Editor. See Equation Editor (Math configuration
menu) on page 207.

 

Available when Math Type = Advanced

Var1, Var2 Use the arrows to change the value, tap and use the assigned multipurpose knob to change values, or
double-tap to open the virtual keypad to enter a specific value.

 

Available when Math Type = Advanced

Units Select dBV or Linear units.

Available when Math Type = FFT.

Window Select the window type from the drop-down list. The choices are: Hanning, Rectangular, Hamming, or
Blackman-Harris.

Available when Math Type = FFT.

Horizontal Scale Sets the horizontal scale units. Tap the arrows to change the value, tap and use the assigned
multipurpose knob to change values, or double-tap to open the virtual keypad to enter a specific value.

Available when Math Type = FFT.

Horizontal Position Sets the horizontal position. Tap the arrows to change the value, tap and use the assigned
multipurpose knob to change values, or double-tap to open the virtual keypad to enter a specific
value.

Available when Math Type = FFT.

Set to 0 Sets the position of the math waveform to zero (center of the screen.

Math waveform guidelines
• Digital channels and serial buses are not valid in math waveforms.
• You can take measurements on math waveforms in the same way as on channel waveforms.
• Math waveforms derive their horizontal scale and position from the sources in their math expressions. Adjusting these controls for the

source waveforms also adjusts the math waveform.
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• You can Zoom on math waveforms.

Equation Editor (Math configuration menu)
Use the Equation Editor to build your advanced math waveform expression using sources, operators, constants, measurements, and
functions.

To access the math Equation Editor:

1. Double-tap a Math waveform badge. If no Math badge is present, tap the Add Math Ref Bus button and select Math to add a Math
waveform and create a Math badge.

2. Double tap the Math badge to open the configuration menu.
3. Set Math Type to Advanced.
4. Tap Edit to open the Equation Editor.

Equation Editor menu fields and controls
 

Field or control Description
Sources Lists all available sources that you can add to an equation. Tap a source icon to add it to the cursor

position in the Math Expression box.
Functions Select the math functions to apply to your signal or signals. See Add Functions (math Equation

Editor) on page 207. Selecting the Meas button opens the Pick Measurement configuration menu.
Keypad Use to enter numeric and basic math operations.
Miscellaneous Use to enter logic conditions.
Left/Right arrows These arrows move the text input bar left/right one function at a time
Bksp Deletes the character to the left of the cursor.
Clear Erases the math equation field.
Cancel Closes the equation editor without saving changes.
OK Saves changes to the math expression and closes the Equation Editor window.

Equation editor guidelines
• Use parentheses to group terms in the expression to control execution order, for example, 5*(Ch1 + Ch2).

Add Functions (math Equation Editor)
Use the Functions controls to add predefined math operations to your equation.

 

Button Description
Intg( Integral. Inserts the text INTG( into the math expression. Enter an argument to the function. The integral function

produces the integral of the argument.

Diff( Inserts the text Diff( into the math expression.
Table continued…
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Button Description
Log( Base 10 logarithm. Inserts the text LOG( into the math expression. Enter an argument to the function. The log

function produces the base 10 logarithm of the argument.

Exp( Inserts the text Exp( into the math expression.
Sqrt( Inserts the text SQRT( into the math expression. Enter an argument to the function.

Abs( Absolute. Inserts the text ABS( into the math expression. The ABS function takes the absolute value of the
expression.

Sine( Inserts the text SIN( into the math expression.

Cosine( Inserts the text COS( into the math expression.

Tangent( Inserts the text TAN( into the math expression.

FFT( FFT Magnitude. Inserts the text Fft( into the math expression. Select one of the waveforms as an argument to the
function. This function creates an FFT waveform that shows the magnitude components of the source signal.

Rad( Radians. Inserts the text RAD( into the math expression. The function expresses the value of the expression in
Radians.

Deg( Degrees. Inserts the text DEG( into the math expression. The function expresses the value of the expression in
degrees.

Trend( Inserts the text Trend( into the math expression.
Var1( Inserts the text Var1( into the math expression.
Var2( Inserts the text Var2( into the math expression.
Meas Opens the Pick Measurement configuration menu. Selecting a measurement enters the measurement into the

math expression and closes the menu. See Pick Measurement on page 208.

Pick Measurement
Use the Pick Measurement menu to pick measurement to add to the measurement expression.

To access the Pick Measurement configuration menu:

1. From the math Equation Editor, tap Meas. The Pick Measurement configuration menu opens.
2. Select a measurement from the displayed list. Selecting a measurement adds the string to the math expression and closes the menu.

Pick Measurement menu fields and controls
 

Field or control Description
Amplitude List all available amplitude measurements that you can add to an equation.
Timing List all available timing measurements that you can add to an equation.
Other List all available other measurements that you can add to an equation.
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Reference waveform configuration menu
Use this menu to configure display settings for a reference waveform.

To open a reference waveform configuration menu, double-tap a Ref badge on the Settings bar.

Reference waveform configuration menu fields and controls
 

Field or control Description
Display Turns On or Off displaying the waveform.
Label Adds a label to the waveform. Tap and enter text using a keyboard, or double-tap to open the virtual

keyboard. The label text is the same color as the waveform.

 

Once you have entered the label, close the menu and double-tap the label text to open the Text
Settings menu to change the font color, size, and other characteristics.

Vertical Scale Set the vertical scale by using the assigned multipurpose knob, a virtual keypad, or tap the up or down
arrows.

Vertical Position Set the vertical position of the waveform using the assigned multipurpose knob or the virtual keypad.
Set to 0 Sets the vertical position to 0 (vertical center of the graticule).
Horizontal Scale Set the horizontal scale by using the assigned multipurpose knob, a virtual keypad, or tap the up or

down arrows.
Horizontal Position Set the horizontal position of the waveform using the assigned multipurpose knob or the virtual keypad.
Set to 0 Sets the horizontal position to 0 (horizontal center of the graticule).
Ref Details Readout-only text that shows the sample rate and record length values of the reference waveform.

Recall configuration menu (Ref waveform configuration menu)
Use this menu to locate and load a reference waveform file.

Prerequisite: A Ref badge must be present on the Settings bar. See Add a math, reference, or bus waveform on page 69.

To open the Recall configuration menu:

1. Double-tap a Ref badge on the Settings bar.
2. Tap Recall to open the Recall configuration menu.

Recall configuration menu (Ref configuration menu) fields and controls
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Field or control Description

Directory structure The Name column lists the directory structure, opening at the root (/) level. Use to quickly navigate to a
file.

 

Tap to list the contents of the directory in the Name pane.

 

Tap the + button to display the directory and any subdirectories under it. Tap the - button to close that
directory structure.

 

Drag the scroll bar up and down to show more entries.

+ and - Use the + and - buttons to navigate the file directory.

The - button closes the folder.

The + button opens a folder.

Scroll bar Use the scroll bar to access additional files and folders, when available.

Recall To: Select which reference waveform location to store the recalled waveform in. Text is included below the
buttons that indicates the last time the selected reference was modified.

Note: The oscilloscope can save digital waveforms to .csv files, not reference memories. The
oscilloscope cannot recall digital waveforms.

Note: The oscilloscope can save, but not recall, RF acquisitions as .TIQ files. You can
use .TIQ files with Tektronix SignalVu Vector Signal Analysis software.

OK, Recall Waveform Recalls the selected file.

Recalling a waveform file adds a Reference waveform badge to the Settings bar and displays the
waveform as it fits in the current Horizontal setting.

Search configuration menu
Use the Search configuration menu to define conditions that you want to search for on a channel or waveform signal. Each occurrence of
the search condition is marked with a triangle along the top of the display.

To open the Search menu, double-tap on the Search badge in the Results bar.

If there is no Search badge on the Results bar, tap the Search button. A Search badge is added to the Results bar, and the Search
configuration menu opens to search type of Edge (default).

See the following links for information on the search type menus.

Bus Search configuration menus on page 139

Edge Search configuration menu on page 157

Logic Search configuration menu on page 158

Pulse Width Search configuration menu on page 160

Rise/Fall Time Search configuration menu on page 161
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Runt Search configuration menu on page 162

Setup and Hold Search configuration menu on page 164

Timeout Search configuration menu on page 165

Trigger configuration menu overview
Use the Trigger menu to define the channel or waveform signal conditions on which to trigger the oscilloscope. The trigger event
establishes the time-reference point in the waveform record. All waveform record data is located in time with respect to the trigger point.

To access the Trigger menu, double-tap the Trigger badge on the Settings bar. The Trigger menu opens to show the current trigger
settings.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Bus Trigger configuration
Use the Bus trigger menus to trigger on bus-related events (Start, Stop, Missing Ack, Address, Data, and so on).

Note: You must add a bus to the Waveform view before you can trigger on it. Add a math, reference, or bus
waveform on page 69.

To open the Bus trigger menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Bus.
3. Select the bus on which to trigger in the Source field.

Use the following links to access trigger settings for specific buses.

ARINC429 serial bus trigger settings panel on page 212

Audio serial bus trigger settings panel on page 214

CAN serial bus trigger settings panel on page 215

FlexRay serial bus trigger settings panel on page 217

I2C serial bus trigger settings panel on page 219

LIN serial bus trigger settings panel on page 220

MIL-STD-1553 serial bus trigger settings panel on page 222
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Parallel serial bus trigger settings panel on page 224

RS-232 serial bus trigger settings panel on page 224

SPI serial bus trigger settings panel on page 225

USB serial bus trigger settings panel on page 226

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

ARINC429 serial bus trigger settings panel
Use the ARINC429 bus menu (optional) to set up and decode a ARINC429 avionics network serial data bus waveform

Note: Requires option SRAERO.

 

Field or control Description
Source Select the ARINC429 bus on which you want to trigger.
Trigger On Select the type of information on which to trigger.
Error Type Sets the error condition on which to trigger.

Available when Trigger On = Error.

Trigger When Sets the condition on which to trigger.

Available when Trigger On = Label.

Label Sets the label pattern on which to trigger.

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

 

Available when Trigger On = Label & Data or Trigger When = any condition except Inside Range or
Outside Range.

Table continued…
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Field or control Description
Label Low Sets the low value of the label pattern range on which to trigger.

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

Label High Sets the high value of the label pattern range on which to trigger.

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

SSM Sets to trigger when the specified Sign/Status Matrix (SSM) bit condition occurs.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Data and the Data Format is set to Data (19 bits) or SDI+Data (21
bits).

SDI Sets to trigger when the specified Source/Destination Identifier (SDI) bit condition occurs.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Data and the Data Format is set to Data (19 bits).

Trigger When Data Sets the condition on which to trigger.

Available when Trigger On = Label & Data.

Data Sets to trigger when the specified data bits condition occurs.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

Available when Trigger When = anything except Inside Range or Outside Range.

Data High Sets the high value of the data pattern range on which to trigger.

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

Data Low Sets the low value of the data pattern range on which to trigger.

Tap the Binary, Hex, or Octal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change in data or bit fields.

Use the B knob to change the value of the digit(s) in the selected field.
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Field or control Description
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Audio serial bus trigger settings panel
Use the Audio bus menu (optional) to set up and display Audio Type I2S, Left Justified (LJ), Right Justified (RJ), or TDM Audio serial bus
waveforms.

Note: Requires option SRAUDIO.

 

Field or control Description
Source Select the Audio bus on which to trigger.
Trigger On Select the type of information on which to trigger.
Word Sets the audio word channel on which to trigger (Either, Left, Right).

Available when Trigger On = Data.

Channel Sets the audio channel on which to trigger.

Available when Trigger On = Data and the Audio bus is TDM.

Trigger When Sets the trigger when condition for the specified data pattern.

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified trigger type.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Data.

Data Sets the data pattern on which to trigger. Use in conjunction with the Trigger When field to specify the
exact trigger condition.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal
virtual keypads on page 243.

Available when Trigger When ≠ Inside Range or Outside Range.
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Field or control Description
Data High Sets the data high pattern which, if exceeded, will cause a trigger.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

Data Low Sets the data low pattern which, if exceeded, will cause a trigger.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Inside Range or Outside Range.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

CAN serial bus trigger settings panel
Use the CAN bus menu (optional) to set up and display a CAN (Controller Area Network) serial bus waveform.

Note: Requires option SRAUTO.

 

Field or control Description
Source Select the CAN bus on which you want to trigger.
Trigger On Select the type of information on which to trigger.
Frame Type Sets the frame type on which to trigger.

Available when Trigger On = Type of Frame.

FD BRS Bit Sets the FD BRS or EIS bit to X, 0, or 1.

Available when Source is a CAN FD bus and Trigger On = FD BRS Bit.

FD ESI Bit Sets the FD BRS or EIS bit to X, 0, or 1.

Available when Source is a CAN FD bus and Trigger On = FD ESI Bits.
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Field or control Description
Trigger When Data Select the Trigger When Data condition from the drop down list.

Available when Trigger On = Data or Identifier & Data.

Identifier Format Sets the identifier for standard (11-bit) or extended (29-bit for CAN 2.0B) length.

Available when Trigger On = Identifier or Identifier & Data.

Data Bytes Sets the number of data bytes on which to trigger (one to eight bytes). Use the A knob to change the
value.

Available when Trigger On = Data or Identifier & Data.

Data Offset Sets the data offset in bytes to delay the trigger.

Available when Trigger On = Data or Identifier & Data.

Identifier Sets the identifier pattern on which to trigger. The number of bits shown depends on the Identifier
Format setting.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Identifier or Identifier & Data.

Data Sets the data pattern on which to trigger. The number of bits shown depends on the Data Bytes
setting.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

Available when Trigger On = Data or Identifier & Data.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

 

Use the B knob to change the value of the digit(s).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.
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FlexRay serial bus trigger settings panel
Use the Flexray bus menu (optional) to set up and display a Flexray automotive network serial bus waveform.

Note: Requires option SRAUTO.

 

Field or control Description
Source Select the FlexRay bus on which to trigger.
Trigger On Select the type of information on which to trigger: Start of Frame, Indicator Bits, Identifier, Cycle Count,

Header Fields, Data, Identifier & Data, End of Frame, or an Error.
Indicator Bits Select the indicator bits type on which to trigger: Normal (01XX), Payload (11XX), Null (00XX), Sync

(XX10), or Startup (XX11).

Available when Trigger On = Indicator Bits.

Frame Type Sets the end of frame type on which to trigger (Static, Dynamic (DTS), ALL).

Available when Trigger On = End of Frame.

Error Type Sets the error type on which to trigger: Header CRC; Trailer CRC; Null Frame, Static; Null Frame,
Dynamic; Sync Frame; or Startup Frame (No Sync).

Available when Trigger On = Error.

Trigger When Sets the trigger when condition.

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified trigger type.

Available when Trigger On = Identifier or Cycle Count.

Identifier Sets the frame identifier pattern on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Identifier, Identifier & Data, or Header and Trigger When Data is not
set to Inside Range or Outside Range.

Identifier High Sets the frame identifier high pattern which, if exceeded, will cause a trigger.

Available when Trigger On = Identifier and Trigger When Data is set to Inside Range or Outside
Range.

Identifier Low Sets the frame identifier low pattern which, if exceeded, will cause a trigger.

Available when Trigger On = Identifier and Trigger When Data is set to Inside Range or Outside
Range.

Cycle Count Sets the cycle count pattern on which to trigger. Use in conjunction with the Trigger When field to
specify the exact trigger condition.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Cycle Count or Header Fields and Trigger When Data is not set to
Inside Range or Outside Range.
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Field or control Description
Cycle Count High Sets the cycle count high limit which, if exceeded, will cause a trigger.

Available when Trigger On = Cycle Count and Trigger When Data is set to Inside Range or Outside
Range.

Cycle Count Low Sets the cycle count low limit which, if exceeded, will cause a trigger.

Available when Trigger On = Cycle Count and Trigger When Data is set to Inside Range or Outside
Range.

Indicator Bits Sets the indicator bits on which to trigger.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Header Fields .

Payload Length Select the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values.
Or double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Header Fields.

Header CRC Select the Binary or Hex field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Header Fields.

Trigger When Data Sets the trigger when data condition.

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified trigger type.

Available when Trigger On = Identifier or Identifier & Data.

Data Bytes Sets the number of data bytes on which to trigger (one to sixteen bytes). Use the A knob to change the
value. Or double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Data or Identifier & Data.

Data Offset Sets the data offset (Don't Care or the number of bytes). Tap the input box and use the A knob to
change the value.

Available when Trigger On = Data or Identifier & Data.

Data Sets the data pattern on which to trigger. The number of bits shown depends on the Data Bytes
setting. Use in conjunction with the Trigger When field to specify the exact trigger condition.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

Available when Trigger On = Data or Identifier & Data and Trigger When Data is not set to Inside
Range or Outside Range.
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Field or control Description
Data High Sets the data high pattern which, if exceeded, will cause a trigger.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Data or Identifier & Data and Trigger When Data is set to Inside
Range or Outside Range.

Data Low Sets the data low pattern which, if exceeded, will cause a trigger.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Data or Identifier & Data and Trigger When Data is set to Inside
Range or Outside Range.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

I2C serial bus trigger settings panel
Use the I2C bus menu (optional) to set up and display an I 2C (Inter-Integrated Circuit) serial bus waveform.

Note: Requires option SREMBD.

 

Field or control Description
Source Select the I2C bus on which to trigger.
Trigger On Select the type of information on which to trigger.
Direction Sets the transfer direction on which to trigger (Read, Write, Either).

Available when Trigger On = Address or Address & Data.

Addressing Mode Sets the slave device address length (7 bits or 10 bits long).

Available when Trigger On = Address or Address & Data.
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Field or control Description
Address Sets the address pattern on which to trigger. The number of bits shown depends on the Address

Mode setting.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Address or Address & Data.

Data Bytes Sets the number of data bytes on which to trigger (one to five bytes). Use the A knob to change the
value.

Available when Trigger On = Data or Address & Data.

Data Sets the data pattern on which to trigger. The number of bits shown depends on the Data Bytes
setting.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

Available when Trigger On = Data or Address & Data.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s). Or double-tap on the field and use the virtual
keypad to enter values.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

LIN serial bus trigger settings panel
Use this menu (optional) to set up and display a LIN (Local Interconnect Network) serial bus waveform.

Note: Requires option SRAUTO.

 

Field or control Description
Source Select the LIN bus on which to trigger.
Trigger On Select the type of information on which to trigger.
Table continued…
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Field or control Description
Identifier Sets the identifier pattern on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Identifier or Identifier & Data.

Trigger When Data Sets the trigger when condition.

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified trigger type.

Available when Trigger On = Data or Identifier & Data.

Data Bytes Sets the number of data bytes on which to trigger (one to eight bytes). Use the A knob to change the
value.

Available when Trigger On = Data or Identifier & Data.

Data Sets the data pattern on which to trigger. The number of bits shown depends on the Data Bytes
setting.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

Available when Trigger On = Data or Identifier & Data and Trigger When Data is not set to Inside
Range or Outside Range.

Data High Sets the data pattern high limit which, if exceeded, will cause a trigger.

Available when Trigger On = Data or Identifier & Data and Trigger When Dataa is set to Inside
Range or Outside Range.

Data Low Sets the data pattern low limit which, if exceeded, will cause a trigger.

Available when Trigger On = Data or Identifier & Data and Trigger When Dataa is set to Inside
Range or Outside Range.

Error Type Sets the LIN error type on which to trigger.

Available when Trigger On = Error.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s). Or double-tap on the field and use the virtual
keypad to enter values.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.
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Field or control Description
Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

MIL-STD-1553 serial bus trigger settings panel
Use the MIL-STD-1553 bus menu (optional) to set up and decode a MIL-STD-1553 aeronautic network serial data bus waveform.

Note: Requires option SRAERO.

 

Field or control Description
Source Select the MIL-STD-1553 bus on which you want to trigger.
Trigger On Select the type of information on which to trigger.
Error Type Sets the error condition on which to trigger.

Available when Trigger On = Error.

Parity Sets to trigger on the selected parity bit logic state.

Available when Trigger On = Command, Status, or Data.

Data Sets the data pattern on which to trigger.

Available when Trigger On = Data.

Trigger When Sets to trigger when the specified RT/IMG signal time condition occurs.

Available when Trigger On = Time (RT/IMG).

Maximum Time Sets the maximum time for a valid RT/IMG signal.

Available when Trigger On = Time (RT/IMG).

Minimum Time Sets the minimum time for a valid RT/IMG signal.

Available when Trigger On = Time (RT/IMG).

Transmit/Receive Bit Sets the transmit or receive bit on which to trigger.

 

Available when Trigger On = Command.

Trigger When RT Address Sets to trigger when the specified RT address condition occurs.

Available when Trigger On = Command or Status.

Parity Sets to trigger when the specified parity condition occurs.

Available when Trigger On = Command or Status.
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Field or control Description
Address Sets the address pattern on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When RT Address = anything but Inside Range or Outside Range.

High Address Sets the high address of the address pattern range on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When RT Address = Inside Range or Outside Range.

Low Address Sets the low value of the address pattern range on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When RT Address = Inside Range or Outside Range.

Subaddress/Mode Sets the subaddress or mode pattern on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Command.

Word Count/Mode Code Sets the word count or mode code on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Command.

Status Word Bits Sets the status word pattern on which to trigger.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values.
Selecting a bit shows a short description of that bit's function. Or double-tap on the field and use the
virtual keypad to enter values.

Available when Trigger On = Status.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change in data or bit fields.

Use the B knob to change the value of the digit(s). Or double-tap on the field and use the virtual
keypad to enter values.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.
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Parallel serial bus trigger settings panel
Use this menu to set up and display a parallel bus waveform.

Note: Parallel bus triggering is standard on all instruments.

 

Field or control Description
Source Select the type of information on which to trigger.
Data Sets the data pattern on which to trigger. The number of bits shown depends on how the parallel bus is

defined.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal virtual
keypads on page 243.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

RS-232 serial bus trigger settings panel
Use this menu (optional) to set up and display an RS232 serial bus waveform.

Note: Requires option SRCOMP.

 

Field or control Description
Source Select the RS-232 bus on which to trigger.
Trigger On Select the type of information on which to trigger.
Data Bytes Sets the number of data bytes (1 byte = 8 bits) on which to trigger (one to ten bytes). Use the A knob

to change the value.

Available when Trigger On = Rx Data or Tx Data.
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Field or control Description
Data Sets the data pattern on which to trigger. The number of bits shown depends on the Data Words

setting.

Tap the Binary, Hex, or ASCII field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal
virtual keypads on page 243.

Available when Trigger On = Rx Data or Tx Data.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

SPI serial bus trigger settings panel
Use the SPI bus menu (optional) to set up and display an SPI (Serial Peripheral Interface) synchronous serial bus waveform.

Note: Requires option SREMBD.

 

Field or control Description
Source Select the SPI bus on which you want to trigger.
Trigger On Select the type of information on which to trigger.
Data Bytes Sets the number of data bytes on which to trigger (one to sixteen bytes). Use the A knob to change the

value.

Available when Trigger On = MOSI, MISO, or MOSI & MISO.

MOSI Sets the data pattern on which to trigger. Double touch to open the editor to set the pattern.

Available when Trigger On = MOSI, or MOSI & MISO.

MISO Sets the data pattern on which to trigger. Double touch to open the editor to set the pattern.

Available when Trigger On = MISO, or MOSI & MISO.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).
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Field or control Description
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

USB serial bus trigger settings panel
Use the USB bus menu (optional) to set up and display an USB 2.0 (Universal Serial Bus) waveform.

Note: Requires option SRUSB2.

 

Field or control Description
Source Select the USB bus on which to trigger.
Trigger On Select the type of information on which to trigger: Sync, Reset, Suspend, Resume, End of Packet,

Token Packet, Data Packet, Handshake Packet, Special Packet, or Error.
Trigger When Sets the trigger when condition.

When set to Inside Range or Outside Range, fields are displayed to set a high and low boundary
pattern for the specified trigger type.

Tap the Binary or Hex field and use the A and B knobs to select and change the values. Or double-tap
on the field and use the virtual keypad to enter values.

Available when Trigger On = Handshake Packet, Data Packet, Error, Special Packet Packet, or
when Trigger On is set to Token Packet and Token Type is set to anything but SOF (0101) .

Token Type Sets the token packet type on which to trigger.

Available when Trigger On = Token Packet.

Endpoint Sets the token packet endpoint pattern on which to trigger.

Use in conjunction with the Trigger When field to specify the exact trigger condition.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger On = Token Packet and Token Type = all except SOF (0101).

Handshake Type Sets the handshake packet type on which to trigger.

Available when Trigger On = Handshake Packet.
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Field or control Description
Packet Type Sets the special packet type on which to trigger.

Available when Trigger On = Special Packet.

Error Type Sets the error type on which to trigger.

Available when Trigger On = Error.

Address Sets the token packet address pattern on which to trigger. Use in conjunction with the Trigger When
field to specify the exact trigger condition.

Tap the Binary, Hex, or Decimal field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When ≠ Inside Range or Outside Range.

Address Low, Address High Sets the boundary address conditions when testing for in-range or out of range conditions.

Available when Trigger When = Inside Range or Outside Range.

Frame Number Sets the frame number on which to trigger. Use in conjunction with the Trigger When field to specify
the exact trigger condition.

Tap the Binary, Hex, or Dec field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values.

Available when Trigger When = Token Packet and Token Type = SOF (0101).

Data Packet Type Sets the data packet type on which to trigger.

Available when Trigger On = Data Packet.

Data Bytes Sets the number of data bytes on which to trigger (one to two bytes). Tap the field and use the A knob
to change the value.

Available when Trigger On = Data Packet.

Byte Offset Sets the byte offset (Don't Care or the number of bytes). Tap the field and use the A knob to change
the value.

Available when Trigger On = Data Packet.

Data Sets the data packet pattern on which to trigger. The number of bits shown depends on the Data
Bytes setting. Use in conjunction with the Trigger When field to specify the exact trigger condition.

Tap the Binary, Hex, or ASCII field and use the A and B knobs to select and change the values. Or
double-tap on the field and use the virtual keypad to enter values. See Binary, decimal, hex, and octal
virtual keypads on page 243.

Available when Trigger On = Data Packet and Trigger When = anything but Inside Range or
Outside Range.

Data Low, Data High Sets the boundary data conditions when testing for in-range or out of range conditions.

Available when Trigger When = Inside Range or Outside Range.

A, B knob controls Use the A knob to select (highlight) the digit(s) to change.

Use the B knob to change the value of the digit(s).
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Field or control Description
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Edge Trigger configuration menu
Use the Edge Trigger menu to trigger the oscilloscope when a signal rises and/or falls through a specified level.

To open the Edge trigger menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Edge.

Settings panel (Edge Trigger configuration menu) fields and controls
 

Field or control Description
Trigger Type Set to Edge.
Source Lists the source channel or waveform to use to trigger.

 

Coupling Set the conditioning to apply to the source signal trigger circuit from the source signal.

 

DC coupling passes all input signals directly to the trigger circuitry.

 

AC coupling blocks the DC component and shows only the AC signal.

 

HF Reject coupling attenuates signals above 50 kHz before passing the signal to the trigger circuitry.

 

LF Reject coupling attenuates signals below 50 kHz before passing the signal to the trigger circuitry.

 

Noise Reject coupling provides stable triggering by increasing the trigger hysteresis. Increased
hysteresis reduces the trigger sensitivity to noise so may require greater signal amplitude.

Level Sets the amplitude level that the signal must pass through to be considered a valid transition.
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Field or control Description
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Slope Sets the signal transition direction to detect. (rising, falling, or either direction).
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Logic Trigger configuration menu
Use the Logic trigger to trigger the oscilloscope when the specified logic conditions occur on any combination of analog and digital inputs.
The logic conditions include the state of each input, the condition to test (inputs go true, false, or are within a time limit), and the Boolean
function of the inputs.

To open the Logic Trigger menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Logic.

Settings panel (Logic Trigger configuration menu) - fields and controls
 

Field or control Description
Use Clock Edge? Enables or disables finding logic patterns that occur on the specified clock edge.
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Field or control Description
Logic Pattern Define Inputs Opens the Logic Trigger - Define Inputs menu where you define the logic state (High, Low, or Don't

Care), and the signal threshold level that defines the logic state (high or low), for each analog or digital
signal. See Logic Trigger - Define Inputs configuration menu on page 231.

Trigger When

(Use Clock Edge = No)

Defines the waveform condition on which to trigger.

• Goes True: All conditions change to a true state.
• Goes False: All conditions change to a false state.
• Is True > Limit: Condition remains true longer than a specified time.
• Is True < Limit: Condition remains true for less than a specified time.
• Is True = Limit: Condition remains true for a specified time (within ± 5%).
• Is True ≠ Limit: Condition does not remain true for a specified time (within ± 5%).

Clock Source

(Use Clock Edge = Yes)

Sets the signal to use as the clock. The clock signal can be a digital or analog waveform

Clock Edge

(Use Clock Edge = Yes)

Sets the signal transition edge (rising, falling, or either) for evaluating the logic condition at the clock
transition.

Clock Threshold

(Use Clock Edge = Yes)

Sets the threshold level that the clock signal must pass through to be considered a valid transition. The
clock threshold value is independent of the input signal threshold(s).

Define Logic Sets the logic condition that must occur with all inputs.

• AND: All conditions are true.
• OR: Any condition is true.
• NAND: One or more conditions are true.
• NOR: No conditions are true.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
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• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Logic Trigger - Define Inputs configuration menu
Use this menu to set the signal sources, logic states, and threshold levels to use for the Logic trigger.

To open the Logic Trigger - Define Inputs configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set Trigger Type to Logic.
3. Tap the Logic Pattern Define Inputs button.

Logic Trigger - Define Inputs configuration menu fields and controls
 

Field or control Description
Chx (analog channels) or Dx
(digital channels)

Use to select the signal source's logic condition on which to perform the logic trigger (High, Low,
Don't Care). Tap to select.

 

If a channel is a digital channel, tap the + symbol to open the list of digital inputs (D0-D7) from which to
select individual logic conditions for the digital signals.

 

Use the Threshold field to set the signal level that must be exceeded for that signal to be true (logical
1).

Set All Sets all signal sources to detect a logic High, Low, or Don't Care condition.

 

Pulse Width Trigger configuration menu
Use the Pulse Width Trigger to trigger on specific pulse width conditions, including when a pulse width is within or outside a range of
specified times. Pulse Width triggers are often used to troubleshoot digital signals.

To open the Pulse Width trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Pulse Width.

Settings panel (Pulse Width Trigger configuration menu) fields and controls
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Field or control Description
Source Lists the source channel or waveform to use to trigger.

Trigger When • < Limit: A pulse width is less than the specified time limit.
• > Limit: A pulse width is greater than the specified time limit.
• = Limit: A pulse width is equal to the specified time limit.
• ≠ Limit: A pulse width does not equal (is greater than or less than) the specified time limit.
• Inside Range: A pulse width is in the specified time range.
• Outside Range: A pulse width is outside of the specified time range.

Level Sets the amplitude level that the signal must pass through to be considered a valid transition.
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Time Limit

(Trigger When ≠ Inside Range or
Outside Range)

Sets the time period condition to be met.

High Time Limit

(Trigger When = Inside Range or
Outside Range)

Sets the longest acceptable pulse width time period for the range condition.

Low Time Limit

(Trigger When = Inside Range or
Outside Range)

Sets the shortest acceptable pulse width time period for the range condition.

Polarity Sets the polarity of the pulse to detect (positive pulse only, negative pulse only).

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
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• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Rise Fall Time Trigger configuration menu
Use the Rise/Fall Time trigger to trigger when the rise or fall time of a signal is less than, greater than, equal to, or not equal to a specified
time limit.

To open the Rise/Fall Time trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Rise/Fall Time.

Settings panel (Rise/Fall Time Trigger configuration menu) fields and controls
 

Field or control Description
Source Lists the source channel or waveform to use to trigger.

Trigger When • < Limit: A signal has a rise/fall time less than the specified time limit.
• > Limit: A signal has a rise/fall time greater than the specified time limit.
• = Limit: A signal has a rise/fall time that is equal to the specified time limit (±5%).
• ≠ Limit: A signal has a rise/fall time that does not equal (is greater than or less than) the specified

time limit (±5%).

Time Limit Sets the time period condition to be met.
Slope Sets the signal transition direction to detect. (rising, falling, or either direction).
Upper Threshold Sets the upper amplitude level through which the signal must pass to be considered a valid transition.

Lower Threshold Sets the lower amplitude level through which the signal must pass to be considered a valid transition.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu

Menus and dialog boxes

3 Series Mixed Domain Oscilloscope Help 233

www.tehencom.com          



• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Runt Trigger configuration menu
Use the Runt trigger to trigger on waveforms where a low amplitude pulse crosses one threshold but fails to cross a second threshold
before recrossing the first.

To open the Runt trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Runt.

Settings panel (Runt Trigger configuration menu) fields and controls
 

Field or control Description
Source Lists the source channel or waveform to use to trigger.

Trigger When • Occurs: A runt signal event occurs.
• < Limit: A runt signal event occurs that has a pulse width less than the specified time limit.
• > Limit: A runt signal event occurs that has a pulse width greater than the specified time limit.
• = Limit: A runt signal event occurs that has a pulse width that is equal to the specified time limit

(±5%).
• ≠ Limit: A runt signal event occurs that has a pulse width that does not equal (is greater than or

less than) the specified time limit (±5%).

Polarity Sets the polarity of the pulse to detect (positive pulse only, negative pulse only, or a positive or
negative pulse).

Time Limit Sets the time period condition to be met.
Upper Threshold Sets the upper amplitude level through which the signal must pass to be considered a valid transition.

Lower Threshold Sets the lower amplitude level through which the signal must pass to be considered a valid transition.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.
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Field or control Description
Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Sequence Trigger configuration menu
Use Sequence trigger to trigger on a second (B) event after a first (A) event occurs. You can trigger on the first occurrence of event B (with
or without a time delay), or trigger after a specified number of B events occur.

To open the Sequence trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Sequence.

Note: You can select sequence triggering when you choose the slope type Falling or Rising — but not when you pick the slope
type Both.

Settings panel (Sequence Trigger configuration menu) fields and controls
 

Field or control Description
Coupling Sets the trigger coupling.

Edge and Sequence triggering can use all available coupling types: DC, AC, Low Frequency Rejection,
High Frequency Rejection, and Noise Rejection. All other trigger types use DC coupling only.

A Source Selects the source of the first (A) event trigger.

If the A event does not occur, no trigger event is generated.

B Source Selects the source of the second (B) event trigger.

If the A event occurs but the B event does not occur, no trigger event is generated.

A Level Sets the A trigger level.
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Field or control Description
B Level Sets the B trigger level.
Set to 50% Sets the trigger level to 50% of the applied signal.
After the A Trigger Event is
found: Trigger on the 1st B
event

Sets the oscilloscope to trigger on the first occurrence of the B event trigger conditions.

After a Delay of: Sets a time delay condition for the Trigger on 1st B event condition. The oscilloscope waits the
specified time period after the A event before detecting and triggering on the B event condition.

Available when After the A Trigger Event is found = Trigger on the 1st B event.

After the A Trigger Event is
found: Trigger on the Nth B
event

Sets the B trigger event to wait for a specified number of trigger events before generating a trigger.

Where N is: Sets the number of B trigger events that must occur before triggering the oscilloscope.

Available when After the A Trigger Event is found = Trigger on the Nth B event.

Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Setup & Hold Trigger configuration menu
Use the Setup & Hold trigger to trigger on a waveform when a data signal changes state inside of a specified setup and hold time, relative
to a clock edge.

To open the Setup & Hold trigger configuration menu:
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1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Setup & Hold.

Settings panel (Setup & Hold Trigger configuration menu) fields and controls
 

Field or control Description
Clock Source Sets the signal to use as the clock. The clock source can be an analog, digital, math, or reference

waveform.
Clock Threshold Sets the threshold level that the clock signal must pass through to be considered a valid transition. The

clock threshold value is independent of the input signal threshold(s).
Clock Edge Sets the polarity of the clock edge (rising or falling) for evalluating the other menu conditions.

Data Sources: Define Inputs Opens the Setup & Hold Trigger - Define Inputs menu. Use this menu to select the input signals and
their thresholds. See Setup & Hold Trigger - Define Inputs configuration menu on page 238.

Setup Time Sets the length of time that data signal should be stable and not change before a clock edge occurs.
Hold Time Sets the length of time that data signal should be stable and not change after a clock edge occurs.
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu
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Setup & Hold Trigger - Define Inputs configuration menu
Use this menu to set the input signals and their threshold levels for the Setup & Hold trigger.

To open the Setup & Hold Trigger - Define Inputs menu:

1. Double-tap the Trigger Badge.
2. Set the Trigger Type to Setup & Hold.
3. Tap the Data Sources Define Inputs button.

Setup & Hold Trigger - Define Inputs configuration menu fields and controls
 

Field or control Description
Chx (analog channels) or Dx
(digital channels)

Use to select the signal sources to test for the setup and hold condition. Tap to select an input source.

 

If a channel is a digital channel, tap the + symbol to open the list of digital inputs (D0-D7) or (D8-D15)
from which to select individual digital signals.

 

Use the Threshold field to set the signal level that must be exceeded for that signal to be true.

Set All Sets all signal sources to be included or not included.

Timeout Trigger configuration menu
Use the Timeout Trigger to trigger on a waveform when an expected signal does not transition within a specified period of time, such as
when a signal gets stuck either high or low.

To open the Timeout trigger menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Timeout.

Settings panel (Timeout Trigger configuration menu) fields and controls
 

Field or control Description
Source Lists the source channel or waveform to use to trigger.

Trigger When • Stays High: The signal stays above the specified threshold level longer than the specified time.
• Stays Low: The signal stays below the specified threshold level longer than the specified time.
• Either: The signal stays above or below the specified threshold level longer than the specified

time.

Threshold Sets the amplitude level that the signal must pass through to be considered a valid transition.
Set to 50% Sets the threshold at 50% of the measured signal transition range. 50% is calculated as (Top +

Bottom)/2.
Time Limit Sets the time period condition to be met.
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Field or control Description
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Video trigger configuration menu
Use the Video Trigger menu to trigger the oscilloscope on video signals.

Trigger on specified fields or lines of a composite video signal. Only composite signal formats are supported. Trigger on NTSC, PAL, or
SECAM signals. Triggering also works with Macrovision signals.

Trigger on a variety of HDTV video standard signals, as well as custom (non-standard) bilevel and trilevel video signals with 3 to 4,000
lines.

To open the Video trigger menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Set the Trigger Type to Video.

Settings panel (Video Trigger configuration menu) fields and controls
 

Field or control Description
Trigger Type Set to Video.
Source Lists the source channel or waveform to use to trigger.
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Field or control Description
Format Set the video format from the drop-down list.
Trigger On Set to trigger on lines or fields from the drop-down list.
Line Number Set the line number to trigger on. This control is only available when Trigger On is set to Line Number.
Polarity Sets the video polarity. (Normal or Inverted).
Scan Method Set the scan method to Progressive or Interlaced.
Line Period Set the line period when the format is set to Bilevel Custom or Trilevel Custom.
Sync Interval Set the sync interval when the format is set to Bilevel Custom or Trilevel Custom.
Mode & Holdoff Trigger Mode determines how the instrument behaves in the absence or presence of a trigger event.

Holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and
triggering on the next trigger event.

For additional information on Trigger Mode, Holdoff, forcing a trigger, and the Trigger Frequency
Counter see Mode and Holdoff panel on page 240.

Act On Trigger Set the actions the instrument takes when a trigger event occurs.

For additional information on the Act On Trigger panel see Act On Trigger configuration
menu on page 241.

Trigger types
Use the following links to see more information on specific trigger types.

• Edge Trigger menu
• Pulse Width Trigger menu
• Timeout Trigger menu
• Runt Trigger menu
• Logic Trigger menu
• Setup & Hold Trigger menu
• Rise/Fall Time Trigger menu
• Video Trigger menu
• Bus Trigger menu
• Sequence Trigger menu

Mode and Holdoff panel
Use the mode and holdoff panel controls to stabilize triggering.

To open the Pulse Width trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Tap Mode & Holdoff to open the Mode & Holdoff panel.

Mode & Holdoff panel fields and controls

Menus and dialog boxes

240

www.tehencom.com          



Field or control Description
Trigger Mode The trigger mode determines how the instrument behaves in the absence or presence of a trigger

event:

Auto trigger mode enables the instrument to acquire and display a waveform even if a trigger does not
occur. Auto mode uses a timer that starts when the acquisition is started, and the pretrigger information
is obtained. If a trigger event is not detected before the timer times out, the instrument forces a trigger.
The length of time it waits for a trigger event depends on the time base setting.

When forcing triggers in the absence of valid triggering events, Auto mode does not synchronize the
waveform on the display. The waveform will appear to jump across the screen.

If valid triggers occur, the display will become stable.

Normal trigger mode enables the instrument to acquire a waveform only when it is triggered. If no
trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists, no
waveform is displayed.

Force Trigger Forces a trigger event regardless of whether the waveform meets any trigger conditions.
Holdoff Trigger holdoff sets the amount of time the oscilloscope waits after a trigger event before detecting and

triggering on the next trigger event. Use this option when the signal that you want to trigger on has
several possible trigger points or is a burst signal. This control is only available when the trigger type is
not video.

Holdoff (Time) Use the multipurpose knob to adjust the holdoff time value. Or double-tap the field and use the virtual
keypad to enter a time holdoff period. This control is only available when the trigger type is video.

Holdoff (Fields) Use the multipurpose knob to adjust the holdoff fields value. Or double-tap the field and use the virtual
keypad to enter a fields holdoff value. This control is only available when the trigger type is video.

Trigger Frequency Counter Turn On to display the trigger event frequency in the Trigger badge.

The trigger frequency can help you troubleshoot signal problems where the frequency of the trigger
event may be related to a clock, switching power supply, or other recurrent frequency that occurs on
your DUT.

Only available if you have installed the DVM option, which is available when you register your
instrument with Tektronix.

Act On Trigger configuration menu
Use this configuration menu to set the actions the instrument takes when a trigger event occurs.

To open the Act On Trigger configuration menu:

1. Double-tap the Trigger badge on the Settings bar.
2. Tap Act On Trigger to open the Act On Trigger panel.

Act On Trigger menu fields and controls
Displayed fields and controls can change depending on menu selections.
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Field or control Description
Act on Trigger on/off switch Allows you to configure AOE before enabling. If the maximum number of saves is hit, this control turns

off.

Save Image Saves the screen image at the time of the event, to the format designated in the Save Configuration
panel.

Save Waveform Saves the waveform data at the time of the event, to the format designated in the Save Configuration
panel.

Stop Acquisitions Stops the instrument from acquiring any more data.

SRQ Generates a service request (SRQ) when a specified event occurs.

AUX OUT Pulse Sends a pulse to the Auxiliary Out port when a specified event occurs.

Actions guidelines
• All actions are taken on a per acquisition basis.

Viewing the trigger frequency
You can display a readout of trigger frequency.

The Trigger Frequency Counter counts all Edge trigger triggerable events, whether the instrument triggered on them or not, and displays
the number of times per second that they occur. To display this readout, do the following:

1. Double-tap the Trigger badge to display the trigger menu.
2. Tap Mode & Holdoff to display the Mode & Holdoff panel.
3. Tap Trigger Frequency Counter to toggle it on.
4. Tap an empty location on the display to close the Trigger menu.

The trigger frequency now appears in the Trigger badge.

Virtual Keyboard
Use the onscreen virtual keyboard to enter textual information such as a file path, file name, or label text.

To access the virtual keyboard, double-tap in a menu or dialog text input box. Enter your text and tap Enter to close the keyboard and add
your text to the menu or dialog field.

Tap ESC, Cancel, or anywhere outside the keyboard, to dismiss it without adding text to the input box.

Single-tap in the keyboard text field to position the insertion cursor at that location. Double-tap to select individual words. Triple-tap to
select all text in the field.

Touch and drag the title bar to move the keyboard on the screen.
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Binary, decimal, hex, and octal virtual keypads
Use the logic keypad to edit bus logic values for trigger settings. Using a logic keypad is faster to set larger logic trigger values than using
the multipurpose knobs in the trigger menu.

To open the logic keypad, double-tap inside a field that requires logic values. Which field you select (Binary, Hex, and so on) sets which
logic keypad is displayed.

Logic Keypad fields and controls
 

Field or control Description
Clear Sets all digits to X (don't care) for binary, hex, and octal formats. Decimal gets set to 0.
< Moves the insertion point left and highlights the character that can be edited.
> Moves the insertion point right and highlights the character that can be edited.
Keypad Provides a keypad associated with the logic entry field that was double-tapped in the Trigger menu.

Tapping a key sets the selected digit to the specified value and moves the selected digit indicator to the
next (right) digit.

 

You can also use an attached keyboard to enter values in the keypad character field.

Numeric input keypad
Use the virtual Keypad to enter numeric values and units for settings.

To open the virtual keypad, double-tap inside a field that requires numeric values.

Virtual Keypad fields and controls
 

Field or control Description
Clear Clears all values from the input entry field.
Exp Lets you enter exponential notation entries.
Max Enters the maximum value allowed for this setting.
Min Enters the minimum value allowed for this setting.
Bksp ← Deletes characters to the left of the insertion point.
Enter Closes the number pad and assigns the entered value to the field.
± Sets a numeric value to a positive (default) or negative value.
Unit buttons Use to set the units of the entered value.
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IP address keypad
Use the virtual Logic keypad to edit bus logic values for trigger settings. Using a logic keypad is faster to set larger logic trigger values than
using the multipurpose knobs in the trigger menu.

To open the IP address keypad, double-tap inside IP address field.

IP address Keypad fields and controls
 

Field or control Description
Clear Clears all values from the input entry field.
< Moves the insertion point left and highlights the character that can be edited.
> Moves the insertion point right and highlights the character that can be edited.
Enter Closes the keypad and assigns the entered value to the field.
Cancel Closes the keypad without saving entered values.

Waveform View configuration menu
Use this menu to configure the Waveform View to set style, persistence, intensity, markers, spectrogram, and other parameters.

To open the Waveform View menu, double-tap anywhere in the Waveform View screen.

Time Domain Waveform View menu fields and controls
 

Fields or controls Description
Persistence Sets the length of time data points are displayed on screen before being erased.

 

Off sets the record points to appear for the current acquisition only.

 

Infinite continuously accumulates record points on the waveform until you change one of the
acquisition display settings or clear the acquisition memory. Use infinite persistence for displaying
record points that may occur outside the normal acquisition envelope.

 

Variable lets you specify a time length to retain data points on screen. Each record point decays
independently according to the time interval.

 

Auto sets the Waveform Intensity field to control the persistence time.

Variable Persistence Time

(Persistence = Variable)

Sets the length of time data points remain displayed. Tap the field and use the A knob to adjust, or
double-tap and use the keypad to set a time.

Table continued…
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Fields or controls Description
Waveform Style Sets how waveforms are drawn on the screen.

 

Vectors draws waveforms with lines between record points.

 

Dots draws waveform record points as dots on the screen, and adds crosshair markers to real
sampled points.

Graticule Style Sets the type of graticule to display.

 

Full displays a frame, cross hairs, and a grid on the display. This style is useful for making quick,
full-screen measurements with cursors and automatic readouts when cross hairs are not needed.

 

Grid, Solid, and Cross Hair provide compromises between Frame and Full.

 

Frame provides a clean screen on which you can most easily read automatic measurement results
and other screen text.

Waveform Intensity Sets the brightness of waveforms. Tap the field and use the A knob to set the intensity.
Graticule Intensity Sets the brightness of the graticule. Tap the field and use the A knob to set the graticule intensity.
Screen Annotation Use the keyboard to add text to the display.

 

Frequency Domain (RF) Waveform View menu fields and controls
 

Fields or controls Description
Peak Markers Enables (On) or disables (Off) showing triangular marks on spectrum waveform peaks. Default is On.

The highest peak on the currently selected trace is the reference marker.

Peak marker symbols (triangle at top of view) are colored red for the reference marker and white
otherwise

Readout Sets the marker readouts to show Absolute or Delta values. The default value is Absolute.

Delta readouts are relative to the Reference Marker.

Quantity Sets the maximum number of highest peak markers to show on traces in the Waveform View window.
The default value is 5.

If there are fewer peaks in the Waveform View window than this control is set for, only the displayed
peaks will be marked.

Threshold Sets the minimum amplitude that a signal must exceed to be a valid peak.

Table continued…
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Fields or controls Description
Excursion Sets how far a signal needs to fall in amplitude between marked peaks to be another valid peak.

Reference To Center Moves the reference marker to the center of the display.
Spectrogram Toggles the spectrogram traces on or off. The spectrogram display is useful for monitoring slowly-

changing RF phenomena. The x-axis represents frequency, just like the typical spectrum display. The
y-axis represents time. Color indicates amplitude.

Spectrogram slices are generated by taking each spectrum and flipping it on its edge so that it is one
pixel row tall, and then assigning colors to each pixel based on the amplitude at that frequency with
the cold colors of blue and green representing low amplitude, and the hotter colors of yellow and red
indicating higher amplitude. Each new acquisition adds another slice at the bottom of the spectrogram,
and the history moves up one row. See Spectrogram display on page 258 for more information.

Graticule Style Sets the type of graticule to display.

 

Full displays a frame, cross hairs, and a grid on the display. This style is useful for making quick,
full-screen measurements with cursors and automatic readouts when cross hairs are not needed.

 

Grid, Solid, and Cross Hair provide compromises between Frame and Full.

 

Frame provides a clean screen on which you can most easily read automatic measurement results
and other screen text.

Graticule Intensity Sets the brightness of the graticule. Tap the field and use the A knob to set the graticule intensity.
Screen Annotation Double-tap the field and use the keyboard to add text to the display.
Selected Trace Makes the Normal, Average, Max Hold, or Min Hold trace the selected trace.

Cursors menu (RF view)
Use the RF view cursors to take manual measurements on spectrum signals.

To open the RF view cursors menu, double-tap on a cursor or its readout in the Waveform View window.

Cursors menu (RF view), fields and controls

Field or control Description

Display Toggles the spectrum cursor display On or Off.

Reference To Center Moves the reference cursor to the center of the display.

Cursor A X-Position Sets a specific x-axis position for Cursor A using the multipurpose knob or the virtual keypad.

Cursor B X-Position Sets a specific x-axis position for Cursor B using the multipurpose knob or the virtual keypad.

Table continued…
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Field or control Description

Readout Sets the cursor readouts to show Absolute or Delta values.

Delta readouts are relative to the Reference Marker.

RF badge menu
Use the RF badge menu to set spectrum parameters including reference level, amplifier mode, spectrum traces, detection method, and
spectrogram.

To open the RF badge menu, double-tap the badge.

RF badge menu, fields and controls

Field or control Description

Display Enables (On) or disables (Off) showing RF traces.

Reference Level Sets the reference level using the multipurpose knob, double-tap to bring up the virtual keypad, or tap
the up and down arrows to change the level

Scale Sets the vertical scale using the multipurpose knob, double-tap to bring up the virtual keypad, or tap
the up and down arrows to change the scale.

Position Set the vertical position using the virtual keypad.

Label Enter a label using the keyboard.

Units Sets the measurement unit to use in the vertical scale in the RF waveform view.

Amplifier Mode When a TPA-N-PRE (preamplifier) is attached to the RF input, tap to toggle between Auto and Bypass
mode. The readout indicates preamplifier mode.

Spectrum Traces Add or remove Normal, Average, Max Hold, or Min Hold traces to the display.

• Normal sets the spectrum trace to show the first sample point data in each sample interval.
• Average sets the spectrum trace to show the average of the normal points in each sample interval

over several acquisitions.
• Max Hold sets the spectrum trace to show the highest amplitude points in each sample interval

over several acquisitions.
• Min Hold sets the spectrum trace to show the lowest amplitude points in each sample interval over

several acquisitions.

Sets the trace mode to show all available sample point data in the spectrum trace.

Detection Type Displays the detection type, or, if the detection method is set to Manual, allows you to select the
detection type: +Peak, Average, Sample, or -Peak.

Table continued…

Menus and dialog boxes

3 Series Mixed Domain Oscilloscope Help 247

www.tehencom.com          



Field or control Description

Detection Method Select the detection method:

• Auto allows the instrument to select the detection type.
• Manual allows you to select the detection type: +Peak, Average, Sample, or -Peak.

Number of Averages When the Average spectrum trace is selected, sets the spectrum trace to show the average of the
normal points in each sample interval over several acquisitions.

Spectrogram Toggles the spectrogram traces on or off. The spectrogram display is useful for monitoring slowly-
changing RF phenomena. The x-axis represents frequency, just like the typical spectrum display. The
y-axis represents time. Color indicates amplitude.

Spectrogram slices are generated by taking each spectrum and flipping it on its edge so that it is one
pixel row tall, and then assigning colors to each pixel based on the amplitude at that frequency with
the cold colors of blue and green representing low amplitude, and the hotter colors of yellow and red
indicating higher amplitude. Each new acquisition adds another slice at the bottom of the spectrogram,
and the history moves up one row.
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Waveform acquisition concepts

Acquisition concepts
The Acquisition system sets which data points are used to acquire waveforms.

Acquisition hardware
Before a signal is displayed, it must pass through the input channel where it is scaled and digitized. Each channel has a dedicated input
amplifier and digitizer. Each channel produces a stream of digital data from which the instrument extracts waveform records.

Sampling process
Acquisition is the process of sampling an analog signal, converting it into digital data, and assembling it into a waveform record, which is
then stored in acquisition memory. 

Waveform record
The instrument builds the waveform record through use of the following parameters:

• Sample interval: The time between sample points.
• Record length: The number of samples required to fill a waveform record.
• Trigger point: The zero time reference in a waveform record.
• Horizontal position: When horizontal delay is off, the horizontal position is a percentage of the waveform record between 0 and 99.9

percent. The trigger point and the horizontal reference are at the same time in the waveform record. For example, if the horizontal
position is 50 percent, then the trigger point is in the middle of the waveform record. When horizontal delay is on, the time from the
trigger point to the horizontal reference is the horizontal delay.
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Acquisition modes
Acquisition is the process of sampling an analog signal, converting it into digital data, and assembling it into a waveform record, which
is then stored in acquisition memory. The acquisition mode determines how the waveform record points are calculated from the sampled
waveform data.

How the acquisition modes work
Acquisition mode

Sample mode retains the first sampled point
from each acquisition interval. Sample is the
default mode. The instrument does no post
processing of the acquired samples in this
mode.

Peak Detect mode retains the highest and
lowest values of all the samples in two
consecutive acquisition intervals. This mode
only works with real-time, noninterpolated
sampling and is useful for catching high
frequency glitches.

High Res mode calculates the average
of all the samples for each acquisition
interval. This mode also only works
with real-time, noninterpolated sampling.
Hi-Res provides a higher-resolution, lower-
bandwidth waveform.

Envelope mode finds the highest and
lowest record points over many acquisitions.
Envelope uses Peak Detect for each
individual acquisition.

Average mode calculates the average
value for each record point over a user-
specified number of acquisitions. Average
uses Sample mode for each individual
acquisition. Use Average mode to reduce
random noise.

FastAcq™ mode is helpful in finding elusive
signal anomalies. Fast acquisition mode
reduces the dead time between waveform
acquisitions, enabling the capture and
display of transient events such as glitches
and runt pulses. Fast acquisition mode
can also display waveform phenomena
at an intensity that reflects their rate of
occurrence.
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Roll Mode provides an instant display response when the oscilloscope is operating at very slow sweep speeds. Without it, the acquisition
must complete before the display will update.

Roll Mode is not available in the Acquisition Mode drop-down menu. It is automatically enabled at Horizontal Scale factors of 40 ms/div and
slower when running in Auto Trigger mode or in Single / Seq acquisition mode. The record length is limited to 1 M points when rolling.

Roll Mode is disabled when running in Normal Trigger mode. This can be selected with the front panel Trigger Mode button or the Trigger
Mode control on the MODE & HOLDOFF panel of the Trigger configuration menu.

Note: If Roll Mode is enabled, Average and Envelope will not be available in the Acquisition Mode drop-down list.

Coupling
Coupling determines whether an input signal is directly connected to the input channel (DC coupling) or connected through a DC blocking
capacitor (AC coupling).

All instruments and probes specify a maximum signal level. Do not exceed the limit, even momentarily, as the input channel or probe may
be damaged. Use external attenuators if necessary to prevent exceeding the limits.

The input resistance of each input channel can be 1 MΩ or 50 Ω. To properly terminate signals when using coaxial cables, or to support
active probes with different termination requirements, select the termination in the Channel menu Vertical Settings panel.

All probes expect a specific coupling and input termination. Both coupling and input termination are displayed on the screen. If the
instrument determines the coupling and termination required by the probe, either implicitly because of the TekProbe/TekVPI interface or
through performing a probe compensation, the instrument sets the required coupling and input termination.

Consider the following when you use 50 Ω termination with any channel:

• The instrument does not accurately display frequencies under 200 kHz if AC coupling is selected.
• The instrument reduces the maximum volts per division setting for the channel, since input amplitudes appropriate for the higher

settings would overload the 50 Ω input.

Scaling and positioning
Set vertical scaling, positioning, and DC offsets to display the features of interest on your waveform and to avoid clipping.

The display contains ten major divisions. This represents the maximum digitizing range of the instrument for any given vertical scale.
Vertical waveform data that is outside (above and/or below) the maximum range is clipped; that is, the data values exceed the digitizing
capability of the ADC at the current settings.

Set the horizontal scale, position, and resolution (record length) to include the acquired waveform record waveform attributes of interest
with good sampling density on the waveform. These settings define the horizontal acquisition window, described in .

Note: The terms vertical acquisition window and horizontal acquisition window refer to the vertical and horizontal range of the
segment of the input signal that the acquisition system acquires.

Vertical acquisition considerations
You can set the vertical scale, position, and offset of each channel independently of other channels.

The offset control subtracts a constant DC level from the input signal before the vertical scale factor is applied, and the vertical position
control adds a constant number of divisions of signal after the scale factor is applied to the resulting difference.

The vertical scale and position controls have the following effects on the waveform display and the displayed waveform:
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The vertical volts per division you set determines the vertical size of the waveform display, allowing you to scale it to contain all of a
waveform amplitude or only part.

Note: Amplitude-related automatic measurements (for example, peak-to-peak and RMS) will be accurate for vertical windows if
the waveform is not clipped. But if signal amplitude were to extend outside the vertical acquisition window, the data acquired
is clipped. Clipped data causes inaccurate results if used in amplitude-related automatic measurements. Clipping also causes
inaccurate amplitude values in waveforms that are stored or exported for use in other programs.

If the scale of a math waveform is changed so that the math waveform is clipped, it will affect the amplitude measurements on that math
waveform as follows:

• The vertical position adjusts the waveform relative to the graticule. Adjust the vertical position to place the waveforms where you want
to see them. The waveform baseline indicators indicate the zero Volts (or Amps) level for each waveform. If you adjust the channel's
Vertical Scale, the waveform expands or contracts around the waveform's baseline indicator.

• When you use the Channel Offset control to move a waveform, the baseline indicator no longer represents zero. Instead, it represents
the level of the offset. Offset moves the waveform display to control the portion of the waveform amplitude the display captures. If you
adjust the channel's Vertical Scale, the waveform expands or contracts around the waveform's baseline indicator.

Horizontal acquisition considerations
The instrument lets you define the horizontal waveform display parameters.

These common parameters specify a horizontal scale and position that is applied to all channels simultaneously.

These parameters are shown in the next figure (horizontal window with delay on):

• The trigger position determines where the trigger event will be located in the waveform record. To see more pretrigger data move your
trigger position to the right on the graticule.

• The horizontal position determines the number of pretrigger and posttrigger samples. Samples before the trigger point are pretrigger
samples and those after the trigger point are posttrigger samples. When Delay is off, the horizontal position is the same as the trigger
position.

• The horizontal delay determines the time from the trigger point to the Horizontal Reference.
• The horizontal scale determines the horizontal size of the relative to any waveform, allowing you to scale it to contain a waveform

edge, a cycle, or several cycles.

Using reference waveforms and traces
You can compare a reference waveform or trace to another waveform.

You can create and store a reference waveform or trace. For example, you might do this to set up a standard against which to compare
other waveforms. To recall a previously saved reference waveform or trace:

1. Tap the Add Math Ref Bus button and then tap Ref 1 . This creates a reference badge and displays the reference waveform.
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2. Double-tap the Ref 1 badge to open the Reference configuration menu.
3. Use the resulting menu selections to display or select a reference waveform or trace.
4. Tap the Vertical Scale and Vertical Position fields and use the multipurpose knobs to adjust the vertical settings.
5. Tap the Horizontal Scale and Horizontal Position fields and use the multipurpose knobs to adjust the horizontal settings.
6. Double-tap Label and use the keyboard to define labels to display with the reference waveform and trace.
7. Ref Details provides information about the selected reference. Use this to determine whether the reference is an analog waveform or

an RF trace.
8. To create a reference see Save a waveform to a file on page 99.

Quick Tips
• Selecting and Displaying Reference Waveforms. You can display all the reference waveforms at the same time.
• Removing Reference Waveforms from the Display. To remove a reference waveform from the display, tap the reference badge and

flick it off the display.
• Scaling and Positioning a Reference Waveform. You can position and scale a reference waveform independently from all other

displayed waveforms. You can do this whether acquisition is running or not.

If a reference waveform is selected, scaling and repositioning of the reference waveform operates the same way whether zoom is
turned on or off.

• Saving 10 M Reference Waveforms. 10 M reference waveforms are volatile and not saved when the oscilloscope power is turned off.
To keep these waveforms, save them to external storage.

Frequency-Domain concepts
Typical oscilloscope displays show electrical signals as a graph of amplitude on the y-axis versus time on the x-axis. The frequency
domain RF view shows the same electrical signals as a graph of amplitude (or magnitude) on the y-axis versus frequency on the x-axis.

The same signal is simply displayed in two different ways. A time-domain signal is a composite of a number of discrete sine waves, each
with their own frequency, magnitude, and phase. The frequency-domain spectrum is an decomposition of the signal into its constituent
frequency components.

Displaying the Frequency Domain menu
Use the Frequency Domain menu to make vertical settings, display traces, and display a spectrogram.

1. Tap the RF button on the display or push the RF button on the front panel.
2. Double tap the RF badge to bring up the RF menu
3. Double-tap Label to display a keyboard and label the RF traces.
4. Double-tap Reference Level, Scale, or Position to display a keypad and configure the RF input.
5. Tap Traces to open the Traces panel.
6. Tap Spectrogram to toggle the spectrogram trace on.
7. Select the detection method:

• Auto allows the instrument to select the detection type.
• Manual allows you to select the detection type: +Peak, Average, Sample, or -Peak.

Waveform acquisition concepts

3 Series Mixed Domain Oscilloscope Help 253

www.tehencom.com          



RF waveform view and badges
RF waveform view makes changes to system badges as follows:

When the RF mode is enabled, the Waveform View window is opened and a new RF badge is added to the Readout bar. The RF badge
first line indicates the reference level of the RF waveform. The second line indicates the vertical scale of the RF waveform.

Spectrum trace handle
The spectrum trace handle provides details on the trace reference level, the source channel for the trace, and which trace types are
displayed.

Figure 3: Spectrum trace MANm handle info

1. The RF trace indicator is placed at the Reference Level. The waveform view shows the spectrum traces relative to a Reference Level
reference point. If the Reference level is above the top of the graticule, the handle is drawn at the top of the graticule and pointing up.

2. A capital M indicates that the maximum trace is enabled.
3. A capital A indicates that the average trace is enabled.
4. A capital N indicates that the normal trace is enabled.
5. The small m indicates that the minimum trace is enabled.

Highlighting around a letter indicates that trace type is selected. In the figure, the small m is highlighted, indicating that the minimum trace
is currently selected.

There is an important distinction between enabled and selected traces:

• An enabled trace letter (displayed in the trace handle) means that trace type is being displayed.
• A selected trace (highlighted around the letter) is the trace that is used for measurements, marker readouts, and cursor readouts.
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Spectrum trace markers
Automatic peak markers assist with quickly identifying the frequency and amplitude of peaks in the spectrum trace.

Figure 4: Spectrum trace markers

1. The Reference Marker is placed on the highest amplitude peak. It is marked with a Red triangle.
2. The Automatic markers mark the next highest peaks in the trace.

• The automatic markers indicate frequency and amplitude.
• Absolute readouts show the actual frequency and amplitude of the automatic markers.
• Delta readouts show the frequency and amplitude of the automatic markers relative to the reference marker.

The RF waveform view user interface
This topic identifies objects in the RF waveform view.

1. Normal trace: Each acquisition is discarded as new data is acquired.
2. Max hold trace: The maximum data values are accumulated and displayed over multiple acquisitions of the Normal trace.
3. Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal trace.
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4. Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power averaging, which occurs before
the log conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.

5. Amplitude (magnitude) scale.
6. Frequency span and scale. Shows the start and stop frequencies in the spectrum trace. The Horizontal badge shows the center

frequency.

RF View guidelines

• The vertical and horizontal in-graticule labels apply to the currently selected channel.
• The MANm spectrum trace handle (see Spectrum trace handle on page 254) for the currently selected channel is shown highlighted,

just like with analog channels.
• The MANm trace handle for non-selected traces are shown in the same fashion as non-selected analog channels.
• The RF View does not support zoom.
• Horizontal pinch and expand touch gestures adjust the spectrum span in the same style as a horizontal pinch/expand in the Waveform

Vew.
• A horizontal pan adjusts the center frequency.
• Vertical pinch and expand touch gestures adjust the spectrum vertical scale in the same style as a vertical pinch/expand in the

Waveform Vew.
• A vertical pan adjusts the vertical position.

Using spectral analysis controls
Use these control to configure the acquisition and display of the RF input.

1. Tap the RF badge or push the RF button to bring up the frequency domain display and create an RF badge. The RF menu provides
access to the Spectrogram display.

2. Double-tap the Horizontal badge to open the Horizontal menu.
3. Specify the portion of the spectrum to view on the display:

• Tap and use the multipurpose knob or double-tap the Center Frequency and Span fields or
• Tap and use the multipurpose knob or double-tap the Start Frequency and Stop Frequency

4. Tap RBW Mode to define the resolution bandwidth

• Auto, tap Span:RBW and use the keypad to set resolution bandwidth
• Manual, tap RBW and use the multipurpose knob or double-tap RBW to set the resolution bandwidth.

5. Tap Window and select which FFT window to use. The choices are:

• Rectangular see Rectangular window on page 285
• Hanning see Hanning FFT window on page 284
• Hamming see Hamming window on page 285
• Blackman-Harris see Blackman-Harris FFT window concepts on page 284

6. Double-tap the RF badge and use the controls to set the Reference Level and the Scale of the frequency domain traces.

Setting up the RF input
This topic helps set up the center frequency, span, and reference level.

Frequency and span parameters
1. The center frequency is a precise frequency at the center of the display. In many applications, it is a carrier frequency.
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2. The span is the range of frequencies you can observe around the center frequency.

To define the center frequency and the span:

1. Tap the RF button on the display or push the RF button on the front panel.
2. Double-tap the Horizontal badge to display the Horizontal menu.
3. Double-tap Center Frequency and use the keypad to enter the desired center frequency.
4. Double-tap Span and use the keypad to enter the desired span.
5. Double-tap Start Frequency and use the keypad to set the lowest frequency to capture.
6. Double-tap Stop Frequency and use the keypad to set the highest frequency to capture.

Reference Level
1. Double-tap the RF badge to open the RF menu.
2. Double-tap Reference Level and use the keypad to set the approximate maximum power level, as shown by the baseline indicator at

the top of the frequency graticule.
3. Double-tap Position and use the keypad to set the position or tap Position and turn Multipurpose a to adjust the vertical position. You

will move the baseline indicator up or down. This is useful if you want to move signals onto the visible display.
4. Tap Scale and turn Multipurpose a to adjust the vertical scale.
5. Tap Units and select the units of measure for the frequency domain. Choices are: dBm, dBμW, dBmV, dBμV, dBmA, and dBμA.

This is useful if your application requires a different unit of measurement than that being currently displayed.
6. Tap Auto Level to direct the oscilloscope to automatically calculate and set the reference level for you.

Resolution bandwidth
Use resolution bandwidth to determine which frequencies the instrument can resolve.

The resolution bandwidth (RBW) determines the level to which the oscilloscope can resolve individual frequencies in the frequency
domain. For example, if the test signal contains two carriers separated by 1 kHz, you will not be able to discriminate between them unless
the RBW is less than 1 kHz.

The views below both show the same signal. The difference between them is their RBW.
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Figure 5: Lower (narrower) RBWs take longer to process, but have finer frequency resolution and a lower noise floor.

Figure 6: Higher (wider) RBWs take less time to process, but have less frequency resolution and a higher noise floor.

Do the following to adjust the resolution bandwidth.

1. In frequency domain mode, double-tap the Horizontal badge to display the Horizontal menu.
2. Tap RBW Mode to select either Auto or Manual.

• Auto sets the resolution bandwidth automatically as you change the span. The default behavior is RBW = Span/1000.
• Manual allows you to set your own resolution bandwidth.

3. To manually adjust the RBW, tap RBW and turn the multipurpose knob.
4. Tap Span : RBW and use the multipurpose knob to set the span/RBW ratio.

This ratio is used when the RBW Mode is set to Auto. The default is 1000:1 but you can set it to other values.
5. Tap Window and select which FFT window to use. The choices are:

• Rectangular see Rectangular window on page 285
• Hanning see Hanning FFT window on page 284
• Hamming see Hamming window on page 285
• Blackman-Harris see Blackman-Harris FFT window concepts on page 284

Spectrogram display
The spectrogram display is useful for monitoring slowly-changing RF phenomena.

The spectrogram x-axis represents frequency, just like the typical spectrum display. The y-axis represents time. Color indicates amplitude.

Spectrogram slices are generated by taking each spectrum and flipping it on its edge so that it is one pixel row tall, and then assigning
colors to each pixel based on the amplitude at that frequency with the cold colors of blue and green representing low amplitude, and the
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hotter colors of yellow and red indicating higher amplitude. Each new acquisition adds another slice at the bottom of the spectrogram, and
the history moves up one row.

When acquisitions are stopped, you can navigate through the history of the spectrogram by pressing the side menu slice control and
turning the Multipurpose a knob. When acquisitions are stopped and the spectrogram is displayed, the spectrogram slice trace is displayed
as the Normal spectrum trace.

To use the spectrogram feature, display a trace in RF mode.

1. Double-tap the RF badge to display the RF menu.
2. Tap Traces to display the traces panel.
3. Tap Spectrogram to toggle the spectrogram display on.
4. To review each spectrum captured in the spectrogram, push Run / Stop to stop acquiring RF acquisitions. Turn Multipurpose knob a.

Automatic peak markers
This topic explains the automatic peak markers in the RF mode display.

Automatic peak markers are on by default and assist with quickly identifying the frequency and amplitude of peaks in the spectrum.

1. The Reference Marker is placed on the highest amplitude peak. It is marked with a red R in a triangle.
2. The automatic markers indicate frequency and amplitude.
3. Absolute readouts show the actual frequency and amplitude of the automatic markers.
4. Delta readouts show the frequency and amplitude of the automatic markers relative to the reference marker.

Each automatic marker has a readout associated with it. These can be absolute or delta readouts. An absolute marker readout shows the
actual frequency and amplitude of the associated marker. A delta marker readout shows the frequency and amplitude differences from the
Reference Marker. The Reference Marker’s readout indicates absolute frequency and amplitude, regardless of the readout type.

Note: Automatic markers can be turned on and off in the Waveform View menu. Tap Peak Markers to toggle the automatic
markers on and off.
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Frequency domain cursors
This topic provides help in using frequency domain cursors.

Two cursors are provided to measure non-peak areas of the spectrum and to measure Noise Density and Phase Noise. When the
cursors are turned on, the Reference Marker is no longer automatically attached to the highest amplitude peak. It is now assigned to the
Multipurpose knob a and can be moved to any location. This enables easy measurement of any part of the spectrum as well as delta
measurements to any part of the spectrum. This also allows measurement of non-peak spectral content. The readouts for cursors indicate
frequency and amplitude, just like automatic marker readouts.

As with automatic peak marker readouts, the cursor readouts can show either absolute or delta values.

1. To enable cursors, tap Cursors or press the Cursors front-panel button.
2. One cursor is controlled by Multipurpose knob a.
3. The other cursor is controlled by Multipurpose knob b.
4. Double-tap the reference cursor to open the Cursors menu.
5. To bring the reference cursor to the center of the screen, tap Reference To Center.
6. To change the readouts from Absolute to Delta readouts for frequency and amplitude, tap Readout Delta.
7. To change the readout units, double-tap the RF badge to open the RF menu, and then tap Units and select the desired units from the

list.

Use the Arbitrary Function Generator
The instrument contains an optional integrated arbitrary function generator (AFG).

The AFG is useful for simulating signals within a design or adding noise to signals to perform margin testing.

The function generator provides output of predefined waveforms up to 50 MHz. Choose between sine, square, pulse, ramp/triangle, DC,
noise, sin(x)/x (Sinc), Gaussian, Lorentz, exponential rise/fall, Haversine, and cardiac signals.

The AFG can generate up to 131,072 points of an arbitrary waveform. You can create the waveform from any of the four internal
ARB memories, the four (or two) analog channels, the four (or two) reference waveforms, the math waveform or the 16 digital channel
waveforms. You can also use a .CSV (spreadsheet) file stored externally or a predefined template.

For waveform manipulation, you can use Tektronix’ ArbExpress PC-based waveform creation and editing software. It is available for free
download from www.tektronix.com/software. Use version 3.1 or later with this instrument

How to access the AFG
To access the AFG output, connect your cable to the port marked AFG OUT in the back of the oscilloscope.
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To see the output of the AFG, connect the other end of the cable to one of the input channels on the front of the oscilloscope.

Tap the AFG button to display the AFG menu.

Tap Output to toggle the AFG output on and off and display the AFG badge.

The AFG badge is displayed when the output is on. The On-Off status is always off when you recall an instrument setup. The AFG will
always come up in the off state when you turn the oscilloscope power on.

Tap Modulation to toggle the AM/FM modulation on and off.

The modulation menu is not available when the AFG waveform type is set to DC, Pulse, Noise, or Cardiac.
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How to change the waveform type
1. Tap the AFG button to bring up the AFG menu.
2. Tap Waveform Type and select the waveform type from the list. Choose between Sine, Square, Pulse, Ramp, DC, Noise, Sin(x)/x,

Gaussian, Lorentz, Exponential Rise, Exponential Decay, Haversine, Cardiac, and Arbitrary.
3. Tap Frequency, Period, Amplitude, Offset, High Level, or Low Level and set the frequency, period, amplitude, offset and the high

and low levels of the desired waveform.
4. Tap Load Impedance and select the load impedance: 50Ω or High Z.
5. Tap Add Noise check box to toggle noise on. Set the amount of noise to add to the output signal using the keypad or the multipurpose

controls.

You can enable the AFG trigger pulse to come out of the rear-panel AUX OUT port. This is useful if you want an AUX OUT pulse that is
synchronized to your AFG waveform. To enable this feature, tap Utility> I/O> Aux Out> AFG Out Signal > AFG Sync.

Figure 7: The channel 1 sine wave shows the output of the AFG. The channel 2 square wave show the output of the AFG sync pulse. It comes from the AUX OUT port.

Restrictions The output waveform (MHz) frequency
setting

AFG trigger output frequency (MHz)

When an output frequency is higher than
4.9 MHz, some restrictions exist. A divided
frequency that is lower than 4.9 MHz is
output from the AUX OUT port. The AFG
trigger frequency will be limited as shown in
the table to the right.

≤ 4.9 MHz Signal frequency

>4.9 MHz to 14.7 MHz Signal frequency / 3

>14.7 MHz to 24.5 MHz Signal frequency / 5

>24.5 MHz to 34.3 MHz Signal frequency / 7

>34.3 MHz to 44.1 MHz Signal frequency / 9

>44.1 MHz to 50 MHz Signal frequency / 11

How to load an arbitrary waveform
You can load the waveform from the four (or two) analog channels, the four (or two) reference waveforms, the math waveform, or the
16 digital channel waveforms. You can also use a .CSV (spreadsheet) file stored externally or a predefined template (square, sine, ramp,
pulse, or noise).

1. Tap the AFG button to display the AFG menu.
2. Tap Waveform Type and Arbitrary from the list of waveforms in the menu.
3. Tap Frequency, Period, Amplitude, Offset, High Level, or Low Level and set the frequency, period, amplitude, offset and the high

and low levels of the desired waveform.
4. If you will load one of the channel, reference, or math waveforms, tap Load From and select the waveform source from the list.

Waveform acquisition concepts

262

www.tehencom.com          



5. Push OK Load Waveform to load the new waveform.
6. If you select to load from a file, tap Browse and browse the directory for the file.
7. Push OK Load Waveform to load the new waveform.
8. View your arbitrary waveform on the oscilloscope display.

Quick Tips
• You can load an arbitrary waveform from a .CSV format file. A .CSV file consists of sets of waveform point pairs (voltage, point

number).
• You can load arbitrary waveforms from a variety of active time domain waveform sources: Channel 1 - 4, Ref 1 - 4, MATH, digital

channels D0 - D15.

Note: Load impedance scales the vertical settings to show what the load would see based on the load impedance. Since the AFG
is a 50 Ω source, for most accurate operation, set the load impedance to 50 Ω and set the input channel to 50 Ω.

Note: Noise range is reduced above 50% of the function Maximum Amplitude according to the function

Noise Percent Maximum = 100.0 * (Maximum Amplitude / Amplitude – 1.0)
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Triggering concepts
Overview
User-defined trigger conditions are used to capture waveforms for measurement and analysis. This instrument has simple edge triggers as
well as a variety of advanced triggers.

The trigger event
The trigger event establishes the time-zero point in the waveform record. All waveform record data are located in time with respect to that
point. The instrument continuously acquires and retains enough sample points to fill the pre-trigger portion of the waveform record (that
part of the waveform that is displayed before, or to the left of, the triggering event on screen).

When a trigger event occurs, the instrument starts acquiring samples to build the post-trigger portion of the waveform record (displayed
after, or to the right of, the trigger event). Once a trigger is recognized, the instrument will not accept another trigger until the acquisition is
complete and the holdoff time has expired.

Trigger sources
The trigger source provides the signal that triggers acquisition.

Use a trigger source that is synchronized with the signal that you are acquiring and displaying.

You can derive your trigger from the following sources:

• Input channels. Analog input channels are the most commonly used trigger sources. You can select any of the input channels. The
channel that you select as a trigger source will function whether it is displayed or not.

• Digital channels. These sources are available if you have the MSO option and a digital probe connected. You can select any
combination of digital channels.

• Bus. This source is used to trigger a parallel bus or a serial bus. You can include any combination of analog or digital channels to build
a parallel bus, or use any channel as a component in a serial bus.

Trigger types
Select a trigger type to synchronize your acquisitions.

The available trigger types include:

Edge. This is the simplest and most commonly used trigger type, used with both analog and digital signals. An edge trigger event occurs
when the trigger source passes through a specified voltage level in the specified direction (rising, falling, or either signal voltage).

Pulse Width. Trigger on pulses that are inside or outside a specified time range. Can trigger on positive or negative pulses.

Timeout. Trigger when no edge transition is detected within a specified time.

Runt. Use Runt trigger to trigger on a pulse amplitude that crosses one threshold but fails to cross a second threshold before recrossing
the first. Can detect positive or negative runts, or only those wider than, less than, greater than, equal to, or not equal to a specified width.

Logic. These are special-purpose triggers that are primarily used with digital logic signals. Logic triggers are available on the main triggers.
Triggering occurs when the selected condition goes true. You can also select triggering when the condition goes false, or time-qualified
triggering.

Setup & Hold. Trigger when a logic input changes state inside the setup and hold times relative to the clock. This type triggers on a setup
and hold violation.

Rise/Fall Time. Trigger on pulse edges that traverse between two thresholds at faster or slower rates than the specified time. The pulse
edges can be positive or negative.
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Sequence. Use the A Trigger Event with the B Trigger Event to capture complex data. Both the A and B trigger events must be edge
triggers and rising or falling slopes.

• Time. After the A Event occurs, the trigger system waits the specified amount of time, and then looks for the B Event before triggering
and displaying the waveform.

• Events. After the A Event occurs, the trigger system looks for a specified number of B Events before triggering and displaying the
waveform.

Video Trigger on specified fields or lines of a composite video signal. Only composite signal formats are supported. Trigger on NTSC, PAL,
or SECAM. Works with Macrovision signals. Trigger on a variety of HDTV video standard signals, as well as custom (non-standard) bilevel
and trilevel video signals with 3 to 4,000 lines.

Bus. This trigger is used with both analog and digital signals to set up parallel buses or serial buses. A bus trigger event occurs when the
instrument detects a bus pattern that you specify for a parallel bus, or a bus cycle you select for a serial bus. A bus is defined in a bus
menu. Serial buses are optional, see Serial bus decode and trigger options on page 26.

Trigger modes
The trigger mode determines how the instrument behaves in the absence of a trigger event: 

• Normal trigger mode enables the instrument to acquire a waveform only when it is triggered. If no trigger occurs, the instrument does
not acquire a waveform, and the last waveform record acquired remains on the display. If no last waveform exists, no waveform is
displayed.

• Auto trigger mode enables the instrument to acquire a waveform even if a trigger does not occur. Auto mode uses a timer that starts
after a trigger event occurs. If another trigger event is not detected before the time out, the instrument forces a trigger. The length of
time it waits for a trigger event depends on the time base setting.

Auto mode, when forcing triggers in the absence of valid triggering events, does not synchronize the waveform on the display. In other
words, successive acquisitions are not triggered at the same point on the waveform; therefore, the waveform will appear to roll across the
screen. If valid triggers occur, the display will become stable.

Trigger holdoff
Trigger holdoff can help stabilize triggering. When the instrument recognizes a trigger event, it disables the trigger system until acquisition
is complete. In addition, the trigger system remains disabled during the holdoff period that follows each acquisition. Adjust holdoff to obtain
stable triggering when the instrument is triggering on undesired trigger events.

A digital pulse train is a good example of a complex waveform. Each pulse looks like any other, so many possible trigger points exist. Not
all of these will result in the same display. The holdoff period allows the instrument to trigger on the correct edge, resulting in a stable
display.
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At the longer holdoff time for the top waveform, unstable triggering occurs. With a shorter holdoff set for the bottom waveform, triggers all
occur on the first pulse in the burst to remedy the unstable trigger.

For more information on how to set holdoff, see Set Trigger Holdoff on page 87. If you select Auto holdoff, the instrument selects a holdoff
value for you.

Trigger coupling
Trigger coupling determines what part of the signal is passed to the trigger circuit. Edge triggering can use all available coupling types: DC,
Low Frequency Rejection, High Frequency Rejection, and Noise Rejection. All of the advanced trigger types use DC coupling only.

• DC. This coupling passes all input signals to the trigger circuitry.
• HF Reject. This coupling attenuates signals above 50 kHz before passing the signal to the trigger circuitry.
• LF Reject. This coupling attenuates signals below 50 kHz before passing the signal to the trigger circuitry.
• Noise Reject. This coupling provides stable triggering by increasing the trigger hysteresis. Increased hysteresis reduces the trigger

sensitivity to noise but may require greater signal amplitude.

Trigger slope and level
The slope control determines whether the instrument finds the trigger point on the rising or the falling edge of a signal. The level control
determines where on that edge the trigger point occurs. See the next figure. 

Trigger position in waveform record
Trigger position is an adjustable feature that defines where the trigger occurs on the waveform record. It lets you choose how much the
instrument acquires before and after the trigger event. The part of the record that occurs before the trigger is the pretrigger portion. The
part that occurs after the trigger is the posttrigger portion. A longer posttrigger period may be useful when you want to see the effects an
event has on your system under test.

Pretrigger data can be valuable when troubleshooting. For example, if you are trying to find the cause of an unwanted glitch in your test
circuit, you can trigger on the glitch and make the pretrigger period large enough to capture data before the glitch. By analyzing what
happens before the glitch, you may uncover information that helps you find the source of the glitch.

Trigger delay
Use the Trigger Delay to trigger the instrument a specified period of time after the A trigger. After the A trigger arms the trigger system, the
instrument triggers on the next B trigger event that occurs after the time that you specify.

You can trigger with the A trigger system alone or you can combine the A trigger with the B (Delayed) trigger to trigger on sequential
events. When using sequential triggering, the A trigger event arms the trigger system, and the B trigger event triggers the instrument when
the B trigger conditions are met.
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A and B triggers can (and typically do) have separate sources. The B trigger condition can be based on a time delay or a specified number
of counted events.

Bus triggering concepts
A bus trigger occurs when a supported instrument detects a bus pattern that you specify for a parallel bus, or a bus cycle you select for a
serial bus.

You can set the instrument to trigger on a parallel bus when the instrument detects a match to the bus pattern, or when the instrument
detects that the value on the bus is < or > the value of the bus pattern. The pattern can be in Binary or Hex format.

You can set the instrument to trigger on an SPI bus when the instrument detects an SS Active bus cycle or Data.

You can set the instrument to trigger on an I2C bus when the instrument detects a Start, Stop, Repeated Start, Missing Ack, Address,
Data, or Addr + Data bus cycle or activity.

You can set the instrument to trigger on a USB bus (Low and Full Speed USB) when the instrument detects a Sync, Reset, Suspend,
Resume, End of Packet, Token (Address) Packet, Data Packet, Handshake Packet, Special Packet, or Error bus cycle or activity.

You can set the instrument to trigger on an RS232 bus when the instrument detects a Start, End of Packet, Data, or Parity Error bus cycle
or activity.

You can set the instrument to trigger on an CAN bus when the instrument detects a Start of Frame, Type of Frame, Identifier, Data, Id and
Data, End of Frame, Missing Acq, FD bit, or Bit Stuffing Error bus cycle or activity.

You can set the instrument to trigger on an LIN bus when the instrument detects a Sync, Identifier, Data, Identifier & Data, Wakeup Frame,
Sleep Frame, or Error bus cycle or activity.

You can set the instrument to trigger on an FlexRay bus when the instrument detects a Start of Frame, Indicator Bits, Identifier, Cycle
Count, Header Fields, Data, Identifier & Data, End of Frame, or Error bus cycle or activity.

You can set the instrument to trigger on an AUDIO bus when the instrument detects a Word Select, Frame Sync, or Data bus cycle or
activity.

For all the serial standard buses, you can also set the component threshold levels through the Bus Setup menu

Pulse width trigger concepts
A pulse width trigger occurs when the instrument detects a pulse that is less than, greater than, equal to, or not equal to a specified time.
Additionally, you can trigger when a pulse width is within or outside a range of two different specified times. The instrument can trigger on
positive or negative width pulses.

Timeout trigger
A timeout trigger occurs when the instrument does not detect an expected pulse transition within a user specified period of time, such as
when a signal gets stuck either high or low. If the pulse transition occurs prior to a specified timeout time (the expected case), then no
trigger results.

Runt trigger
A runt trigger occurs when the instrument detects a short pulse that crosses one threshold but fails to cross a second threshold before
recrossing the first. You can set the instrument to detect any positive or negative runt pulse, or only those wider than a specified minimum
width.
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Logic trigger concepts
Logic trigger the instrument when all channels transition to the specified state. You can set each bit to be active High, Low, or Don't Care.
You can also set the logic thresholds and define the logic (AND, OR, NOR, or NAND).

Setup and Hold trigger concepts
A setup/hold trigger occurs when a data signal changes state inside of the user specified setup and hold times relative to the clock. When
you use setup/hold triggering, you define:

• The channel containing the logic input (the data source) and the channel containing the clock (the clock source)
• The direction of the clock edge to use
• The clocking level and data threshold that the instrument uses to determine if a clock or data transition has occurred
• The setup and hold times that together define a time range relative to the clock

Data that changes state within the setup/hold violation zone triggers the instrument. The next figure shows how the setup and hold times
that you choose position the violation zone relative to the clock.

Setup/hold triggering uses the setup/hold violation zone to detect when data is unstable too near the time it is clocked. Each time trigger
holdoff ends, the instrument monitors the data and clock sources. When a clock edge occurs, the instrument checks the data stream it is
processing (from the data source) for transitions occurring within the setup/hold violation zone. If any occur, the instrument triggers with the
trigger point located at the clock edge.

The setup/hold violation zone spans the clocking edge as shown above. The instrument detects and triggers on data that does not become
stable long enough before the clock (setup time violation) or that does not stay stable long enough after the clock (hold time violation).

Rise/Fall time trigger concepts
Rise/Fall time triggering is based on the slope (change in voltage/change in time) of a pulse edge. Trigger on pulse edges that traverse
between two thresholds at faster or slower rates than the specified time.

Use the Rise/Fall time trigger to trigger the instrument on pulse edges that traverse between two thresholds at faster or slower rates than
the specified time. You can set up the instrument to trigger on positive or negative edges.

Sequential (A B) trigger concepts
In applications that involve two or more signals, you may be able to use sequential triggering to capture more complex events. Sequential
triggering uses the A (Main) trigger to arm the trigger system, and then uses the B (Delayed) trigger to trigger the instrument if a specific
condition is met. Both the A trigger and the B trigger must be Edge triggers.
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You can choose one of two trigger conditions:

• Trigger after a Delay. After the A trigger arms the trigger system, the instrument triggers on the next B-trigger event that occurs after
the trigger delay time. You can set the trigger delay time with the keypad or a multipurpose knob.

• Trigger on the Nth event. After the A trigger arms the trigger system, the instrument triggers on the Nth B event. You can set the
number of B events with the keypad or a multipurpose knob.

Note: The traditional delayed trigger mode called Runs After is controlled by the Horizontal Delay feature. You can use horizontal
delay to delay acquisition from any trigger event, whether from the A trigger alone or from a sequential trigger that uses both the A
and B triggers.
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Waveform display concepts

Waveform display overview
This instrument includes a flexible, customizable display that lets you control how waveforms appear. The figure shows how the display
features fit into the overall instrument operation.

The display shows analog, digital, math, reference and bus waveforms. The waveforms include channel markers and trigger source and
level indicators.

Waveform preview mode
The waveform preview attempts to show what the next acquisition will look like when the acquisition is delayed due to slow triggers or
long acquisition duration, or when the acquisitions have stopped. Waveform preview recalculates math waveforms, but does not represent
changes in trigger levels, trigger modes, or different acquisition modes.

Horizontal position and the horizontal reference point
The time value you set for horizontal position is measured from the trigger point to the horizontal reference point. This is not the same as
the time value from the trigger point to the start of the waveform record, unless you set the horizontal reference to 0%. See the next figure.

Annotating the screen
You can add your own text to the screen.

Doing the following to add your own text to the screen:

1. Double-tap an empty location on the screen to display the Waveform view menu.
2. Double tap Screen Annotation to display the keyboard.
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3. Enter the desired text using the keyboard.
4. Tap Enter to display the text and close the keyboard.
5. Tap and drag the text to the desired location.

Vertical graticule readout
Vertical graticule readout shows the value of vertical divisions of the selected channel on the screen.
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Measurement concepts

Taking automatic measurements in the time domain
This topic explains how to take an automatic measurement in the time domain.

To take an automatic measurement in the time domain:

1. If the instrument is in the frequency domain, tap the 2 button or push the channel 1 front panel button.
2. Tap Measure to display the Add Measurements menu.
3. Tap a measurement category panel to display available measurements.
4. Tap Source and select the desired source for the measurement.
5. Tap the desired measurement.
6. Tap Add to create the measurement results badge.
7. To remove a measurement, tap the measurement results badge and flick it off the display.

Quick Tips
• A symbol and Clipping appears if a vertical clipping condition exists. Part of the waveform is above or below the display. To obtain a

proper numerical measurement, turn the vertical scale and position knobs to make all of the waveform appear in the display.
• If the oscilloscope displays an error message, change the instrument setup, such as increasing the record length of the acquisition or

changing the horizontal scale so that the instrument has more points or edges from which to calculate the measurement.

Taking automatic measurements in the frequency domain
This topic explains how to take an automatic measurement in the frequency domain.

To take an automatic measurement in the frequency domain:

1. If the instrument is in the time domain, tap the RF button or push RF front-panel button.
2. Tap Measure to display the Add Measurements menu.
3. Tap the measurement of interest from the menu. As you select each frequency measurement, on screen help will appear to explain the

purpose of that measurement.

• Channel Power: The total power within the bandwidth, defined by the Channel Width.
• Adjacent Channel Power Ratio: The power in the main channel and the ratio of channel power to main power, for the upper and

lower halves of each adjacent channel.
• Occupied Bandwidth: The bandwidth that contains the specified % of power within the analysis bandwidth.

4. Tap Add to create the measurement results badge.
5. To configure the measurement, double-tap the measurement badge.
6. After you set the measurement parameters in the resulting menu, the instrument will automatically set the span. When the RF

measurements are on, the Auto detection method will set all frequency domain traces to the Average detection method. This provides
optimal measurement accuracy.

Taking digital voltmeter measurements
Use the digital voltmeter to measure the potential difference between two points in an electrical circuit.

Use this procedure to take digital voltmeter measurements.
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1. Tap the DVM button to display the DVM results badge.
2. Double-tap the DVM results badge to display the DVM menu.
3. Tap the Display field to toggle the digital voltmeter on and off.
4. Tap the Source field and select the source from the drop-down list. Measurements will be taken on this source.
5. Tap the Mode field and select the measurement type you want to take: DC, AC RMS, AC+DC RMS, or Frequency.
6. Tap Show Basic Statistics in Badge to display statistics in the measurement badge.
7. Tap an empty location on the display to close the DVM menu.

View the finished results in the DVM results badge.

Taking manual measurements with cursors
Cursors are on-screen markers that you position in the waveform display to take manual measurements on acquired data.

To take manual measurements with cursors in the frequency domain, see Frequency domain cursors on page 260.

Cursors appear as horizontal and/or vertical lines. To use cursors on analog or digital channels:

1. Tap the Cursors on-screen button or push the Cursors front-panel button.

Note: A second tap or push turns cursors off.

As you turn Multipurpose a, you move one cursor to the right or left. As you turn Multipurpose b, you move the other cursor.

2. Double-tap a cursor to display the cursor menu.
3. Tap Cursor Mode. Selecting Independent allows the a and b cursors to move independently.

Selecting Linked turns the cursor linking on. If linking is on, turning Multipurpose knob a moves the two cursors together. Turning
Multipurpose knob b adjusts the time between the cursors.

4. Push a Multipurpose knob to toggle between a coarse and a fine adjustment for the Multipurpose knobs.
5. Double-tap a cursor to display the cursor menu.
6. Tap Cursor Type and select Screen from the list.

In Screen mode, two horizontal bars and two vertical bars span the graticule.
7. Tap a horizontal cursor. Turn Multipurpose a and Multipurpose b to move the pair of horizontal cursors.
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8. Tap a vertical cursor.

This makes the vertical cursors active and the horizontal cursors inactive. Now, as you turn the multipurpose knobs, the vertical
cursors will move.

Tap a horizontal cursor to make the horizontal cursors active again.
9. View the cursor and the cursor readout.

Note: On digital channels, you can take timing measurements with cursors, but not amplitude measurements.

10. Display multiple waveforms on the screen by pushing one or more of the channel buttons or by pushing the Digital button.
11. Double-tap a cursor to display the cursor menu again.
12. Tap the Source button and select a source from the list. The default menu selection of Selected Waveform will cause the cursors to

take measurements on the selected (last used) waveform.
13. Tap the Source button and select a source from the list to measure other than the one pointed to by Selected Waveform.
14. Tap outside the menu to remove the menu.
15. Tap or push Cursors again. This turns off the cursors. The screen no longer displays the cursors and the cursor readout.

Making automated power measurements
This topic explains how to take an automatic power measurement (optional).

Acquire, measure, and analyze power signals with the 3-PWR Power Measurement and Analysis option. To use this application:

1. Tap Measure to display the Add Measurements menu.
2. Tap the Power Measurements panel.
3. Tap Source 1 and Source 2 and select the desired sources for the measurement.
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4. Tap the desired measurement. Choose among:

• Power quality
• Switching loss
• Harmonics
• Ripple
• Modulation
• Safe operating area

5. Tap Add to create the measurement results badge. View the measurement results in the results badge.
6. To remove a measurement, tap the measurement results badge and flick it off the display.
7. To configure the measurement, double-tap the Power results badge to display the measurement configuration menu. See The Power

Measurements panel (optional) on page 109 for more information.

Using cursor readouts
Cursor readouts supply textual and numeric information relating to the current cursor positions.

The instrument shows the readouts when the cursors are turned on. Readouts appear in the upper portion of the graticule attached to the
cursors.

When a bus is selected, the readout shows the decoded bus data in the format you have selected from the choices in the bus menu. When
a digital channel is selected, the cursors show the values of all displayed digital channels.

Note: When serial or parallel buses are selected, the data value at that point is displayed in the cursor readout.

• Δ Readout: Indicates the difference between the cursor positions.
• a Readout: Indicates that the value is controlled by the Multipurpose a knob.
• b Readout: Indicates that the value is controlled by the Multipurpose b knob.

The horizontal cursor lines on the display measure the vertical parameters, typically voltage.

The vertical cursor lines on the display measure horizontal parameters, typically time.

The square and circle shapes in the readout map to the multipurpose knobs when both vertical and horizontal cursors are present.
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Using XY Cursors
When the XY Display mode is on, the cursor readouts appear at the right of the display.

The oscilloscope displays rectangular, a, b, and the Δ readouts.

Measurement variables
By knowing how the instrument makes calculations, you may better understand how to use your instrument and how to interpret your
results. The instrument uses a variety of variables in its calculations. These include:

Definition of Base and Top
Base is the value used as the 0% level in measurements such as fall time and rise time.

Top is the value used as the 100% level in measurements such as fall time and rise time. For example, if you set the 10% to 90% rise time,
then the instrument calculates 10% and 90% as percentages of Top and Base, with Top representing 100%.

The exact value of Base and Top depends on which Base Top Method you select in the Reference Levels panel of a Measurement
configuration menu. It also depends on if you set the reference level to be Global (applies to all measurements set as Global in the
Reference Levels panel), or Local (just applies to the measurement that is set to Local).

Base, Top calculation methods
The Base Top calculation method is set in the Reference Levels panel of a Measurement configuration menu.

Auto is the default method, and automatically determines the best Base Top method to use. Most commonly sets the Base Top method to
Histogram Mode.

MinMax defines the 0% and the 100% waveform levels as the lowest value and the highest value samples of the waveform record. This
setting is best for examining waveforms that have no large, flat portions at a common value, such as sine waves and triangle waves -
almost any waveform except for pulses.

The MinMax method calculates the Top and Base values as follows:

Top = Max

and

Base = Min

Histogram uses histogram analysis to select the most common values either above or below the midpoint. Since this statistical approach
ignores short-term aberrations (overshoot, ringing, and so on), Histogram is the best setting for examining pulses.

Histogram Eye Center uses histogram analysis of the amplitudes in the center of each bit (unit interval) while ignoring the waveform
during bit transitions. The histogram sets the Top at the nominal high level and Base at the nominal low level. This is similar to the
Histogram Mode, except it is less influenced by the shape of the waveform during transitions between bits.

HighRef, MidRef, LowRef
You set the various reference levels, through the Reference Levels tab of the Measure menu. They include:

High is the waveform high reference level (also HighRef). Used in all measurements. Typically set to 90%. You can set it from 0% to 100%
or to a voltage level.

Mid is the waveform middle reference level (also MidRef). Mid reference levels are used in all measurements that need to find edges.
Typically set to 50%. You can set it from 0% to 100% or to a voltage level.
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Low is the waveform low reference level (also LowRef). Used in all measurements. Typically set to 10%. You can set it from 0% to 100%
or to a voltage level.

High, mid and low reference levels can be set uniquely for each measurement source. Reference levels can also be set differently for rising
edge detection and falling edge detection.

Other variables
The instrument also measures several values itself that it uses to help calculate measurements.

Record Length is the number of data points in the time base. You set it with the Horizontal menu Record Length item.

Start is the location of the start of the measurement zone (X-value). It is 0.0 samples unless you are making a gated measurement. When
you use cursor gated measurements, it is the location of the left vertical cursor.

End is the location of the end of the measurement zone (X-value). It is (RecordLength – 1.0) samples unless you are making a gated
measurement. When you use cursor gated measurements, it is the location of the right vertical cursor.

Hysteresis Is the hysteresis band of the waveform amplitude.

For example, once a crossing has been measured in a negative direction, the waveform data must fall below the hysteresis value of
the amplitude from the Mid reference point before the measurement system is armed and ready for a positive crossing. Similarly, after a
positive Mid reference crossing, waveform data must go above the hysteresis value of the amplitude before a negative crossing can be
measured. Hysteresis is useful when you are measuring noisy signals, because it allows the oscilloscope to ignore minor fluctuations in the
signal.

Edge calculations
Edge1, Edge2, and Edge3 refer to the first, second, and third Mid reference edge times, respectively.

An edge can be detected when the waveform is either rising or falling past Midref. The direction of the edges alternates, that is, if Edge1 is
rising, Edge2 will be falling.

A rising edge has positive polarity. A falling edge has negative polarity.

TPOS is the location of the sample just before the trigger point (the time reference zero sample). In other terms, it contains the domain
reference location. This location is where time = 0.
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TSOFF is the offset between TPOS and the actual trigger point. In other words, it is the trigger sample offset. Values range between
0.0 and 1.0 samples. This value is determined by the instrument when it receives a trigger. The actual zero reference (trigger) location in
the measurement record is at (TPOS + TSOFF).

Missing or out-of-range samples
If some samples in the waveform are missing or off-scale, the measurements will interpolate between known samples to make an
appropriate guess as to the sample value. Missing samples at the ends of the measurement record will be assumed to have the value of
the nearest known sample.

When samples are out of range, the measurement will give a warning to that effect (for example, CLIPPING) if the measurement
could change by extending the measurement range slightly. The algorithms assume the samples recover from an overdrive condition
instantaneously.

Math waveforms
Once you have acquired waveforms or taken measurements on waveforms, the instrument can mathematically combine them to create a
waveform that supports your data-analysis task. For example, you might have a waveform clouded by background noise. You can obtain
a cleaner waveform by subtracting the background noise from your original waveform. Or, you can integrate a single waveform into an
integral math waveform

With spectral analysis you can analyze waveforms in the frequency domain.

This instrument supports mathematical combination and functional transformations of waveforms it acquires.

You create math waveforms to support the analysis of your channel and reference waveforms. By combining and transforming source
waveforms and other data into math waveforms, you can derive the data view that your application requires. Create math waveforms that
result from:

• Mathematical operations on one or several waveforms: add, subtract, multiply, and divide.
• Functional transformations of waveforms, such as integration, differentiation, and so on.
• Spectral analysis of waveforms, such as testing impulse response.

Math waveform elements
You can create Math waveforms from the following:

• Channel waveforms
• Reference waveforms
• Measurement scalars (automated measurements) that measure channel, reference, or math waveforms.
• Other math waveforms
• Variables
• Filters

Dependencies
In general, math waveforms that include sources as operands are affected by updates to those sources:

• Shifts in amplitude or DC level of input sources that cause the source to clip also clip the waveform data supplied to the math
waveform.
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• Changes to the vertical offset setting for a channel source that clips its data also clips the waveform data supplied to the math
waveform.

• Changes to the acquisition mode globally affects all input channel sources, modifying any math waveforms using them. For example,
with the acquisition mode set to Envelope, a Ch1 + Ch2 math waveform will receive enveloped channel 1 and channel 2 data, and will
also be an envelope waveform.

• Clearing the data in a waveform source causes a baseline (ground) to be delivered to any math waveform that includes that source
until the source receives new data.

Guidelines for working with math waveforms
Remember guidelines when working with math waveforms.

Use the following guidelines when working with math waveforms:

• Keep math waveforms simple.
• Math calculations are not available on digital channels.
• To avoid syntax errors in a math expression, verify the use of operators, parentheses, operands, and the spelling of functions.
• If one or more reference waveforms are used in a math waveform, the record length is equal to the smallest of all the source

waveforms (reference or channel waveforms). The math is calculated using the first point from each source, followed by the next point,
and so forth. This is true even if the sources have different times between points in the record.

Math waveform editor syntax
You can build math waveforms using the predefined expressions or the equation editor.

To help you create valid math waveforms, the following tools block most illegal entries by disabling any window element that would create
an invalid entry in the math waveform expression.

Predefined expressions are accessible using the FFT or Basic Math Types.

The following syntax describes the valid math expressions you can use with the Equation Editor for the Advanced Math Type:

A math expression is composed of settings, functions, scalars and sources.

Settings have the syntax [settingName=settingValue] and are generally applied to measurements. The setting applies to everything to the
right of the closing square brackets.

Example: [CoefFileName="highpass_0.25bw.flt"]HighPass(Ch1)

CoefFileName is the setting and is used as the high pass filter on channel 1.

Example: [CoefFileName="highpass_0.25bw.flt"] HighPass(Ch1) + [CoefFileName="lowpass_0.05bw.flt"] LowPass(Ch2)

The high pass filter file is applied to channel 1 and lowpass_0.05bw.flt is applied to channel 2.

Functions, except for basic and logic functions, have the syntax function(source).

In the previous examples the functions are HighPass and LowPass.

Basic and logic functions have the syntax source1 function source2.

Examples: Ch1 * Ch2

Ch1 AND Ch2

Ch1 >= Ch2

Logic functions, ==|<|>|!=|<=|>=|AND|OR|NAND|NOR|XOR|EQV result in a waveform consisting of binary 0 and 1 values.

Scalars can be integers, floating point values, PI or meas<x>.
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Sources can be Ch<x> or Ref<x>

Math waveform differentiation
The math capabilities of the instrument include waveform differentiation.

Waveform differentiation allows you to display a derivative math waveform that indicates the instantaneous rate of change of the acquired
waveform.

Derivative waveforms are used in the measurement of slew rate of amplifiers and in educational applications.

The math waveform, derived from the sampled waveform, is computed based on the following equation:

Where: X is the source waveform, Y is the derivative math waveform, and T is the time between samples.

Since the resultant math waveform is a derivative waveform (see the next figure), its vertical scale is in volts/second (its horizontal scale is
in seconds). The source signal is differentiated over its entire record length; therefore, the math waveform record length equals that of the
source waveform.

Math waveform offset position and scale
The settings that you make for offset, scale, and position affect the math waveform you obtain.

Here are some tips for obtaining a good display:

• Scale and position the source waveform so that it is contained on the screen. (Off-screen waveforms may be clipped, resulting in errors
in the derivative waveform).

• Use vertical position and vertical offset to position your source waveform. The vertical position and offset will not affect your derivative
waveform unless you position the source waveform off screen so that it is clipped.

Waveform integration
The math capabilities of the instrument include waveform integration.

This allows you to display an integral math waveform that is an integrated version of the acquired waveform.

Use integral waveforms in the following applications:

• Measuring power and energy, such as in switching power supplies.
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• Characterizing mechanical transducers, as when integrating the output of an accelerometer to obtain velocity.

The integral math waveform, derived from the sampled waveform, is computed based on the following equation:

Where: x(i) is the source waveform, y(n) is a point in the integral math waveform, scale is the output scale factor, and T is the time
between samples.

Since the resultant math waveform is an integral waveform, its vertical scale is in volt-seconds (its horizontal scale is in seconds). The
source signal is integrated over its entire record length; therefore, the math waveform record length equals that of the source waveform.

Offset and position
When creating integrated math waveforms from live channel waveforms, consider the following:

• You should scale and position the source waveform so that it is contained on screen. (Off screen waveforms may be clipped, which will
result in errors in the integral waveform.)

• You can use vertical position and vertical offset to position your source waveform. The vertical position and vertical offset will not affect
your integral waveform unless you position the source waveform off screen so that it is clipped.

DC offset
The source waveforms that you connect to the instrument often have a DC offset component. The instrument integrates this offset along
with the time-varying portions of your waveform. Even a few divisions of offset in the source waveform may be enough to ensure that the
integral waveform saturates (clips), especially with long record lengths.

Using math waveforms
This topic helps you create basic math waveforms.

Create math waveforms to support the analysis of your channel and reference waveforms. By combining and transforming source
waveforms and other data into math waveforms, you can derive the data view that your application requires.

Note: Math waveforms are not available for use with serial buses.

Math functions are available when the instrument is operating in time-domain mode.

Use the following procedure for executing basic (+, –, x, ÷) math operations on two waveforms:

1. Tap the Add Math Ref Bus button and then tap Math. This creates a Math badge and displays the math waveform.
2. Double-tap the Math badge to open the Math configuration menu.
3. Tap the Math Type Basic button.
4. Set the sources to either channel 1, 2, 3, 4, or reference waveforms R1, 2, 3, or 4.
5. Choose the +, –, x, or ÷ operators.
6. For example, you might calculate power by multiplying a voltage waveform and a current waveform.

Measurement concepts

3 Series Mixed Domain Oscilloscope Help 281

www.tehencom.com          



Quick Tips
Math waveforms can be created from channel or reference waveforms or a combination of them.

Measurements can be taken on math waveforms in the same way as on channel waveforms.

Math waveforms derive their horizontal scale and position from the sources in their math expressions. Adjusting these controls for the
source waveforms also adjusts the math waveform.

Using advanced math
The advanced math feature lets you create a custom math waveform expression that can incorporate active and reference waveforms,
measurements, and/or numeric constants.

To use the advanced math feature:

1. Tap the Add Math Ref Bus button and then tap Math. This creates a Math badge and displays the math waveform.
2. Double-tap the Math badge to open the Math configuration menu.
3. Tap the Math Type Advanced button.
4. Tap the Edit button. The Equation Editor menu is displayed.
5. Use the Equation Editor buttons to create custom expressions.
6. When done, tap OK.

For example, to use Equation Editor to take the integral of a square wave:

1. Tap Clear.
2. Tap Functions Intg(.
3. Tap Sources Ch1 to select channel 1.
4. Tap Miscellaneous ).
5. Tap OK.

Using FFT
This topic explains how to use an FFT to display a graph of the frequency domain of a signal.

An FFT function breaks down signals into component frequencies, which the oscilloscope uses to display a graph of the frequency
domain of a signal, as opposed to the oscilloscope's standard time domain graph. You can match these frequencies with known system
frequencies, such as system clocks, oscillators, or power supplies.

1. Tap the Add Math Ref Bus button and select Math. This adds the Math badge to the Settings bar .
2. Tap Math Type FFT.
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3. Tap Source and select the source from the list. Choices are: channels 1, 2, (3, and 4 on four-channel models), reference waveforms
R1, R2, (R3, and R4 on four-channel models).

4. Tap Units and select either Linear or dBV.
5. Tap Window and select the desired window. Window choices are: Rectangular, Hamming, Hanning, and Blackman-Harris.
6. Tap Horizontal Scale and Horizontal Position activate the Multipurpose a and Multipurpose b knobs to pan and zoom the FFT

display.
7. The FFT will appear on the display.

Quick Tips
Use short record lengths for faster instrument response.

Use long record lengths to lower the noise relative to the signal and increase the frequency resolution.

If desired, use the zoom feature along with the horizontal Position and Scale controls to magnify and position the FFT waveform.

Use the default dBV scale to see a detailed view of multiple frequencies, even if they have very different amplitudes. Use the linear scale to
see an overall view of how all frequencies compare to each other.

The math FFT feature provides a selection of windows. Each offers a trade-off between frequency resolution and magnitude accuracy. The
choice of which window to use depends upon what you want to measure and your source’s signal characteristics.

FFT process
An FFT waveform displays a frequency-domain view, up to the Nyquist frequency, of a time-domain signal.

The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot acquisition) into its frequency
components.

The FFT function processes the waveform record and displays the FFT frequency domain record, which contains the input signal
frequency components from DC (0 Hz) to ½ the sample rate (also called the Nyquist frequency).

FFT and aliasing
Aliasing occurs when the input frequency of a signal is greater than one half of the sampling frequency (the sample rate).

Set the sample rate high enough so that the signals in the spectrum appear at their correct frequency as opposed to a lower aliased
frequency value. Also, complex signal shapes that have many harmonics in them, such as a triangle or square wave, can appear to be OK
in the time domain when in fact many of the harmonics in that signal are aliased.
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One way to check for aliasing is to increase the sample rate and observe whether any of the harmonics unwrap to different frequency
locations.

Another way to recognize aliasing is to realize that higher order harmonics usually have decreasing magnitudes compared to lower order
harmonics. Thus, if you see a series of increasing harmonic magnitude values as frequency increases then you can suspect that they
may be aliased. In the spectral math waveform, the actual higher frequency components are under sampled, and therefore they appear
as lower frequency aliases that fold back around the Nyquist point. You may test by increasing the sample rate and observing if aliases
unwrap to different frequency positions.

If you have a variable-frequency signal source, another way to observe aliasing is to adjust the frequency slowly while watching the
spectral display. If some of the harmonics are aliased, you will see the harmonics decreasing in frequency when they should be increasing
or vice versa.

Blackman-Harris FFT window concepts
The frequency resolution when using the Blackman-Harris window is poor, the spectral leakage is very low and amplitude accuracy is
good.

The Blackman-Harris window has a low amount of energy leakage compared to the other windows. Its best use is for single frequency
signals to look for higher order harmonics. Use the Blackman-Harris window for measuring predominantly single frequency waveforms to
look for higher order harmonics, or several moderately or widely spaced sinusoidal signals.

Hanning FFT window
The frequency resolution when using the Hanning window is good, the spectral leakage is low and amplitude accuracy is fair.

The Hanning window has the narrowest resolution bandwidth, but higher side lobes. Hanning has slightly poorer frequency resolution than
Hamming. Hanning is best for measuring sine, periodic, and narrow-band random noise, and transients or bursts where the signal levels
before and after the event are significantly different.
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Hamming window
The frequency resolution when using the Hamming window is good (slightly better than Hanning), the spectral leakage is moderate, and
amplitude accuracy is fair.

This window is unique in that the time domain shape does not taper all the way to zero at the ends. This makes it a good choice if you
wanted to process the real and imaginary parts of the spectrum off line and inverse transform it back to the time domain. Because the data
does not taper to zero, you can remove the effect of the window function from the result.

Use the Hamming window for measuring sine, periodic, and narrow band random noise. This window works well on transients or bursts
where the signal levels before and after the event are significantly different.

Rectangular window
The frequency resolution when using the Rectangular window is very good, the spectral leakage is high, and amplitude accuracy is poor.

This window is equal to unity (see the next figure). This means the data samples in the gate are not modified before input to the spectral
analyzer. Rectangular windows are best for measuring transients or bursts where the signal levels before and after the event are nearly
equal. Also, use this window for equal-amplitude sine waves with frequencies that are very close together, and for broadband random
noise with a relatively slow varying spectrum. This window is the best type for measuring the frequency spectrum of non-repetitive signals,
and measuring frequency components near DC.

Note: This window has the narrowest resolution bandwidth of any of the windows, but it also has the most spectral leakage and
the highest side lobes.

Using spectrum math
This topic describes using spectrum math.

The spectrum math feature lets you create a math waveform by adding or subtracting frequency traces.

Note: Spectrum Math is available when the instrument is acquiring in Spectrum Analyzer mode.
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1. Tap the Add Math Ref Bus button and then tap Math. This creates a Math badge and displays the math waveform.
2. Double-tap the Math badge to open the Math configuration menu.
3. Set the Source 1 and Source 2 from the drop-down lists.
4. Choose the + or – operators.

The math waveform will appear on the display as a red trace.
5. Double-tap Label and use the keyboard to give your math trace an appropriate label.

Note: The instrument completes the calculation if the units of measure of the source waveforms, when combined, make logical
sense.
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References

Upgrading firmware
Use this procedure to upgrade the instrument firmware.

To upgrade the firmware of the oscilloscope:

1. Open up a Web browser and go to www.tektronix.com/software/downloads. Proceed to the software finder. Download the latest
firmware for your oscilloscope on your PC.

2. Unzip the files and copy the firmware.img file into the root folder of a USB flash drive or USB hard drive.
3. Power off your oscilloscope.
4. Insert the USB flash or hard drive into the USB port on the front panel of your oscilloscope.
5. Power on the oscilloscope. The instrument automatically recognizes the replacement firmware and installs it.

Note: Do not power off the oscilloscope or remove the USB drive until the oscilloscope finishes installing the firmware.

If the instrument does not install the firmware, rerun the procedure. If the problem continues, try a different model of USB flash or hard
drive. Finally, if needed, contact qualified service personnel.

6. When the upgrade is complete, power off the oscilloscope and remove the USB flash or hard drive.
7. Power on the oscilloscope.
8. Tap Help and select About. The oscilloscope displays the firmware version number.
9. Confirm that the version number matches that of the new firmware.

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl alcohol
solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or chemicals that
could damage the touchscreen, case, controls, markings or labels, or possibly infiltrate the case.
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display cursors 75
display cursors (RF view) 246
display parameters 90
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display settings 191
Displayed waveform 251
domain name 192
draw a mask on the screen 92
draw-a-box button 94
DVM 182
DVM option 41
dynamic range limit marker 41

E
e* Scope HTTP Port 192
e*Scope 78
Edge search menu 157
Edge trigger menu 228
edit a segment (mask)

change a segment's 92
change a segment's height 92
change a segment's horizontal center 92
change a segment's shape 92
change a segment's source 92
change a segment's vertical center 92
change a segment's width 92
flip a segment horizontally 92
flip a segment vertically 92
rotate a segment 92

Edit Vertices panel (Mask Testing) 202
eject USB devices 188
electrostatic damage, preventing 62
elements

math waveforms 278
email 188
enter password (Opt 3-SEC) 198
enter security password (Opt 3-SEC) 198
Envelope 103
envelope acquisition mode 250
Environment requirements 33
equation editor 207, 208
erase memory 197
erase nonvolatile memory 197
ESD, preventing 62
Ethernet bus trigger settings 211
Ethernet port (rear panel) 39
Ethernet, connect to 59
excursion 244
expansion point, waveform 41
external

triggering 89
external monitor 62

F
factory calibration 196
factory settings 76
Fall Time 107
Falling Edge Count 108
Fast Acq button 38
Fast acquisitions 77
FastAcq 201

FastAcq acquisition mode 250
FFT

process 283
using 282

FFT aliasing 283
FFT math waveforms 73
FFT window 177
file menu 182
file utilities menu 188
firmware upgrade 287
firmware, how to update 56
FlexRay bus trigger settings 211
FlexRay serial bus menu 125
flip a segment (mask) 92
Force button 38
Frequency 107
frequency counter 242
frequency domain cursors 260
frequency domain display 43
frequency domain measurements 272
frequency domain menu 253
Front cover 22
front panel

Acquisition 38
Autoset button 38
Bus button (front panel) 38
Channel buttons (front panel) 38
Clear button 38
Cursors button 38
Default Setup 38
description 38
Fast Acq button 38
Force button 38
High Res button 38
Horizontal 38
input connectors 38
Level knob 38
Math button (front panel) 38
Mode button 38
multipurpose knobs 38
position

knob (horizontal) 38
Position knob 38
probe compensation connectors 38
Ref button (front panel) 38
Run/Stop button 38
Scale knob 38
Scale knob (horizontal) 38
Single/Seq button 38
Slope button 38
Touch Off button 38
Trigger 38
USB ports 38
Vertical 38

functional test 55

G
getting help 20
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GPIB address 192
GPIB talk/listen address 79
graticule intensity 75, 90
graticule intensity, setting 244
graticule style 75, 90
graticule style, setting 244

H
H Bar cursors 179
Hamming window

defined 285
handle rotate 32
handles, analog and digital 41
Hanning window

defined 284
Hard transit case 22
harmonics 283
Harmonics 109
HDMI output (rear panel) 39
help 200
help menu 182
Help system 54
hex virtual keypad 243
HF reject 266
Hi Res

acquisition mode 103
High 105
High Res acquisition mode 250
High Res button 38
holdoff 240, 265
holdoff, trigger 87
Horizontal acquisition

delay 252
position 252, 270
reference point 270
window 251

Horizontal controls 38
horizontal menu, open 64
horizontal mode 201
horizontal scale 201
horizontal settings 201
host name 192
how to

add a measurement 70
Add bus waveform 69
Add math waveform 69
Add reference waveform 69
add waveform to screen 67
change graticule intensity 75
change graticule style 75
change measurement settings 71
change persistence 75
change waveform intensity 75
change waveform settings 75
check power-on self tests results 35
compensate TPP250, TPP0500B, TPP1000 probes 57
connect probes 36
connect to network 59

how to (continued)
connect to PC using USB cable 79
Define Mask 118
delete a measurement 72
display cursors 75
download, install firmware 56
load a reference waveform 101
open acquisition menu 65
open horizontal menu 64
quickly display waveform (Autoset) 63
recall a reference waveform 101
recall an instrument setup 101
remote access the oscilloscope (from Web) 78
run signal path compensation (SPC) 56
save a screen image 99
save a waveform file 99
save all 100
save instrument settings 100
set acquisition parameters 65
set channel vertical parameters 67
set date 180
set GPIB talk/listen address 79
set horizontal parameters 64
set probe deskew 67
set probe parameters 67
set pulse width trigger 86
set time 55, 180
set trigger holdoff 87
set trigger parameters 64
set UTC time 180
update firmware 56
use Autoset 63
use mouse with the UI 53

I
I/O 192
I2C

bus trigger settings 219
serial bus menu 126

I2C bus trigger settings 211
I2S 122
inactive channel buttons 41
ink saver mode 186
Input

resistance 251
termination 251

Input channel
trigger sources 264

Input connectors (front panel) 38
input signal level requirements 33
install license 200
install option license 200
installed options 200
installed probes 200
Instrument option upgrades 29
instrument settings

saving 100
instrument setup

3 Series Mixed Domain Oscilloscope Help 291

www.tehencom.com          



instrument setup (continued)
recalling 101

intensity 90
intensity, graticule 75
intensity, waveform 75
IP address 192
IP address keypad 244

K
key features 19
keyboard 242
keyboard, installing 62
keypad 243
knob A 38
knob B 38

L
LAN 192
LAN port (rear panel) 39
LAN reset 192
LAN Reset 195
LAN status 192
LAN, connect to 59
Left Justified (LJ) audio bus 122
Level 266
Level knob 38
LF reject 266
license file (option) 30
LIN bus trigger settings 211
LIN serial bus menu 127
load

waveform 101
loading

files 183
reference waveforms 183
setup files 183

lock to bench or rack 36
log files 195
log files, how to view 195
logic keypad 243
Logic search menu 158
Logic Search- Define Inputs menu 159
logic trigger 229, 268
Logic trigger input settings 231
Low 105
LXI 78

M
MAC address 192
markers 255, 259
markers (RF view 255
marking waveform events 74
mask

change a segment's height 92
change a segment's horizontal center 92
change a segment's shape 92

mask (continued)
change a segment's vertical center 92
change a segment's width 92
change the mask definition 92
flip a segment horizontally 92
flip a segment vertically 92
rotate a segment 92

Mask Test configuration menu (Mask Testing) 203
mask testing

create a mask 92
Mask Testing

Actions To Take On 203
badge settings 203
Edit Vertices panel 202
Mask Test configuration menu 203
Segment configuration menu 202
segment settings panel 202

math 178, 205, 282, 285
Math button 38
math editor 279
Math equation 278
math syntax 279
math waveform 205, 207, 208
Math waveform

differentiation 280
elements 278
guidelines 279
interactions 278
offset 280
position 280
scale 280

math waveform menu 204
math waveforms

FFT 73
Max 105
Maximum signal level 251
Mean 105
measure

AC + DC RMS 272
AC RMS 272
DC 272
frequency 272

Measure button 40
measurement

customizing 96
reference levels 96

Measurement algorithms
Edge1 277
Edge2 277
Edge3 277
end 277
HighRef 276
hysteresis 277
LowRef 276
MidRef 276
min-max method 276
out of range samples 278
record length 277
start 277
top, base 276
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Measurement algorithms (continued)
TPOS 277
TSOFF 278
variables 276

measurement annotations 191
measurement badge 46
measurement badge, delete 72
Measurement configuration menu 114
measurement gates

setting 97
Measurement Name panel 115
measurements

Amplitude 105
Area 108
Burst Width 107
Cycle Area 108
Cycle Mean 105
Cycle RMS 105
Delay 107
Fall Time 107
Falling Edge Count 108
Frequency 107
High 105
Low 105
Max 105
Mean 105
Min 105
Negative Duty Cycle 107
Negative Overshoot 105
Negative Pulse Width 107
Peak-To-Peak 105
Period 107
Phase 107
Positive Duty Cycle 107
Positive Overshoot 105
Positive Pulse Count 108
Positive Pulse Width 107
Rise Time 107
Rising Edge Count 108
RMS 105
Total Overshoot 105

menu
Reference waveform 209

Menu bar 40
menu panels 50
menus 50
MIL-STD-1553 bus trigger settings 211
Min 105
Mini keyboard 22
Mode button (front panel) 38
modulation 109
monitor, connecting 62
mount drive 59
mount network drive menu 190
mouse 22
mouse touchscreen UI equivalents 53
mouse, installing 62
move cursors 75
multipurpose knobs 38

N
navigation buttons, badges 46
Negative Duty Cycle 107
Negative Overshoot 105
Negative Pulse Width 107
network address 192
network drive 59
network drive (standard instrument

unmount a network drive 60
network, connect to 59
noise reject 266
numeric keypad 243
nyquist 283
Nyquist point 283

O
octal virtual keypad 243
Offset

math offset and position 280
on screen keyboard 242
open acquisition menu 65
open horizontal menu 64
opening files 183
operating

altitude range 33
humidity range 33
temperature range 33

operating power requirements 33
option details 200
option license 200
options

install an option 30
option license file 30

Options
3-SEC (enhanced instrument security) 26
Power (Option 3-PWR, SUP3-PWR) 27

Options, bandwidth 25
Options, upgrades 29
Other drawer

Channel Settings menu 169
Other measurements

Area 108
Cycle Area 108
Falling Edge Count 108
Positive Pulse Count 108
Rising Edge Count 108

P
packing list 22
palette (Fast Acq) 77
panels, menu 50
parallel bus

trigger 88
parallel bus inputs 131
parallel bus menu 130
parallel bus search 139
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parallel bus trigger settings 211
parallel trigger menu 224
password, enter (Opt 3-SEC) 198
password, set (Opt 3-SEC) 199
paste files 188
Peak Detect

acquisition mode 103
peak detect acquisition mode 250
peak markers 244
Peak-To-Peak 105
Period 107
persistence 90
persistence, waveform 75
Phase 107
pick measurement 208
pinching and handle rotate 32
position

control 251
knob 38
knob (horizontal) 38

Positive Duty Cycle 107
Positive Overshoot 105
Positive Pulse Count 108
Positive Pulse Width 107
power 27
power cord 22
power cord connector (rear panel) 39
power cord options 27
power measurement 117
Power Measurement Name panel 118
power measurements 274
Power Measurements

Input analysis 109
Power Quality 109
power requirements 33
power standby mode 34
power-on self tests 195
power-on test results 35
powering on or off 34
preventing ESD 62
print 188, 191
printer 188
probe

compensation 169
compensation (TPP0500B, TPP1000) 57
compensation connectors 38
compensation TPP250 57
deskew, set 67
inputs 38
parameters, set 67

probe setup
analog 168

probes, connecting 36
product description 19
projector, connecting 62
proper handle rotate 32
Pulse Width search menu 160
pulse width trigger 86, 231
Pulse width trigger 267

Q
quantity 244
quick print 191

R
rack mount kit information 37
Rackmount kit accessory 22
RBW 177, 257
readout 244
readouts 255, 275
rear panel

AFG Out 39
AUX Out 39
cable lock 39
connections 39
Ethernet port (RJ-45) 39
HDMI output 39
LAN port (RJ-45) 39
power cord 39
security cable lock 39
USB Device port 39
USB Host ports 39

recall
instrument setup 101
waveform 101

recall reference file menu 209
recalling 98
record length 201
Record length 252
Record length memory options 25
record view, waveform 41
Rectangular window

defined 285
redo last action 191
Ref button 38
reference 179
reference level 256
reference levels

measurement 96
reference levels panel 119
Reference waveform menu 209
reference waveforms 69, 252
remote access (e*Scope) 78
remote access (Web-based) 78
remove AC power from instrument 34
rename files 188
requirements

altitude 33
environment 33
humidity 33
power 33
signal inputs 33
temperature 33

resolution bandwidth 177, 257
Results bar 40
results table 138
Results Table button 40
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RF
badge 247
channel 175
measurements 272
settings 175, 244

RF view
cursor display on-off 246
cursors configuration menu 246
M, A, N, m traces 255
markers 255
trace handle 255
user interface 255

right click settings 191
Right Justified (RJ) audio bus 122
ripple 109
Rise Time 107
Rise/Fall Time search menu 161
rise/fall time trigger 233, 268
Rising Edge Count 108
RM menu 253
RM3 rack mount 37
RMS 105
Rollmode acquisition mode 250
rotate a segment (mask) 92
RS-232 serial bus menu 132
RS-232 serial bus search 153
RS-232 serial bus trigger 224
RS232 bus trigger settings 211
run signal path compensation 56
Run/Stop

Acquisition menu 103
Run/Stop button 38
Runt search menu 162
runt trigger 267

S
safe operating area 109
Sample

acquisition mode 103
sample acquisition mode 250
sample rate 201
Sampling process

defined 249
sanitize 26
save

all 100
instrument settings 100
screen image 99
waveform file 99

Save As dialog 174, 185
Save button 38
Save menu action 174, 185
saving 98
saving ink on printed screen captures 185
scale buttons, badge 46
Scale controls

math 280
positioning 251

Scale knob 38
Scale knob (horizontal) 38
screen annotation 244
screen capture 99, 188
screen captures, saving 185
screen dim 191
screen image

saving 99
screen keyboard 242
search 138, 139
search badge 46
Search button 40
search menu

Edge 157
Logic 158
Pulse Width 160
Rise/Fall Time 161
Runt 162
Setup and Hold 164
Timeout 165

Search menu 210
search serial bus 139
search tables and zoom mode 94
searching for events 74
security 197
security cable lock 39
Segment configuration menu (Mask Testing) 202
selected trace 244
self tests 195
SENT bus trigger settings 211
SENT serial bus menu 133
sequence trigger 266
Sequence trigger menu 235
sequential acquisition mode 103
sequential triggering 88
Sequential triggering 268
serial bus

RS-232 132
trigger options 26
triggering 89

serial bus configuration 119
serial bus menu

SENT 133
serial bus search settings 139
serial bus trigger settings 211
serial bus, audio 122
serial bus, auto 123
serial bus, FlexRay 125
serial bus, I2C 126
serial bus, LIN 127
service name 192
service options 28
set

GPIB talk/listen address 79
probe

deskew 67
probe parameters 67
time 55

set measurement gates 97
set password (Opt 3-SEC) 199
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set security password (Opt 3-SEC) 199
setting up a bus 119
Settings bar 40
settings, Edge trigger 228
settings, Video trigger 239
setup

parallel bus 83
Setup and Hold Search - Define Inputs menu 165
Setup and Hold search menu 164
Setup and hold trigger 268
show a measurement 70
signal input levels 33
signal path compensation 196
single acquisition mode 103
single sequence 66
Single Sequence/Stop After

Acquisition menu 103
Single/Seq

Acquisition menu 103
Single/Seq button 38
Slope

trigger 266
Slope button (front panel) 38
span 177, 256
Span:RBD 257
SPC 196
SPC (signal path compensation) 56
spectral FastAcq setting 201
spectral math 178
spectral ref 179
spectrogram 244, 247, 258
spectrogram display 176, 258
spectrum math 285
spectrum traces 247
SPI bus trigger settings 211
SPI serial bus 135
SPMI bus trigger settings 211
standard accessories 22, 32
start frequency 177
stop acquisitions 103
stop frequency 177
subnet mask 192
SUP3-AFG option 26
Support 20
switching loss 109
syntax

math editor 279
system information 200

T
TDM audio bus 122
Technical support 20
TEK-DPG 22
TekSecure 197
Tektronix Technical Support 20
TekVPI input connectors 38
TekVPI probes 23
Termination 251

threshold 244
time 180
time domain measurements 272
time-domain vs frequency domain 253
time, how to set 55
Timebase Reference Source

Acquisition menu 103
Timeout search menu 165
timeout trigger 238
Timeout trigger 267
timing measurements

Burst Width 107
Delay 107
Fall Time 107
Frequency 107
Negative Duty Cycle 107
Negative Pulse Width 107
Period 107
Phase 107
Positive Duty Cycle 107
Positive Pulse Width 107
Rise Time 107

Total Overshoot 105
Touch Off button 38
touchscreen UI tasks 53
TPP0500B 22
TPP1000 22
trace markers 255
traces 252
traces panel 176
Transit case, hard plastic 22
trigger

act on trigger 241
external signal 89
holdoff 240
level indicators 41
logic 229
mode 240
parallel bus 88
position indicator 41
pulse width 231
rise/fall time 233
serial bus 89
timeout 238

Trigger
considerations 252
modes 265
slope and level 266
sources 264

Trigger controls 38
trigger coupling 266
trigger delay 266
trigger frequency 242
trigger holdoff 87, 265
trigger level 266
trigger menu 64
trigger menu, parallel 224
Trigger menus 211
trigger out 192
trigger position 266
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trigger slope 266
trigger source 264
trigger the oscilloscope 64
trigger types 264
Triggering

modes 265
sources 264

triggering concepts 86, 264
turn instrument on or off 34

U
undo last action 191
unmount a network drive 60
unmount USB devices 188
USB 192
USB bus trigger settings 211
USB cable, connect to PC 79
USB Device port (rear panel) 39
USB Host ports (rear panel) 39
USB ports (front panel) 38
USB serial bus menu 136
use cursors 75
user button 185
user preferences

display settings 191
using

reference waveforms 252
using FFT 282
using mouse with the touchscreen 53
utility menu 182

V
V Bar cursors 179
V&H Bar cursors 179
variable persistence 244
Vertical acquisition 251
Vertical acquisition window 251
Vertical controls 38
Vertical offset 251
vertical settings 166
Video trigger menu 239
virtual keyboard 242
virtual keypad 243, 244
voltmeter 45, 182, 272
Volts per division

maximum 251

W
waveform

expansion point 41
intensity 75
persistence 75
recalling 101
record view 41
XY 73

waveform badge 46

waveform cursors 179
Waveform differentiation 280
waveform dots style, setting 244
waveform editor 279
waveform file

saving 99
Waveform integration 280
waveform intensity, setting 244
waveform memory options 25
waveform persistence 90
waveform persistence, setting 244
waveform preview 270
waveform style 90
waveform style, setting 244
waveform vectors style, setting 244
Waveform View 40
Waveform View settings 244
Waveforms

math 279
waveforms, saving 185
welcome 19
window 177, 257

X
XY cursors 276
XY waveform 73

Z
zoom 94
Zoom 201
Zoom box 52
zoom icon 41
zoom mode 94
Zoom overview 52
Zoom title bar 52
zooming on search events 94
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